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1
  General Information

1.1  Introduction

PSIM1 is a simulation software specifically designed for power electronics and motor drives. With fast
simulation and friendly user interface, PSIM provides a powerful simulation environment for power electronics,
analog and digital control, magnetics, and motor drive system studies.

PSIM includes the basic package, as well as the following add-on options: 

Motor Drive Module
Digital Control Module
SimCoupler Module
Thermal Module
MagCoupler Module
MagCoupler-RT Module
SimCoder2 Module
Renewable Energy Package

The Motor Drive Module has built-in machine models and mechanical load models for motor drive system
studies. 

The Digital Control Module provides discrete elements such as zero-order hold, z-domain transfer function
blocks, quantization blocks, digital filters, for digital control system analysis. 

The SimCoupler Module provides interface between PSIM and Matlab/Simulink3 for co-simulation. 

The Thermal Module provides the capability to calculate semiconductor devices losses. 

The MagCoupler Module provides interface between PSIM and the electromagnetic field analysis software
JMAG4 for co-simulation.

The MagCoupler-RT Module links PSIM with JMAG-RT4 data files. 

The SimCoder Module provides automatic code generation capability for DSP hardware. 

The Renewable Energy Package includes the basic PSIM package, the Motor Drive Module, and Renewable
Energy models such as solar modules and wind turbine for simulation in renewable energy applications. 

In addition, PSIM supports links to third-party software through custom DLL blocks. The overall PSIM
environment is shown below. 

1.  PSIM and SIMVIEW are registered trademarks of, and are copyright by, Powersim Inc., 2001-2010
2. SimCoder is a trademark of Powersim Inc., and is copyright by Powersim Inc., 2008-2010
3. Matlab and Simulink are registered trademarks of the MathWorks, Inc.
4. JMAG and JMAG-RT are copyright by JSOL Corporation, 1997-2010
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The PSIM simulation environment consists of the circuit schematic program PSIM, the simulator engine, and
the waveform processing program Simview1. The simulation process is illustrated as follows.

This manual covers both PSIM and all the add-on Modules except SimCoder Module. The use of the SimCoder
Module is described in the separate document SimCoder User Manual. 

Chapter 1 of this manual describes the circuit structure, software/hardware requirement, and parameter
specification format. Chapter 2 through 4 describe the power and control circuit components. Chapter 5
describes the specifications of the transient analysis and ac analysis. The use of the PSIM schematic program
and SIMVIEW is discussed in Chapter 6 and 7. Finally, error/warning messages are discussed in Chapter 8. 

1.2  Circuit Structure
A circuit is represented in PSIM in four blocks: power circuit, control circuit, sensors, and switch controllers.
The figure below shows the relationship between these blocks. 

The power circuit consists of switching devices, RLC branches, transformers, and coupled inductors. The
control circuit is represented in block diagram. Components in s domain and z domain, logic components (such

PSIM

Matlab/ JMAG / 

- Control systems - Finite element analysis
- Power electronics
- Analog/digital control
- Motor drives

- Electric machines, and 
  other magnetic devices

Third-party
Software

JMAG-RTSimulink

Power 

Motor DrivesControl

ThermalAuto Code 
Generation

Electronics

Analysis

Digital Control Motor Drive

SimCoupler

ThermalSimCoder

MagCoupler/

DLL

MagCoupler-RT

DSP
Hardware

Hardware
Targets

PSIM Simulator

PSIM Schematic

SIMVIEW

Circuit Schematic Editor (input: *.sch)

PSIM Simulator (output: *.smv or *.txt)

Waveform Processor (input: *.smv or *.txt)

        Power Circuit

  Control Circuit

  Sensors    Switch
 Controllers
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as logic gates and flip flops), and nonlinear components (such as multipliers and dividers) are used in the
control circuit. Sensors are used to measure power circuit quantities and pass them to the control circuit. Gating
signals are then generated from the control circuit and sent back to the power circuit through switch controllers
to control switches.

1.3  Software/Hardware Requirement
PSIM runs in Microsoft Windows XP/Vista on personal computers. The minimum RAM memory requirement
is 128 MB. 

1.4  Installing the Program
A quick installation guide is provided in the flier “PSIM - Quick Guide” and on the CD-ROM.

Some of the files in the PSIM directory are shown in the table below.

File extensions used in PSIM are:

Note that the extension of PSIM schematic files is .sch in PSIM 8.0 or order, but the extension in PSIM 9.0 must
be .psimsch in order to differentiate PSIM files from files of other software. 

1.5  Simulating a Circuit
To simulate the sample one-quadrant chopper circuit “chop.sch”:

- Start PSIM. From the File menu, choose Open to load the file “chop.sch”.

- From the Simulate menu, choose Run PSIM to start the simulation.  Simulation results will be saved
to File “chop.txt”. 

- If the option Auto-run SIMVIEW is not selected in the Options menu, from the Simulate menu,
choose Run SIMVIEW to start SIMVIEW. If the option   is selected, SIMVIEW will be launched
automatically. In SIMVIEW, select curves for display.

1.6  Component Parameter Specification and Format
The parameter dialog window of each component in PSIM has three tabs: Parameters, Other Info, and Color,
as shown below. 

Files Description

PSIM.exe PSIM circuit schematic editor

SIMVIEW.exe Waveform display program SIMVIEW

PcdEditor.exe Device database editor

SetSimPath.exe Program to set up the SimCoupler 
Module

*.psimsch PSIM schematic file 

*.lib PSIM library files

*.fra PSIM ac analysis output file (text)

*.dev Device database file

*.txt Simulation output file in text format

*.smv Simulation output file in binary format
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The parameters in the Parameters tab are used in the simulation. The information in the Other Info tab, on the
other hand, is not used in the simulation. It is for reporting purposes only and will appear in the parts list in
View -> Element List in PSIM. Information such as device rating, manufacturer, and part number can be stored
under the Other Info tab.

The component color can be set in the Color tab.

Parameters under the Parameters tab can be a numerical value or a mathematical expression. A resistance, for
example, can be specified in one of the following ways:

12.5
12.5k
12.5Ohm
12.5kOhm
25./2.Ohm
R1+R2
R1*0.5+(Vo+0.7)/Io

where R1, R2, Vo, and Io are symbols defined either in a parameter file (see Section 4.1), or in a main circuit if
this resistor is in a subcircuit (see Section 6.3.4.1).

Power-of-ten suffix letters are allowed in PSIM. The following suffix letters are supported: 

G 109

M 106

k or K 103

m 10-3

u 10-6

n 10-9

p 10-12

A mathematical expression can contain brackets and is not case sensitive. The following mathematical
functions are allowed:

+ addition
- subtraction
* multiplication
/ division
^ to the power of [Example: 2^3 = 2*2*2]
SQRT square-root function
SIN sine function
COS cosine function
ASIN sine inverse function
ACOS cosine inverse function
TAN tangent function
ATAN inverse tangent function
ATAN2 inverse tangent function [-π <= atan2(y,x) <= π]
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SINH hyperbolic sine function
COSH hyperbolic cosine function
EXP exponential (base e) [Example: EXP(x) = ex]
LOG logarithmic function (base e) [Example: LOG(x) = ln (x)]
LOG10 logarithmic function (base 10) 
ABS absolute function
SIGN sign function [Example: SIGN(1.2) = 1; SIGN(-1.2)=-1]
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2
  Power Circuit Components

2.1  Resistor-Inductor-Capacitor Branches 

2.1.1  Resistors, Inductors, and Capacitors
Both individual resistor, inductor, capacitor, and lumped RLC branches are provided in PSIM. Initial conditions
of inductor currents and capacitor voltages can be defined. 

To facilitate the setup of three-phase circuits, symmetrical three-phase RLC branches are provided. Initial
inductor currents and capacitor voltages of the three-phase branches are all zero. 

Images:

For three-phase branches, the phase with a dot is Phase A.

Attributes:

The resistance, inductance, or capacitance of a branch can not be all zero. At least one of the parameters has to
be a non-zero value.

Parameters Description

Resistance Resistance, in Ohm

Inductance Inductance, in H

Capacitance Capacitance, in F

Initial Current Initial inductor current, in A

Initial Cap. Voltage Initial capacitor voltage, in V

Current Flag Flag for branch current output. 
If the flag is zero, there is no current output. If the flag is 1, the current will be 
available for display in the runtime graphs (under Simulate -> Runtime 
Graphs). It will also be saved to the output file for display in SIMVIEW. 
The current is positive when it flows into the dotted terminal of the branch.

Current Flag_A; 
Current Flag_B; 
Current Flag_C

Current flags for Phase A, B, and C of three-phase branches, respectively.

Resistor Inductor Capacitor RL RC

R3 RL3 RC3 RLC3

RLCLC

L3 C3
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2.1.2  Rheostat
A rheostat is a resistor with a tap. 

Image: 

Attributes:

2.1.3  Saturable Inductor
A saturable inductor takes into account the saturation effect of the magnetic core. 

Image: 

Attributes:

The nonlinear B-H curve is represented by piecewise linear approximation. Since the flux density B is
proportional to the flux linkage λ and the magnetizing force H is proportional to the current i, the B-H curve can
be represented by the λ-i curve instead, as shown below. 

The inductance is defined as: L = λ / i, the ratio of λ vs. i at each point. The saturation characteristics are defined
by a series of data points as: (i1, L1), (i2, L2), (i3, L3), etc. 

Note that the defined saturation characteristics must be such that the flux linkage λ is monotonically increasing.
That is, L1*i1 < L2*i2 < L3*i3, etc.

Also, similar to the saturation characteristics in the real world, the slope of each linear segment must be
monotonically decreasing as the current increases.

In certain situations, circuits that contain saturable inductors may fail to converge. Connecting a very small
capacitor across the saturable inductor may help the convergence. 

Parameters Description

Total Resistance Total resistance of the rheostat R (between Node k and m), in Ohm

Tap Position (0 to 1) The tap position Tap. The resistance between Node k and t is: R*Tap.

Current Flag Flag for the current that flows into Node k. 

Parameters Description

Current vs. Inductance Characteristics of the current versus the inductance (i1, L1), (i2, L2), etc.

Current Flag Flag for the current display

k m

t

i (H)

λ (B)

i1 i2 i3

λ1

λ2
λ3

Inductance L = λ / i
8    Chapter 2: Power Circuit Components



2.1.4  Nonlinear Elements
The following elements with nonlinear voltage-current relationship are provided: 

- Resistance-type [v = f(i)]
- Resistance-type with additional input x [v = f(i,x)]
- Conductance-type [i = f(v)]
- Conductance-type with additional input x [i = f(v,x)]

The additional input x must be a voltage signal. 

Images: 

Attributes:
For resistance-type elements:

For conductance-type elements:

A good initial value and lower/upper limits will help the convergence of the solution. 

Example: Nonlinear Diode

The nonlinear element (NONI) in the circuit above models a nonlinear diode. The diode current is expressed as

Parameters Description

Expression f(i) or f(i,x) Expression of v in terms of i and x [v = f(i) or v = f(i,x)]

Expression df/di The derivative of the voltage v versus current i, i.e. df(i)/di

Initial Value io The initial value of the current i

Lower Limit of i The lower limit of the current i

Upper Limit of i The upper limit of the current i

Parameters Description

Expression f(v) or f(v,x) Expression of i in terms of v and x [i = f(v) or i = f(v,x)]

Expression df/dv Derivative of the current i versus voltage v, i.e. df(v)/dv

Initial Value vo The initial value of the voltage v

Lower Limit of v The lower limit of the voltage v

Upper Limit of v The upper limit of the voltage v

Nonlinear element Nonlinear element (with additional input)
Input x
Chapter 2: Power Circuit Components 9



a function of the voltage as: i = 10-14 * (e 40*v-1). In PSIM, the specifications of the nonlinear element will be:

2.2  Switches
There are two basic types of switches in PSIM. One is the switchmode type. It operates either in the cut-off
region (off state) or saturation region (on state). The other is the linear type. It can operates in either cut-off,
linear, or saturation region. 

Switches in switchmode include the following: 

- Diode and DIAC 
- Thyristor and TRIAC 
- Self-commutated switches, specifically:

- Gate-Turn-Off switch 
- npn bipolar junction transistor (BJT)
- pnp bipolar junction transistor 
- Insulated-Gate Bipolar Transistor (IGBT)
- n-channel Metal-Oxide-Semiconductor Field-Effect Transistor (MOSFET) and p-channel 

MOSFET 
- Bi-directional switch 

Switch models are ideal. That is, both turn-on and turn-off transients are neglected. 

A switch has an on-resistance of 10μΩ. When there is no R-L-C branch connected in parallel with the switch, a
10-MΩ resistor will be connected across the switch internally. This resistance can be viewed as the off-state
resistance. In certain cases, this resistance may need to be modified. To change the off-state resistance to, for
example, 100 MΩ, connect a 100-MΩ in parallel to the switch. Since PSIM sees that there is already a resistor
in parallel to the switch, the 10-MΩ resistor will not be added.

Snubber circuits are not required for switches.

Linear switches include the following: 

- npn and pnp bipolar junction transistor 
- n-channel and p-channel MOSFET 

2.2.1  Diode, LED, Zener Diode, and DIAC

Diode and LED:

A light-emitting diode (LED) emits light when it conducts. The conduction of a diode or LED is determined by
circuit operating conditions. A diode is turned on when the positive bias voltage is greater than the threshold
voltage, and is turned off when the current drops to zero. 

Images: 

Expression f(v) 1e-14*(EXP(40*v)-1)

Expression df/dv 40e-14*EXP(40*v)

Initial Value vo 0

Lower Limit of v -1e3

Upper Limit of v 1

LED

+

-

v

Diode
+

-

v
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Attributes:

The i-v characteristics of the diode and LED is shown below:  

Zener:

A zener diode is modeled by a circuit as shown below. 

Images: 

Attributes:

When the zener diode is positively biased, it behaviors as a regular diode. When it is reverse biased, it will
block the conduction as long as the cathode-anode voltage VKA is less than the breakdown voltage VB. When
VKA exceeds VB, the voltage VKA will be clamped to VB. 

Note that when the zener is clamped, since the diode is modelled with an on-resistance of 10μΩ, the cathode-
anode voltage will in fact be equal to: VKA = VB + 10μΩ * IKA. Therefore, depending on the value of IKA, VKA
will be slightly higher than VB. If IKA is very large, VKA can be substantially higher than VB.

Parameters Description

Diode Threshold 
Voltage

Diode threshold voltage Vd_th, in V. The diode starts to conduct when the positive 
bias voltage is greater than Vd_th.

Diode Resistance Diode on resistance Rd, in Ohm, after it starts to conduct.

Initial Position Flag for the initial diode position. If the flag is 0, the diode is off. If it is 1, the 
diode is on.

Current Flag Current flag of the diode.

Parameters Description

Breakdown Voltage Breakdown voltage VB of the zener diode, in V

Forward Threshold 
Voltage

Threshold voltage of the forward conduction (from anode to cathode), in V

Forward Resistance On resistance of the forward conduction, in Ohm

Current Flag Flag for zener current output (from anode to cathode)

i-v characteristics

0

i

v
Vd_th

Slope = 1/Rd

Zener
Circuit Model

A

K

A

K

VB
Chapter 2: Power Circuit Components 11



DIAC:

A DIAC is a bi-directional diode. A DIAC does not conduct until the breakover voltage is reached. After that,
the DIAC goes into avalanche conduction, and the conduction voltage drop is the breakback voltage. 

Image: 

Attributes:

2.2.2  Thyristor and TRIAC
A thyristor is controlled at turn-on. The turn-off is determined by circuit conditions.

A TRIAC is a device that can conduct current in both directions. It behaviors in the same way as two opposite
thyristors connected in parallel. 

Images: 

Attributes:

Note that for the TRIAC device, the holding current and latching current are set to zero.

There are two ways to control a thyristor or TRIAC. One is to use a gating block, and the other is to use a switch
controller. The gate node of a thyristor or TRIAC must be connected to either a gating block or a switch
controller. 

The following examples illustrate the control of a thyristor switch.

Parameters Description

Breakover Voltage Voltage at which breakover occurs and the DIAC begins to conduct, in V

Breakback Voltage Conduction voltage drop, in V

Current Flag Current flag

Parameters Description

Voltage Drop Thyristor conduction voltage drop, in V

Holding Current Minimum conduction current below which the device stops conducting and returns 
to the OFF state (for thyristor only)

Latching Current Minimum ON state current required to keep the device in the ON state after the 
triggering pulse is removed (for thyristor only)

Initial Position Flag for the initial switch position (for thyristor only)

Current Flag Flag for switch current output

Thyristor

A K
Gate

TRIAC

Gate
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Examples: Control of a Thyristor Switch

This circuit on the left uses a switching gating block. The switching gating pattern and the frequency are pre-
defined, and remain unchanged throughout the simulation. The circuit on the right uses an alpha switch
controller. The delay angle alpha, in deg., is specified through the dc source in the circuit. 

2.2.3  GTO and Transistors
Self-commutated switches in the switchmode, except pnp bipolar junction transistor (BJT) and p-channel
MOSFET, are turned on when the gating signal is high (when a voltage of 1V or higher is applied to the gate
node) and the switch is positively biased (collector-emitter or drain-source voltage is positive). It is turned off
whenever the gating signal is low or the current drops to zero. 

For pnp BJT and p-channel MOSFET, switches are turned on when the gating signal is low and switches are
negatively biased (collector-emitter or drain-source voltage is negative).

A GTO switch is a symmetrical device with both forward-blocking and reverse-blocking capabilities. An IGBT
or MOSFET switch consist of an active switch with an anti-parallel diode. 

Note that a limitation of the BJT switch model in PSIM, in contrary to the device behavior in the real life, is that
a BJT switch in PSIM will block reverse voltage (in this sense, it behaves like a GTO). Also, it is controlled by
a voltage signal at the gate node, not a current. 

Images:

Attributes for GTO: 

Attributes for npn and pnp BJT: 

Parameters Description

Voltage Drop GTO conduction voltage drop, in V

Initial Position Initial switch position flag (0: off; 1: on) 

Current Flag Switch current flag (0: no display; 1: display) 

Parameters Description

Saturation Voltage The saturation voltage Vce_sat for npn, or Vec_sat for pnp, in V

Initial Position Initial switch position flag (0: off; 1: on) 

Gating Block

Alpha 
Controller

BJT BJTGTO IGBTMOSFETMOSFET
(p-channel) (n-channel)(npn) (pnp)
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Attributes for n-channel and p-channel MOSFET: 

Attributes for IGBT: 

A switch can be controlled by either a gating block or a switch controller. They must be connected to the gate
(base) node of the switch. The following examples illustrate the control of a MOSFET switch.

Examples: Control of a MOSFET Switch 

The circuit on the left uses a gating block, and the one on the right uses an on-off switch controller. The gating
signal is determined by the comparator output.

Example: Control of a npn Bipolar Junction Transistor 
The circuit on the left uses a gating block, and the one on the right uses an on-off switch controller. 

Current Flag Switch current flag (0: no display; 1: display) 

Parameters Description

On Resistance The on resistance Rds_on of the MOSFET, in Ohm

Diode Threshold 
Voltage

Anti-parallel diode threshold voltage, in V

Diode Resistance Anti-parallel diode on resistance, in Ohm

Initial Position Initial switch position flag for the transistor only (0: off; 1: on) 

Current Flag Switch current flag for the whole module (the transistor plus the diode) (0: no 
display; 1: display) 

Parameters Description

Saturation Voltage Saturation voltage Vce_sat of the IGBT, in V

Transistor Resistance Transistor on resistance, in Ohm

Diode Threshold 
Voltage

Anti-parallel diode threshold voltage, in V

Diode Resistance Anti-parallel diode on resistance, in Ohm

Initial Position Initial switch position flag for the transistor only (0: off; 1: on) 

Current Flag Switch current flag for the whole module (the transistor plus the diode) (0: no 
display; 1: display) 

On-off Controller
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The following shows another example of controlling the BJT switch. The circuit on the left shows how a BJT
switch is controlled in the real life. In this case, the gating voltage VB is applied to the transistor base drive
circuit through a transformer, and the base current determines the conduction state of the transistor. 

This circuit can be modelled and implemented in PSIM as shown on the right. A diode, Dbe, with a conduction
voltage drop of 0.7V, is used to model the pn junction between the base and the emitter. When the base current
exceeds 0 (or a certain threshold value, in which case the base current will be compared to a dc source), the
comparator output will be 1, applying the turn-on pulse to the transistor through the on-off switch controller. 

2.2.4  Bi-Directional Switches
A bi-directional switch conducts current in both directions. 

Three types of bi-directional switches are provided: single-phase switch, three-phase switch, and push button
switch.

Images:

Attributes:

Parameters Description

Initial Position Initial switch position flag (for single switch only). 

Initial Position (for 
Phase A/B/C)

Initial switch position for Phase A, or B, or C.

Switch Position Switch position can be either "On" or "Off" (for push button switch only)

3-phase switch Push button switchSingle switch
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In the 3-phase switch image, the phase with a dot is Phase A.

For single and 3-phase bi-directional switches, they are on when the gating signal is high, and are off when the
gating signal is low, regardless of the voltage bias conditions. For the push button switch, the switch position is
set directly from the parameter input.

2.2.5  Linear Switches
Linear switches, which can operate in three states, include npn and pnp BJT, and n-channel and p-channel
MOSFET. BJT devices can operate in either cut-off, linear, or saturation state. MOSFET devices can operate in
either cut-off, active, or ohmic state.

Images:

Attributes for npn and pnp BJT: 

Attributes for n-channel and p-channel MOSFET: 

A linear BJT device is controlled by the base current Ib. It can operate in one of the three regions: cut-off (off
state), linear, and saturation region (on state). 

The properties of a npn BJT in these regions are:

- Cut-off region:     Vbe < Vr;   Ib = 0;        Ic = 0
- Linear region:       Vbe = Vr;   Ic = β∗Ib;   Vce > Vce,sat
- Saturation region: Vbe = Vr;   Ic < β∗Ib;   Vce = Vce,sat 

Current Flag Switch current flag (for single switch only)

Current Flag (for 
Phase A/B/C)

Switch current flag for Phase A, or B, or C.  

Parameters Description

Current Gain beta Transistor current gain β, defined as: β=Ic/Ib

Bias Voltage Vr Forward bias voltage, in V, between base and emitter for the npn transistor, or 
between emitter and base for the pnp transistor.

Vce,sat [or Vec,sat for 
pnp]

Saturation voltage, in V, between collector and emitter for the npn transistor, and 
between emitter and collector for the pnp transistor.

Parameters Description

On Resistance On resistance Rds(on) of the MOSFET, in Ohm

Threshold Voltage 
Vgs(th)

Threshold voltage of the gate-to-source voltage, in V, beyond which the MOSFET 
starts to conduct.

Transconductance gm Transconductance gm of the MOSFET.

Diode Threshold 
Voltage

Threshold voltage of the anti-parallel diode, in V

Diode Resistance On resistance of the anti-parallel diode, in Ohm

MOSFET
(p-channel) 

     BJT (npn)       BJT (pnp) MOSFET
(n-channel)
16    Chapter 2: Power Circuit Components



where Vbe is the base-emitter voltage, Vce is the collector-emitter voltage, and Ic is the collector current.

The properties of a pnp BJT in these regions are:

- Cut-off region:     Veb < Vr;   Ib = 0;        Ic = 0
- Linear region:       Veb = Vr;   Ic = β∗Ib;   Vec > Vee,sat
- Saturation region: Veb = Vr;   Ic < β∗Ib;   Vec = Vec,sat 

where Vee is the emitter-base voltage, Vec is the emitter-collector voltage, and Ic is the collector current.

A linear MOSFET device is controlled by the gate-to-source voltage Vgs. It can operate in one of the three
regions: cut-off (off state), active, and ohmic region (on state). 

The properties of a n-channel MOSFET device in these regions are:

- Cut-off region:     Vgs < Vgs(th);   Id = 0
- Active region:       Vgs > Vgs(th) and Vgs - Vgs(th) < Vds;   Id = gm∗(Vgs - Vgs(th))
- Ohmic region:       Vgs > Vgs(th) and Vgs - Vgs(th) > Vds;   Id = Vds / Rds(on)

where Vgs is the gate-source voltage, Vds is the drain-source voltage, and Id is the drain current.

The properties of a p-channel MOSFET device in these regions are:

- Cut-off region:     Vgs > Vgs(th);   Id = 0
- Active region:       Vgs < Vgs(th) and Vgs - Vgs(th) > Vds;   Id = gm∗(Vgs - Vgs(th))
- Ohmic region:       Vgs < Vgs(th) and Vgs - Vgs(th) < Vds;   Id = Vds / Rds(on)

Note that for 3-state npn/pnp BJT and n-channel/p-channel MOSFET, the base node (gate node) is a power
node, and must be connected to a power circuit component (such as a resistor or a source). It can not be
connected to a gating block or a switch controller.

Examples: Circuits Using the Linear BJT Switch
Examples below illustrate the use of linear switches. The circuit on the left is a linear voltage regulator circuit,
and the transistor operates in the linear mode. The circuit on the right is a simple test circuit.

2.2.6  Switch Gating Block
A switch gating block defines the gating pattern of a switch or a switch module. The gating pattern can be
specified either directly (the element is called Gating Block in the library) or in a text file (the element is called
Gating Block (file) in the library).

Note that a switch gating block can be connected to the gate node of a switch ONLY. It can not be connected to
any other elements.

Image:

NPN_1

NPN_1
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Attributes:

The number of switching points is defined as the total number of switching actions in one period. Each turn-on
or turn-off action is counted as one switching point. For example, if a switch is turned on and off once in one
cycle, the number of switching points will be 2.

For the Gating Block (file) element, the file for the gating table must be in the same directory as the schematic
file. The gating table file has the following format:

n
G1
G2
... ...
Gn

where G1, G2, ..., Gn are the switching points.

Example:
Assume that a switch operates at 2000 Hz and has the following gating pattern in one period:

The specification of the Gating Block element for this switch will be:

The gating pattern has 6 switching points (3 pulses). The corresponding switching angles are 35o, 92o, 175o,
187o, 345o, and 357o, respectively.

If the Gating Block (file) element is used instead, the specification will be:

The file “test.tbl” will contain the following: 

6
35.
92.
175.

Parameters Description

Frequency Operating frequency of the switch or switch module connected to the gating block, in 
Hz

No. of Points Number of switching points (for the Gating Block element only)

Switching Points Switching points, in deg. If the frequency is zero, the switching points is in second. 
(for the Gating Block element only)

File for Gating 
Table

Name of the file that stores the gating table (for the Gating Block (file) element only)

Frequency 2000.

No. of Points 6

Switching Points 35. 92. 175. 187. 345. 357.

Frequency 2000.

File for Gating Table test.tbl

0 180 360

9235 175 187 345 357

(deg.)
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187.
345.
357.

2.2.7  Single-Phase Switch Modules
Built-in single-phase diode bridge module and thyristor bridge module are provided. The images and internal
connections of the modules are shown below. 

Images:

Attributes:

Node Ct at the bottom of the thyristor module is the gating control node for Switch 1. For the thyristor module,
only the gating signal for Switch 1 needs to be specified. The gating signals for other switches will be derived
internally in the program.

Similar to the single thyristor switch, a thyristor bridge can also be controlled by either a gating block or an
alpha controller, as shown in the following examples.

Examples: Control of a Thyristor Bridge 
The gating signal for the circuit on the left is specified through a gating block, and the gating signal for the
circuit on the right is provided through an alpha controller. A major advantage of the alpha controller is that the
delay angle alpha of the thyristor bridge, in deg., can be directly controlled. 

2.2.8  Three-Phase Switch Modules
The following figure shows three-phase switch modules and the internal circuit connections. A three-phase
voltage source inverter module VSI3 consists of either MOSFET-type or IGBT-type switches. A current source
inverter module CSI3 consists of GTO-type switches, or equivalently IGBT in series with diodes.

Parameters Description

Diode Threshold Voltage 
or Voltage Drop

Threshold voltage of the diode, or forward voltage drop of the thyristor, in V

Diode Resistance On resistance of the diode, in Ohm (for diode bridges only)

Init. Position_i Initial position for Switch i 

Current Flag_i Current flag for Switch i 

A+

A-

Diode bridge Thyristor bridge
DC+

DC-

A+

A-

DC+

DC-

1 3

4 2 24

1 3

Ct

A+

A-

DC+

DC-

A+

A-

DC+

DC-

Ct
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Images:

Attributes for the diode bridge:  

Attributes for thyristor bridges: 

Parameters Description

Diode Threshold Voltage Threshold voltage drop of the diode, in V

Diode Resistance On resistance of the diode, in Ohm

Init. Position_i Initial position for Switch i 

Current Flag_i Current flag for Switch i 

Parameters Description

Voltage Drop Conduction voltage drop of the thyristor, in V

Init. Position_i Initial position for Switch i 

Current Flag_i Current flag for Switch i 

1 3 5

24 6
DC-

DC+

C
B
A

Ct

Thyristor half-wave (3-phase) Thyristor half-wave

A

B

C

A1

1

2

6

1

2

3

A6

A

B

C

NN
N N

Ct

Ct
Ct

Ct

B

A

C

Diode full-wave Thyristor full-wave
DC+

DC-

A

B

C

DC+

DC-

1 3 5

4 6 2

1 3 5

4 6 2

A A
B B
C C

DC-

DC+

DC-

DC+

Ct

Ct

VSI3 (MOSFET or IGBT)

A

B

C

1 3 5

24 6
DC-

DC+

DC-

DC+

C
B
A

Ct

Ct

VSI3 (MOSFET switches)

CSI3

DC+

DC-

A

B

C

Ct

CSI3
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Attributes for VSI3 bridge (with MOSFET switches): 

Attributes for VSI3 bridge (with IGBT switches): 

Attributes for the CSI3 bridge: 

Similar to single-phase modules, only the gating signal for Switch 1 need to be specified for three-phase
modules. Gating signals for other switches will be automatically derived. For the 3-phase half-wave thyristor
bridge, the phase shift between two consecutive switches is 120o. For all other bridges, the phase shift is 60o.

Thyristor bridges can be controlled by an alpha controller. Similarly, voltage/current source inverters can be
controlled by a PWM lookup table controller. 

The following examples illustrate the control of three-phase thyristor and voltage source inverter modules.

Example: Control of Three-Phase Thyristor and VSI Modules 

The thyristor circuit on the left uses an alpha controller. For a three-phase circuit, the zero-crossing of the

Parameters Description

On Resistance On resistance of the MOSFET transistor, in Ohm

Diode Threshold Voltage Threshold voltage drop of the diode, in V

Diode Resistance On resistance of the diode, in Ohm

Init. Position_i Initial position for Switch i 

Current Flag_i Current flag for Switch i 

Parameters Description

Saturation Voltage Saturation voltage Vce_sat of the IGBT transistor, in Ohm

Transistor Resistance On resistance of the IGBT transistor, in Ohm

Diode Threshold Voltage Threshold voltage drop of the anti-parallel diode, in V

Diode Resistance On resistance of the anti-parallel diode, in Ohm

Init. Position_i Initial position for Switch i 

Current Flag_i Current flag for Switch i 

Parameters Description

Voltage Drop Forward conduction voltage drop of the switch, in V

Resistance Forward on resistance of the switch, in Ohm

Init. Position_i Initial position for Switch i 

Current Flag_i Current flag for Switch i 

PWM ControllerVac
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voltage Vac corresponds to the moment when the delay angle alpha is equal to zero. This signal is used to
provide synchronization to the controller.

The circuit on the right uses a PWM lookup table controller. The PWM patterns are stored in a lookup table in a
text file. The gating pattern is selected based on the modulation index. Other inputs of the PWM lookup table
controller include the delay angle, the synchronization, and the enable/disable signal. A detailed description of
the PWM lookup table controller is given in the Switch Controllers section.

2.3  Coupled Inductors
Coupled inductors with two, three, and four branches are provided. 

Images:

Attributes:

In the images, the circle, square, triangle, and plus marks refer to Inductor 1, 2, 3, and 4, respectively.

The following shows a coupled inductor with two branches. 

Let L11 and L22 be the self-inductances of Branch 1 and 2, and L12 and L21 the mutual inductances, the branch
voltages and currents have the following relationship:

The mutual inductances between two windings are assumed to be always equal, i.e., L12 = L21.

Example: 
Two mutually coupled inductors have the self inductances and mutual inductance as: L11 = 1 mH, L22 = 1.1 mH,

Parameters Description

Lii (self) Self inductance of the inductor i, in H

Lij (mutual) Mutual inductance between Inductor i and j, in H

Initial Current ii Initial current in Inductor i 

Current Flag_i Flag for the current printout in Inductor i 

2-branch 3-branch 4-branch 6-branch5-branch

i1

i2

v1

v2

+ -

+ -

v1

v2

L11 L12

L21 L22

d
dt
----- i1

i2

⋅=
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and L12 = L21 = 0.9 mH. The specification of this element will be:

2.4  Transformers

2.4.1  Ideal Transformer
An ideal transformer has no losses and no leakage flux.

Images:

The winding with the larger dot is the primary, and the other winding is the secondary.

Attributes:

Since the turns ratio is equal to the ratio of the rated voltages, the number of turns can be replaced by the rated
voltage at each side.

2.4.2  Single-Phase Transformers
 Single-phase transformers with 1 or 2 primary windings and 1 to 6 secondary windings are provided, as shown
below. 

Images:

In the images, p refers to primary, s refers to secondary, and t refers to tertiary. The winding with the largest dot
is the primary winding or first primary winding. For the multiple winding transformers, the sequence of the

L11 (self) 1m

L12 (mutual) 0.9m

L22 (self) 1.1m

Parameters Description

Np (primary) No. of turns of the primary winding

Ns (secondary) No. of turns of the secondary winding

Np Ns Np Ns

   5-winding

p

s_1

s_4

  5-winding

p_1

p_2

s_1

s_3

  4-winding

p_1

p_2

s_1

s_2

  8-winding

p_1

p_2

s_1

s_2

s_6

2-winding     3-winding   7-winding

p s
t

p

p

s
s_1

s_6

s_2

sp

2-windinge 

   6-winding

p_1

p_2

s_1

s_4
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windings is from the top to the bottom. For the transformers with 2 or 3 windings, the attributes are as follows.

Attributes:

All the resistances and inductances are referred to the primary winding side. If there are multiple primary
windings, they are referred to the first primary winding side.

For the transformers with more than 1 primary winding or more than 3 secondary windings, the attributes are as
follows.

Attributes:

All the resistances and inductances are referred to the first primary winding side.

Modeling of a Transformer: 
A transformer is modeled as coupled inductors. For example, a single-phase two-winding transformer is
modeled as two coupled inductors. The equivalent circuit can be shown as: 

In the circuit, Rp and Rs are the primary and secondary winding resistances; Lp and Ls are the primary and
secondary winding leakage inductances; and Lm is the magnetizing inductance. All the values are referred to the
primary side. 

Parameters Description

Rp (primary); 
Rs (secondary);
Rt (tertiary)

Resistance of the primary/secondary/tertiary winding, in Ohm 

Lp (pri. leakage); 
Ls (sec. leakage);
Lt (ter. leakage)

Leakage inductance of the primary/secondary/tertiary winding, in H (seen from 
the primary)

Lm (magnetizing) Magnetizing inductance, in H 

Np (primary); 
Ns (secondary);
Nt (tertiary)

No. of turns of the primary/secondary/tertiary winding

Parameters Description

Rp_i (primary i); 
Rs_i (secondary i)

Resistance of the ith primary/secondary/tertiary winding, in Ohm 

Lp_i (pri. i leakage); 
Ls_i (sec. i leakage)

Leakage inductance of the ith primary/secondary/tertiary winding, in H (referred 
to the first primary winding) 

Lm (magnetizing) Magnetizing inductance, in H (seen from the first primary winding)

Np_i (primary i); 
Ns_i (secondary i)

No. of turns of the ith primary/secondary/tertiary winding 

Lp Ls

Lm

Ideal

Rp Rs Np : Ns

SecondaryPrimary
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Example: 
A single-phase two-winding transformer has a winding resistance of 0.002 Ohm and leakage inductance of 1
mH at both the primary and the secondary side (all the values are referred to the primary). The magnetizing
inductance is 100 mH, and the turns ratio is Np:Ns = 220:440. The transformer will be specified as:  

2.4.3  Three-Phase Transformers
Two-winding and three-winding transformer modules are provided, as shown below. They all have 3-leg cores. 

- 3-phase transformer (windings unconnected) 
- 3-phase Y/Y and Y/Δ connected transformer 
- 3-phase 3-winding transformer (windings unconnected) 
- 3-phase 3-winding Y/Y/Δ and Y/Δ/Δ connected transformer 
- 3-phase 4-winding transformer (windings unconnected) 
- 3-phase 6-winding transformer (windings unconnected)

Images:

Rp (primary) 2m

Rs (secondary) 2m

Lp (primary) 1m

Ls (secondary) 1m

Lm (magnetizing) 100m

Np (primary) 220

Ns (secondary) 440

4-winding (unconnected)

A+
A-
B+
B-
C+
C-

AA+
AA-
BB+
BB-
CC+
CC-

a+
a-
b+
b-
c+
c-
aa+
aa-
bb+
bb-
cc+
cc-

Y/Y Y/D D/D 

Y/Y/D Y/D/D 2-winding (unconnected)

A

B

C

A+
A-
B+
B-
C+
C-

A

B

C

a

b

c

A

B

C

a

b

c

a

b

c

N n

aa+

a+
a-
b+
b-
c+
c-

N

A

B

C

a
b
c

aa
bb
cc

A

B

C

a
b
c

aa
bb
cc

N

n

N

A+
A-
B+
B-
C+
C-

a+
a-
b+
b-
c+
c-

aa-bb+bb-
cc+

cc- 

3-winding (unconnected)

6-winding (unconnected)

Winding 1
(primary)

Winding 2

Winding 3

Winding 4

Winding 5

Winding 6

A+
A-
B+
B-
C+
C-

a+
a-
b+
b-
c+
c-
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Attributes:

In the images, P refers to primary, S refers to secondary, and T refers to tertiary. All resistances and inductances
are referred to the primary or the first primary winding side.

Three-phase transformers are modeled in the same way as single-phase transformers.

2.5  Magnetic Elements
A set of magnetic elements, including winding, leakage flux path, air gap, linear core, and saturable core, is
provided to model magnetic devices. These elements are the basic building blocks of magnetic equivalent
circuits, and they provide a very powerful and convenient way of modeling any types of magnetic devices. 

Different unit systems have been used in the magnetic circuit analysis. The table below shows magnetic
quantities in the SI (System International) and the mixed CGS (Centimeter Gram Second) unit systems, and
their conversion. 

2.5.1  Winding
A winding element provides the interface between the electric circuit and the magnetic equivalent circuit. 

Image:

Parameters Description

Rp (primary); 
Rs (secondary);
Rt (tertiary)

Resistance of the primary/secondary/tertiary winding, in Ohm

Lp (pri. leakage); 
Ls (sec. leakage);
Lt (ter. leakage)

Leakage inductance of the primary/secondary/tertiary winding, in H 

Lm (magnetizing) Magnetizing inductance, in H (seen from the primary side) 

Np (primary); 
Ns (secondary);
Nt (tertiary)

No. of turns of the primary/secondary/tertiary winding 

Quantity SI Unit CGS Unit CGS-SI Conversion
Flux φ Weber Maxwell 1 Weber = 104 Maxwell
Flux Density B Tesla Gauss 1 Tesla = 104 Gauss

Field Intensity H A*Turns/m Oerstad 1 A*Turns/m =  Oerstad

Magnetomotive Force (mmf) F A*Turns Gilbert 1 A*Turns =  Gilbert

Permeability (space) μο 4π*10-7 1 4π*10-7

1000
4π

------------

10
4π
------

E1

M2
E2

M1
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Attributes:

This element represents a winding on a magnetic core. The two electric nodes (E1 and E2) are connected to an
electric circuit, while the two magnetic nodes (M1 and M2) are connected to other magnetic elements (such as
leakage flux path, air gap, and magnetic core). 

2.5.2  Leakage Flux Path
This element models the flow path of the leakage flux. 

Image:

Attributes:

The resistance R represents the losses due to the leakage flux. 

Assuming that the mmf (magnetomotive force) applied across the leakage flux path is F, the electric equivalent
circuit of the leakage flux path is as follows:

The mmf, in the form of a voltage source, applies across the capacitor (the capacitance is AL) and the resistor R.
Let the current flowing through this branch be i, and the rms value be Irms, the relationship between the losses
due to the leakage flux and the resistance R is:

2.5.3  Air Gap
The image and attributes of an air gap element are as follows. 

Image:

Parameters Description

Number of Turns No. of turns of the winding

Winding Resistance Winding resistance, in Ohm

Parameters Description

Inductance Factor AL Inductance factor AL, defined as the inductance per turn squared

Resistance for Losses Resistance R, in Ohm, that represents the losses due to the leakage flux.

Current Flag Display flag of the current that flows through the resistor R

M1 M2

+ i

-

F

AL

R

Ploss Irms
2 R⋅=

M1 M2
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The input parameters of the air gap can be defined in two ways. One is to define the air gap length and the cross
section area, and the other is to define the inductance factor AL. They are as follows. 

Attributes:

For the element Air Gap: 

For the element Air Gap (AL): 

The resistance R represents the losses due to the air gap fringing effect. Assuming that the mmf (magnetomotive
force) applied across the air gap is F, the electric equivalent circuit of the air gap is as follows:

The mmf, in the form of a voltage source, applies across the capacitor (the capacitance has the value of the
inductance factor AL) and the resistor R. For the element Air Gap, the inductance factor can be calculated from
the air gap length and the cross section area as:

where μo= 4π∗10−7.

The losses on the resistor represents the losses due to the fringing effect, which can be expressed as:

where Irms is the rms value of the current i flowing through the resistor. 

Parameters Description

Air Gap Length The length of the air gap, lg, in m

Cross Section Area Cross section of the air gap, Ac, in m2

Resistance for Losses Resistance R, in ohm, that represents the losses due to the air gap fringing effect

Current Flag Display flag of the current that flows through the resistor R

Parameters Description

Inductance Factor AL Inductance factor AL, defined as the inductance per turn squared

Resistance for Losses Resistance R, in ohm, that represents the losses due to the air gap fringing effect

Current Flag Display flag of the current that flows through the resistor R

+ i

-

F

AL

R

AL
μo Ac⋅

lg
----------------=

Ploss Irms
2 R⋅=
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2.5.4  Linear Core
This element represents a linear lossless core. 

Image:

Attributes:

If the length of the core is Llength and the cross section area is Ac, the inductance factor AL is expressed as:

where μr is the relative permeability of the core material. 

2.5.5  Saturable Core
This element models a magnetic core with saturation and hysteresis.

Image:

Attributes:

In the element image, the nodes M1 and M2 are the two nodes that connect the core to other magnetic elements
(such as winding, flux leakage path, air gap, etc.). The node marked with a dot is Node M2. Node C1 is a control
output node, which shows the flux (in Weber) flowing through the core, from Node M2 to M1. 

Parameters Description

Inductance Factor AL Inductance factor AL of the core, defined as the inductance per turn squared

Parameters Description

Inductance Factor AL Inductance factor AL of the core, defined as the inductance per turn squared

Resistance for Losses Resistance R, in Ohm, that represents the core losses

Coefficient phi_sat Coefficient Φsat for the core B-H curve, in Weber 

Coefficient K1 Coefficient K1 for the core B-H curve

Coefficient Kexp1 Coefficient Kexp1 for the core B-H curve

Coefficient K2 Coefficient K2 for the core B-H curve

Coefficient Kexp2 Coefficient Kexp2 for the core B-H curve

Initial Flux phi_o Initial flux Φo of the core, in Weber

Current Flag Display flag of the electric current that flows through the resistor R. If the rms 
value of the current is Irms, the core losses can be calculated as: Pcore_loss = Irms

2 * 
R.

M1 M2

AL
μo μr Ac⋅ ⋅

Llength
-------------------------=

C1

M1 M2
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The initial flux of the core, Φo, is the flux flowing from Node M2 to M1 at the beginning, corresponding to the
field intensity H = 0. The initial flux density Bo can be calculated as: Bo = Φo/Ac (where Ac is the core cross
section area), and the initial mmf Fo is: Fo = Φo/AL. 

A differential voltage probe connected between Node M2 to M1 will measure the mmf (in ampere*turn) applied
to the core. 

The coefficients Φsat, K1, Kexp1, K2, and Kexp2 are used to fit the B-H curve of an actual magnetic material. A
good initial guess of Φsat is the maximum flux of the B-H curve in deep saturation. To calculate this flux,
multiply the corresponding flux density B by the cross section area of the core. Coefficient K1 usually varies
between 0.7 and 1, depending on the core material. Coefficient Kexp1 mainly affects the rate of the core
saturation, and is in the range between 10 and 200 (10 for low permeability ferrite, and 200 for metglas).

The coefficients K2 and Kexp2 are used in very rare occasions, such as for ferroresonant regulators. They are
normally set as follows to keep them from affecting the B-H curve:

K2 > 2

Kexp2 > 20

A tutorial on how to define the core coefficients is provided in the "doc" sub-folder in the PSIM directory. Also,
a program is provided to plot the B-H curve of the core given a set of coefficients. To launch this program, in
PSIM, go to Utilities -> B-H Curve. 

2.6  Other Elements

2.6.1  Operational Amplifier
Two types of operational amplifier (op. amp.) models are provided: ideal op. amp. model, and non-ideal op.
amp. model (Level-1 model).

Note that the ideal op. amp. model works in the negative feedback mode but does not work in the positive
feedback mode. The non-ideal op. amp. model does not have such a restriction.

2.6.1.1  Ideal Operational Amplifier
Three ideal op. amp. elements are provided: Op. Amp., Op. Amp. (ground), and Op. Amp. (ground/inverted). An
ideal op. amp. is modelled using power circuit elements, as shown below.

Images:

where 
V+; V- - noninverting and inverting input voltages

V+

V-
Vo

Op. Amp.

Circuit Model of the Op. Amp.

V+

V-
Vo

V+

V-

Vo

Vs+Vs-

Ro

Ao*(V+ - V-)

gnd

Op. Amp. (ground)

gnd

V+

V-

Vo

Op. Amp. (ground/inverted)

gnd
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Attributes: 

The difference between the element Op. Amp. and Op. Amp. (ground) or Op. Amp. (ground/inverted) is that, for
the Op. Amp. element, the reference ground of the op. amp. model is connected to the power ground, whereas
for Op. Amp. (ground) or Op. Amp. (ground/inverted), the reference ground node of the model is accessible and
can be floating.

Note that the image of an op. amp. is similar to that of a comparator. For the op. amp., the inverting input is at
the upper left and the noninverting input is at the lower left. For the comparator, it is the opposite. 

Example: A Boost Power Factor Correction Circuit
The figure below shows a boost power factor correction circuit. The PI regulators of both the inner current loop
and the outer voltage loop are implemented using op. amp. 

2.6.1.2  Non-Ideal Operational Amplifier
As compared to the ideal op. amp. model, the non-ideal op. amp. model, also referred to as Level-1 op. amp.
model, includes the following characteristics in the model:

- Op. amp. bandwidth
- Output current limit

The non-ideal op. amp. is modelled using power circuit elements, and similar to the ideal op. amp., is treated as
a power element in PSIM.

Two non-ideal op. amp. elements are provided: Op. Amp. (level-1) and Op. Amp. (ground) (level-1). The
difference between these two elements is that, for Op. Amp. (level-1), the reference ground of the op. amp.
model is connected to the power ground, whereas for Op. Amp. (ground) (level-1), the reference ground node of
the model is accessible and can be floating.

The non-ideal op. amp. images have the number "1" at the upper right corner, as shown below.

Vo - output voltage

Ao - op. amp. dc gain (Ao is set to 100,000.)

Ro - output resistance (Ro is set to 80 Ohms)

Parameters Description

Voltage Vs+ Upper voltage source level of the op. amp. 

Voltage Vs- Lower voltage source levels of the op. amp.

Comparator
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Images:

Attributes: 

The figure below shows the definition of the dc gain Ao and the unit gain frequency. 

2.6.2  TL431 Shunt Regulator
The image of the TL431 shunt regulator is shown as below. 

Image: 

The TL431 regulator maintains the reference node voltage to be around 2.495V. In this model, the limited
bandwidth of the TL431 is modelled. That is, the ac frequency response of the TL431 model resembles the
following figure from the datasheet.

Parameters Description

Input Resistance Rin Input resistance of the op. amp., in Ohm 

DC Gain Ao DC gain of the op. amp. 

Unit Gain Frequency Frequency at which the op. amp. gain is 1, in Hz.

Output Resistance Ro Output resistance of the op. amp., in Ohm

Maximum Output 
Current

Maximum current that the op. amp. output can provide, in A

Voltage Vs+ Upper voltage source level of the op. amp.

Voltage Vs- Lower voltage source levels of the op. amp.

V+

V-
Vo

Op. Amp. (level-1)

V+

V-
Vo

Op. Amp. (ground) (level-1)

gnd

Open-Loop 

f (Hz)

Unit gain frequency

Gain Av

0

Ao
(dB)

Cathode

Anode

Reference
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2.6.3  Optocoupler
The image and parameters of a optocoupler are shown below.

Image:

Attributes: 

These parameters can either be read directly from the manufacturer datasheet, or can be calculated from the
datasheet information. Take the Motorola optocoupler 4N25 as an example. From the datasheet, we can read the
current transfer ratio and the transistor saturation voltage as:

CTR = 70% = 0.7; Vce_sat = 0.15 V

From the "LED Forward Voltage versus Forward Current" characteristics on the datasheet, one can calculate the
diode resistance Rd and the threshold voltage Vd_th. We assume that the diode forward voltage is approximated
by a straight line. That is,

vd = Vd_th + Rd * id

With TA = 25oC, we can obtain two readings from the curve: id = 10 mA and vd = 1.15 V; id = 40 mA and vd =
1.3 V. Based on these two points, we can calculate Rd and Vd_th as: Rd = 5 Ohm; Vd_th = 1.1 V.

The optocoupler model does not take into account the delay, but it does model the turn-on/turn-off transient

Parameters Description

Current Transfer Ratio The current transfer ratio CTR between the transistor current ic and the diode 
current id, that is, CTR = ic/id.

Diode Resistance Diode resistance Rd, in Ohm. Note that the resistance must be greater than 0.

Diode Threshold 
Voltage

The forward diode threshold voltage Vd_th, in V

Transistor Vce_sat The transistor saturation voltage Vce_sat, in V

Transistor-side 
Capacitance

Capacitance Cp across the collector and emitter of the transistor, in F

Test Circuit 

id ic
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through the capacitor Cp across the collector and emitter of the transistor. The capacitance value can be obtained
from the fall time tfall and the switching time test condition as:

where RL is the load resistor in the switching time test circuit. For 4N25, for example, from the datasheet, we
can obtain: tfall = 1.3 μs, and RL = 100 Ohm. The capacitance is calculated as: Cp = 6 nF.

2.6.4  dv/dt Block
A dv/dt block has the same function as the differentiator in the control circuit, except that it is for the power
circuit. 

Image: 

The output of the dv/dt block is equal to the derivative of the input voltage versus time. It is calculated as: 

where Vin(t) and Vin(t-Δt) are the input values at the current and previous time step, and Δt is the simulation time
step. 

Cp
tfall

2.2 RL⋅
------------------=

Vo
Vin t( ) Vin t Δt–( )–

Δt
----------------------------------------------=
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2.7  Thermal Module
The Thermal Module is an add-on module to the PSIM program. It provides a quick way of estimating the
losses of semiconductor devices (diodes, IGBT, and MOSFET). 

The core of the Thermal Module is the device database. A device database editor is provided to allow users to
add new devices to the database and to manage the database easily. The devices in the database can then be used
in the simulation for the loss calculation. 

The following illustrates the process of how a device in the database is used in the simulation and how the
losses are calculated:

- The behavior model of the device is used in the simulation. The behavior model takes into account the
static characteristics of the device (such as conduction voltage drop, on-state resistance, etc.), but not the
dynamic characteristics (such as turn-on and turn-off transients). 

- Based on the voltage, current, and junction temperature values from the simulation, PSIM accesses the
device database and calculates the conduction losses or switching losses. The static characteristics of the
device are updated for the next simulation.

Note that the loss calculation is only an approximation, and the accuracy of the results depends on the accuracy
of the device data as well as the proper scaling of the results from the device test condition to the actual circuit
operating conditions. Users should always verify the results with the measurement from the experimental setup.

The following sections describe how a device is added to the database, and how it is used in the simulation. 

2.7.1  Device Database Editor
The device database editor, PcdEditor.exe, provides an easy and convenient way of adding, editing, and
managing devices. An image of the database editor is shown below.

On the left are the device database files that are loaded into the database editor, and the list of the devices. The
devices can be displayed based on either Device Type or Manufacturer. Also, the device list can be sorted by
Part Number, Voltage rating, or Current rating, by clicking on the title bars of the list. 

On the right is the information of each device. In general, the following information is defined for the device:

- Manufacturer and Part Number
- Package type
- Absolute maximum ratings
- Electrical characteristics
- Thermal characteristics
- Dimension and weight
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To create a new device file, choose File -> New Device File. To load a device files into the editor, choose File -
> Open Device File. To unload a device file from the editor, choose File -> Close Device File. 

Three types of devices can be added to a device files: diode, IGBT, and MOSFET. However, since dual IGBT-
diode modules have a different set of parameters as compared to the regular IGBT devices, they are treated as a
separate type (referred to as the IGBT-DIODE type). The sections that follow describe in more details each type
of devices.

To create a new device, go to the Device menu, and choose either New Diode, New IGBT, New IGBT-Diode,
or New MOSFET. 

To make a copy of an existing device in the same database file, highlight the device in the list, and choose
Device -> Save Device As. To make a copy of an existing device and save it in a different database file, first
highlight the device in the list, then highlight the file name in the File Name list, and choose Device -> Save
Device As. 

Adding a Device to the Database:

To illustrate how to add a device to a database file, below is the step-by-step procedure to add the Powerex
discrete diode CS240650 (600V, 50A) into the device database file "diode_new.dev".

- Launch PcdEditor.exe. Go to File -> New Device File, and create a file called "diode_new.dev". This file
will be placed in the device sub-folder under the PSIM program folder by default.

- With the file name "diode_new" highlighted in the "File Name" list, Choose Device -> New Diode. A
diode will be added to the database file with Manufacturer as "New" and Part Number as "New". 

- Obtain the datasheet of Powerex diode CS240650 from the web site www.pwrx.com. Show the PDF file
of the datasheet on the screen. 

- By referring to the information from the datasheet, in the database editor, enter the following information
for this device:

Manufacturer: Powerex
Part Number: CS240650
Package: Discrete

   and under Absolute Maximum Ratings:

Vrrm,max (V): 600
IF,max (A): 50
Tj,max (oC): 150

Device
database
files

Device
list

Device
information
36    Chapter 2: Power Circuit Components



- Define the forward voltage characteristics Vd vs. IF under Electrical Characteristics by clicking on the
Edit button on top of the Vd vs. IF graph area. 

The following dialog window will appear. The dialog window has two pages: Graph and Conditions. 

The Graph page contains thee x and y axis settings as well as the data points and the graph. In this case,
the y axis is the conduction voltage drop Vd, and the x axis is the forward current IF. The x and y axis can
have multiplying factors (such as m for 10-3, u for 10-6, etc.). 

The Conditions page contains the conditions under which the graph is obtained.

There are two ways to define the graph. One is to enter the graph data points manually. Another is to use
the Graph Wizard to capture the graph directly from the datasheet image. Defining the graph manually is
preferred if there is only one data point or there are just a few data points. However, if the graph image is
available, it is easier with the Graph Wizard.

To Define the Graph Manually:

- Refer to the "Maximum On-State Characteristics" graph of the datasheet, and enter the values for the
x/y axis settings as follows:

X0: 1
Xmax: 1000
Y0: 0.6
Ymax: 2.6
X in log: checked

- Visually inspect the graph, and select a few data points. Enter the data points in the data area as
follows:

Graph
wizard icons

Help area

X and Y 
axis settings

Graph area

X/Y axis
multiplying
factor

Data area
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(1,0.7) (10,1.05) (100,1.8) (200,2.2) (300,2.4)

Then click on the Refresh button to display the graph. 

- Click on the Conditions tab and enter the Junction Temperature as 25 oC.

Alternatively, the graph can be defined in this case using the Graph Wizard.

To Define the Graph Using the Graph Wizard:

- Click on the Add Curve button. Then click on the forward wizard icon to start the Graph
Wizard. 

- Display the graph of the datasheet on the screen as follows:

Then press the Print Screen key (the key is labeled as "Prt Scr" on some keyboards) to copy the screen
image to the clipboard.

- Click on the forward wizard icon to paste the screen image into the graph window in the
database editor. Position the graph image properly in the graph window by dragging the left mouse so
that the complete graph is displayed within the window. 

If the graph image is either too large or too small, go back to the previous step by clicking on the

backward wizard icon . Then resize the image of the graph in the Adobe Acrobat, and copy the
screen image to the clipboard again.

The graph dialog window should look something like follows.
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Click on the forward wizard icon to move on to the next step. 

- In this step, the border of the graph area is defined by first left clicking at the origin of the graph
(usually the lower left corner), then left clicking again at the opposite corner of the origin (usually the
upper right corner). Note that the graph origin does not have to be the lower left corner, and it can be
any one of the four corners.

To locate the origin of the corner more accurately, right mouse click to zoom in, and press the Esc
(escape) key to exit the zoom.

After this, a blue rectangle will appear around the border of the graph, and the dialog window will
appear as follows.
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Then click on the forward wizard icon to move on to the next step. 

- In this step, the x and y axis settings will be defined. Enter the settings as follows:

X0: 1
Xmax: 1000
Y0: 0.6
Ymax: 2.6
X in log: checked

Leave the checkbox Invert graph unchecked since the diode forward current IF is in the x-axis in this
case. But in other situations, if the current is in y-axis, check the Invert graph checkbox. 

Enter the junction temperature as 25 oC. Click on the forward wizard icon to move on to the next
step. 

- Left click on top of the graph to capture the data points. In this case, for example, four data points at
the current values of around 1A, 10A, 100A, and 280A are captured. Again, right click to zoom in.
You can capture as many data points as desired.

Origin of
the graph

Opposite
end of the
origin
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As data points are captured, red lines will appear that will connect the data points. 

Then click on the forward wizard icon to complete the data capture process. The final graph
dialog window should appear as follows.

Data points
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To see the x and y axis values of a particular data point on the graph, place the cursor inside the graph
area. The cursor image will change to a cross image, and the x and y coordinates of the cursor will be
displayed at the upper right corner of the dialog window. Place the cursor on top of the curve to read
the x and y axis readings. 

If there are multiple curves for different junction temperatures, repeat the same process and enter the
junction temperature value for each curve accordingly. Use the drop-down menu at the upper right
corner of the dialog window to show one particular curve, or to show all the curves at the same time. 

- With the same process, define the reverse recovery characteristics trr vs. IF, Irr vs. IF, and Qrr vs. IF. 

- Enter the Thermal Characteristics as:

Rth(j-c): 0.6
Rth(c-s): 0.4

- Enter the Dimension and Weight as:

Length (mm): 53
Width (mm): 36
Height (mm): 29

Choose Device -> Save Device to save the device information. This completes the process of adding the diode
into the database. 

2.7.2  Diode Device in the Database
The following information is defined for a diode device in the database:

General Information: 
Manufacturer: Device manufacture
Part Number: Manufacturer’s part number
Package: It can be discrete, dual, or 3-phase bridge package, as shown in the figure

below: 

In the images, beside the diode anode and cathode terminals, there are two
extra nodes. The node with a dot is for the diode conduction losses Pcond, and
the node without a dot is for the diode switching losses Psw. 
The style of the package (for example, TO-220, TO-247, etc.) can be
specified in the Style field. 

Absolute Maximum Ratings: 
Vrrm,max (V): Peak reverse blocking voltage
IF,max (A): Maximum dc current
Tj,max (oC): Maximum junction temperature

Electrical Characteristics: 
Vd vs. IF: Forward conduction voltage drop Vd vs. forward current IF
trr vs. IF: Reverse recovery time trr vs. current IF

Discrete Dual Dual Dual 

Psw

Pcond

(Type I) (Type II) (Type (III)
3-phase
Bridge 
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Irr vs. IF: Peak reverse recovery current Irr vs. current IF
Qrr vs. IF: Reverse recovery charge Qrr vs. current IF
Err vs. IF: Reverse recovery energy losses Err vs. current IF

Thermal Characteristics: 
Rth(j-c): Junction-to-case thermal resistance, in oC/W
Rth(c-s): Case-to-sink thermal resistance, in oC/W

Dimensions and Weight: 
Length (mm): Length of the device, in mm
Width (mm): Width of the device, in mm
Height (mm): Height of the device, in mm
Weight (g): Weight of the device, in g

Note that the condition "Reverse blocking voltage VR (V)" in characteristics Err vs. IF is used to scale the loss
calculation, and must be entered correctly. 

Also, parameters under Absolute Maximum Ratings, Thermal Characteristics, and Dimensions and Weight are
not used in the loss calculation, and are optional.

In addition, the diode forward conduction voltage drop Vd changes depending on the forward current IF. The
new voltage drop is used in the subsequent simulation. 

2.7.3  Diode Loss Calculation
A diode device in the database can be selected and used in the simulation for loss calculation. A diode in the
Thermal Module library has the following parameters: 

Attributes: 

The parameter Frequency refers to the frequency under which the losses are calculated. For example, if the
device operates at the switching frequency of 10 kHz, and the parameter Frequency is also set to 10 kHz, the
losses will be the values for one switching period. However, if the parameter Frequency is set to 60 Hz, then the
losses will be the value for a period of 60 Hz.

The parameter Pcond Calibration Factor is the correction factor for the conduction losses. For the example, if
the calculated conduction losses before the correction is Pcond_cal, then

Pcond = Kcond * Pcond_cal

Similarly, the parameter Psw Calibration Factor is the correction factor for the switching losses. For the
example, if the calculated switching losses before the correction is Psw_cal, then

Psw = Ksw * Psw_cal

When several identical diodes are in parallel, one should have just one device in the schematic, and set the
correct number of devices in the parameter input. This is because when several identical devices are in parallel
in the schematic, the device currents may not be exactly equal due to small differences in the simulation. When

Parameters Description

Device The specific device selected from the device database

Frequency Frequency, in Hz, under which the losses are calculated

Pcond Calibration 
Factor

The calibration factor Kcond of the conduction losses Pcond

Psw Calibration Factor The calibration factor Ksw of the switching losses Psw

Number of Parallel 
Devices

Number of identical diode devices in parallel 
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the number of parallel devices is greater than one, the total current through the group of the parallel devices will
be equally divided among the devices. The total losses are then obtained by multiplying the losses in each
device by the number of parallel devices. The currents flowing out of Nodes Pcond and Psw are the total losses of
all the parallel devices combined. 

The voltage at the conduction losses node Pcond or the switching losses node Psw represents the calculated
junction temperature Tj of the diode, and this junction temperature is used when the database curves are used for
loss calculation. If the calculated Tj is between the junction temperatures of two curves, interpolation will be
used. If the calculated Tj is lower than the lowest Tj or higher than the highest Tj in the curves, the curve
corresponding to the lowest or highest Tj will be used. If there is only one curve, that curve is used regardless of
the calculated Tj. 

Conduction Losses:

The diode conduction losses are calculated as:

Conduction Losses = Vd * IF

where Vd is the diode voltage drop, and IF is the diode forward current. When the diode is conducting
periodically with an on duty cycle of D, the conduction losses are calculated as:

Conduction Losses = Vd * IF * D 

Switching Losses:

In calculating the switching losses, the diode turn-on losses are neglected and are not considered. 

The diode turn-off losses due to the reverse recovery is calculated as:

Psw_off = Err * f  * VR / VR_datasheet

or

Psw_off = 1/4 * Qrr * VR * f  

where Err is the reverse recovery energy losses, Qrr is the reverse recovery charge, f is the frequency as defined
in the input parameter Frequency, VR is the actual reverse blocking voltage, and VR_datasheet is the reverse
blocking voltage in the Err characteristics of the datasheet, defined as "Reverse blocking voltage VR (V)" in the
test conditions.

The reverse recovery charge Qrr is defined as:

Qrr = 1/2 * trr * Irr

Whenever Err is given in the device database, the losses will be calculated based on Err. If Err is not given, the
losses will be calculated based on Qrr. If Qrr is not given, the losses will be calculated based on trr and Irr. If
both are not given, the losses will be treated as 0. 

The losses Pcond and Psw, in watts, are represented in the form of currents which flow out of these nodes.
Therefore, to measure and display the losses, an ammeter should be connected between the Pcond or Psw node
and the ground. When they are not used, these two nodes cannot be floating, and must be connected to ground. 

Example: Diode Loss Calculation 
The circuit below shows a sample circuit that uses the Powerex’s discrete diode CS240650 (600V, 50A). The
conduction losses and the switching losses are measured through two ammeters. 

Once the information of the losses is available, by building the thermal equivalent circuit, the device junction
temperature can be calculated. This junction temperature is in turn fed back and used in the loss calculation. The
circuit shows a thermal circuit without considering the thermal transient.
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2.7.4  IGBT Device in the Database
An IGBT device has three types of packages: discrete, dual, or 6-pack. 

For the dual package, both the top and the bottom switches can be IGBT’s (full-bridge configuration), or one of
the switches is IGBT and the other is a free-wheeling diode (half-bridge configuration). For the half-bridge dual
IGBT device, since the free-wheeling diode parameters can be different from these of the anti-parallel diode,
this type of device is referred to as the IGBT-Diode device, and is treated as a different type in the simulation.
But for the convenience of discussion, both devices are referred to as the IGBT devices here.

The following information is defined for an IGBT device in the database:

General Information: 
Manufacturer: Device manufacture
Part Number: Manufacturer’s part number
Package: It can be discrete, dual, or 6-pack, as shown in the figure below: 

In the images, beside the IGBT and diode terminal nodes, there are four extra
nodes from the top to the bottom (or from the left to the right on the top for
the 6-pack package). They are the nodes for transistor conductor losses
Pcond_Q (the node with a circle), for transistor switching losses Psw_Q, for
diode conductor losses Pcond_D (the node with a square), and for diode

Speed 
Sensor

Discrete Dual

Dual (Type I)

6-Pack

Psw_Q
Pcond_Q

Psw_D

Pcond_D Q1

Q4

Q1 Q4

Dual (Type II)
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switching losses Psw_D, respectively. 
The style of the package (for example, TO-247, TO-268, etc.) can be
specified in the Style field. 

Absolute Maximum Ratings: 
Vce,max (V): Maximum collector-emitter voltage
Ic,max (A): Maximum collector current
Tj,max (oC): Maximum junction temperature

Electrical Characteristics - Transistor: 
Vce(sat) vs. Ic: Collector-emitter saturation voltage Vce(sat) vs. collector current Ic
Eon vs. Ic: Turn-on energy losses Eon vs. collector current Ic
Eoff vs. Ic: Turn-off energy losses Eoff vs. collector current Ic

Electrical Characteristics - Diode (or Anti-Parallel Diode): 
Vd vs. IF: Forward conduction voltage drop Vd vs. forward current IF
trr vs. IF: Reverse recovery time trr vs. current IF
Irr vs. IF: Peak reverse recovery current Irr vs. current IF
Qrr vs. IF: Reverse recovery charge Qrr vs. current IF
Err vs. IF: Reverse recovery energy losses Err vs. current IF

Electrical Characteristics - Free-Wheeling Diode (for IGBT-Diode device only): 
Vd vs. IF: Forward conduction voltage drop vs. forward current IF
trr vs. IF: Reverse recovery time trr vs. current IF
Irr vs. IF: Peak reverse recovery current Irr vs. current IF
Qrr vs. IF: Reverse recovery charge Qrr vs. current IF
Err vs. IF: Reverse recovery charge Err vs. current IF

Thermal Characteristics: 
Rth(j-c) (transistor): Transistor junction-to-case thermal resistance, in oC/W
Rth(j-c) (diode): Diode junction-to-case thermal resistance, in oC/W
Rth(c-s): Case-to-sink thermal resistance, in oC/W

Dimensions and Weight: 
Length (mm): Length of the device, in mm
Width (mm): Width of the device, in mm
Height (mm): Height of the device, in mm
Weight (g): Weight of the device, in g

Note that the condition "DC bus voltage (V)" in the characteristics Eon vs. Ic and Eoff vs. Ic for transistors, and
the condition "Reverse blocking voltage VR (V)" in the characteristics Err vs. IF for anti-parallel and free-
wheeling diodes, are used to scale the loss calculation, and must be entered correctly. 

Also, parameters under Absolute Maximum Ratings, Thermal Characteristics, and Dimensions and Weight are
not used in the loss calculation, and are optional.

In addition, the collector-emitter saturation voltage Vce(sat) of the transistor and the forward conduction voltage
drop Vd of the diode change depending on the currents. The new values are used in the subsequent simulation.
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2.7.5  IGBT Loss Calculation
An IGBT device in the database can be selected and used in the simulation for loss calculation. An IGBT device
in the Thermal Module library has the following parameters: 

Attributes: 

The parameter Frequency refers to the frequency under which the losses are calculated. For example, if the
device operates at the switching frequency of 10 kHz, and the parameter Frequency is also set to 10 kHz, the
losses will be the values for one switching period. However, if the parameter Frequency is set to 60 Hz, then the
losses will be the value for a period of 60 Hz.

The parameter Pcond_Q Calibration Factor is the correction factor for the transistor conduction losses. For the
example, if the calculated conduction losses before the correction is Pcond_Q_cal, then

Pcond_Q = Kcond_Q * Pcond_Q_cal

Similarly, the parameter Psw_Q Calibration Factor is the correction factor for the transistor switching losses.
For the example, if the calculated switching losses before the correction is Psw_Q_cal, then

Psw_Q = Ksw_Q * Psw_Q_cal

Parameters Pcond_D Calibration Factor and Psw_D Calibration Factor work in the same way, except that they
are for the diode losses.

When several identical IGBT devices are in parallel, one should have just one device in the schematic, and set
the correct number of devices in the parameter input. This is because when several identical devices are in
parallel in the schematic, the device currents may not be exactly equal due to small differences in the
simulation. When the number of parallel devices is greater than one, the total current through the group of the
parallel devices will be equally divided among the devices. The total losses are then obtained by multiplying the
losses in each device by the number of parallel devices. The currents flowing out of Nodes Pcond_D, Psw_D,
Pcond_Q, and Psw_Q are the total losses of all the parallel devices combined. 

The voltage at the conduction losses node Pcond_Q or the switching losses node Psw_Q represents the calculated
junction temperature Tj_Q of the transistor, and the voltage at the conduction losses node Pcond_D or the
switching losses node Psw_D represents the calculated junction temperature Tj_D of the anti-parallel diode, as
shown below.

Parameters Description

Device The specific device selected from the device database

Frequency Frequency, in Hz, under which the losses are calculated

Pcond_Q Calibration 
Factor

The calibration factor Kcond_Q of the transistor conduction losses Pcond_Q

Psw_Q Calibration 
Factor

The calibration factor Ksw_Q of the transistor switching losses Psw_Q

Pcond_D Calibration 
Factor

The calibration factor Kcond_D of the diode conduction losses Pcond_D

Psw_D Calibration 
Factor

The calibration factor Ksw_D of the diode switching losses Psw_D

Number of Parallel 
Devices

Number of identical IGBT devices in parallel
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The calculated junction temperatures Tj_Q and Tj_D are used when the database curves are used for loss
calculation. If the calculated junction temperature is between the junction temperatures of two curves,
interpolation will be used. If the calculated junction temperature is lower than the lowest junction temperature
or higher than the highest junction temperature in the curves, the curve corresponding to the lowest or highest
junction temperature will be used. If there is only one curve, that curve is used regardless of the calculated
junction temperature. 

Conduction Losses:

The transistor conduction losses is calculated as:

Transistor Conduction Losses = Vce(sat) * Ic

where Vce(sat) is the transistor collector-emitter saturation voltage, and Ic is the collector current. When the
transistor is conducting periodically with an on duty cycle of D, the conduction losses are calculated as:

Transistor Conduction Losses = Vce(sat) * Ic * D 

Switching Losses:

The transistor turn-on losses is calculated as:

Transistor Turn-on Losses = Eon * f  * Vcc / Vcc_datasheet

where Eon is the transistor turn-on energy losses, f is the frequency as defined in the input parameter Frequency,
Vcc is the actual dc bus voltage, and Vcc_datasheet is the dc bus voltage in the Eon and Eoff characteristics of the
datasheet, defined as "DC bus voltage (V)" in the test conditions. 

The transistor turn-off losses is calculated as:

Transistor Turn-off Losses = Eoff * f  * Vcc / Vcc_datasheet

where Eoff is the transistor turn-off energy losses. 

The loss calculation for the anti-parallel diode or free-wheeling diode is the same as described in the section for
the diode device.

The losses Pcond_Q, Psw_Q, Pcond_D, and Psw_D, in watts, are represented in the form of currents which flow out
of these nodes. Therefore, to measure and display the losses, an ammeter should be connected between the
nodes and the ground. When they are not used, these nodes cannot be floating and must be connected to ground. 

Example: IGBT Loss Calculation 
The circuit below shows a sample circuit that uses Powerex’s 6-pack IGBT module CM100TU-12H (600V,
100A). The conduction losses and the switching losses of the transistors and the diodes are added separately,
and a thermal equivalent circuit is provided to calculate the temperature raise. 

With the Thermal Module, users can quickly check the thermal performance of a device under different
operating conditions, and compare the devices of different manufactures. 

Transistor junction temperature

Psw_Q
Pcond_Q

Psw_D

Pcond_D

Diode junction temperature
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2.7.6  MOSFET Device in the Database
The following information is defined for a MOSFET device in the database:

General Information: 
Manufacturer: Device manufacture
Part Number: Manufacturer’s part number
Package: It can be discrete, dual, or 6-pack, as shown in the figure below: 

In the images, beside the MOSFET and diode terminal nodes, there are four
extra nodes from the top to the bottom (or from the left to the right on the top
for the 6-pack package). They are the node for transistor conductor losses
Pcond_Q (the node with a circle), for transistor switching losses Psw_Q, for
diode conductor losses Pcond_D (the node with a square), and for diode
switching losses Psw_D, respectively. 
The style of the package (for example, TO-220, TO-262, TO-247, etc.) can be
specified in the Style field. 

Absolute Maximum Ratings: 
VDS,max (V): Maximum drain-to-source voltage
ID,max (A): Maximum continuous drain current

Tj,max (oC): Maximum junction temperature

Electrical Characteristics - Transistor: 
RDS(on) (ohm): Static drain-to-source on-resistance (test conditions: gate-to-source voltage

VGS, in V, and drain current ID, in A)
VGS(th) (V): Gate threshold voltage VGS(th) (test condition: drain current ID, in A)
gfs (S): Forward transconductance gfs. In the linear region of the device, we have

(test conditions: drain-to- source voltage VDS in V, and

drain current ID in A)
tr (ns) and tf (ns): Rise time tr and fall time tf (test conditions: drain-to-source voltage VDS, in V;

drain current ID, in A; and gate resistance Rg, in ohm)
Qg, Qgs, and Qgd: Total gate charge Qg, gate-to-source charge Qgs, and gate-to-drain ("Miller")

charge Qgd, respectively, all in nC (test conditions: drain-to-source voltage
VDS, in V; gate-to-source voltage VDS, in V; and drain current ID, in A)

Ciss, Coss, and Crss: Input capacitance Ciss, output capacitance Coss, and reverse transfer
capacitance Crss, respectively, all in pF (test conditions: drain-to-source
voltage VDS, in V; gate-to-source voltage VDS, in V; and test frequency, in
MHz)

Discrete Dual 6-Pack

Psw_Q
Pcond_Q

Psw_D

Pcond_D Q1

Q4

Q1 Q4

(n-channel)

(p-channel)

gfs
ID

VGS VGS th( )–
--------------------------------=
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Electrical Characteristics - Diode: 
Vd vs. IF: Forward conduction voltage drop Vd vs. forward current IF
trr and Qrr: Reverse recovery time trr, in ns, and reverse recovery charge Qrr, in uC (test

conditions: forward current IF, in A; rate of change of the current di/dt, in A/
us, and junction temperature Tj, in oC)

Thermal Characteristics: 
Rth(j-c): Junction-to-case thermal resistance, in oC/W
Rth(c-s): Case-to-sink thermal resistance, in oC/W

Dimensions and Weight: 
Length (mm): Length of the device, in mm
Width (mm): Width of the device, in mm
Height (mm): Height of the device, in mm
Weight (g): Weight of the device, in g

Note that the parameters under Absolute Maximum Ratings, Thermal Characteristics, and Dimensions and
Weight, and the rise time tr and fall time tf  parameters, are not used in the loss calculation, and are optional.

In addition, the on-resistance RDS(on) from the database is used in the simulation. Also, the forward conduction
voltage drop Vd of the diode changes depending on the current. The new conduction voltage value is used in the
subsequent simulation.

2.7.7  MOSFET Loss Calculation
A MOSFET device in the database can be selected and used in the simulation for loss calculation. A MOSFET
in the Thermal Module library has the following parameters: 

Attributes: 

The parameter Frequency refers to the frequency under which the losses are calculated. For example, if the

Parameters Description

Device The specific device selected from the device database

Frequency Frequency, in Hz, under which the losses are calculated

VGG+ (upper level) Upper level of the gate source voltage, in V

VGG- (lower level) Lower level of the gate source voltage, in V

Rg_on (turn-on) Gate resistance during turn-on

Rg_off (turn-off) Gate resistance during turn-off. In most cases, the turn-on gate resistance 
Rg_on and the turn-off gate resistance Rg_off are identical. 

RDS(on) Calibration Factor The calibration factor of the on-state resistance RDS(on) 

gfs Calibration Factor The calibration factor of the forward transconductance gfs

Pcond_Q Calibration Factor The calibration factor Kcond_Q of the transistor conduction losses Pcond_Q

Psw_Q Calibration Factor The calibration factor Ksw_Q of the transistor switching losses Psw_Q

Pcond_D Calibration Factor The calibration factor Kcond_D of the diode conduction losses Pcond_D

Psw_D Calibration Factor The calibration factor Ksw_D of the diode switching losses Psw_D

Number of Parallel 
Devices

Number of identical devices in parallel
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device operates at the switching frequency of 10 kHz, and the parameter Frequency is also set to 10 kHz, the
losses will be the values for one switching period. However, if the parameter Frequency is set to 60 Hz, then the
losses will be the value for a period of 60 Hz.

The parameter Pcond_Q Calibration Factor is the correction factor for the transistor conduction losses. For the
example, if the calculated conduction losses before the correction is Pcond_Q_cal, then

Pcond_Q = Kcond_Q * Pcond_Q_cal

Similarly, the parameter Psw_Q Calibration Factor is the correction factor for the transistor switching losses.
For the example, if the calculated switching losses before the correction is Psw_Q_cal, then

Psw_Q = Ksw_Q * Psw_Q_cal

Parameters Pcond_D Calibration Factor and Psw_D Calibration Factor work in the same way. except that they
are for the diode losses.

When several identical MOSFET devices are in parallel, one should have just one device in the schematic, and
set the correct number of devices in the parameter input. This is because when several identical devices are in
parallel in the schematic, the device currents may not be exactly equal due to small differences in the
simulation. When the number of parallel devices is greater than one, the total current through the group of the
parallel devices will be equally divided among the devices. The total losses are then obtained by multiplying the
losses in each device by the number of parallel devices. The currents flowing out of Nodes Pcond_D, Psw_D,
Pcond_Q, and Psw_Q are the total losses of all the parallel devices combined. 

The voltage at the conduction losses node Pcond_D or the switching losses node Psw_D of the MOSFET
represents the calculated junction temperature Tj of the anti-parallel diode, and this junction temperature is used
when the database curves are used for determining the forward conduction diode voltage drop. If the calculated
Tj is between the junction temperatures of two curves, interpolation will be used. If the calculated Tj is lower
than the lowest Tj or higher than the highest Tj in the curves, the curve corresponding to the lowest or highest Tj
will be used. If there is only one curve, that curve is used regardless of the calculated Tj. 

Conduction Losses:

The transistor conduction losses is calculated as:

Transistor Conduction Losses = ID
2 * RDS(on)

where ID is the drain current, and RDS(on) is the static on-resistance. When the transistor is conducting
periodically with an on duty cycle of D, the conduction losses are calculated as:

Transistor Conduction Losses = ID
2 * RDS(on)* D 

Switching Losses:

The transistor turn-on losses is calculated as:

Transistor Turn-on Losses = Eon * f 

where Eon is the transistor turn-on energy losses, and f is the frequency as defined in the input parameter
Frequency. 

The transistor turn-off losses is calculated as:

Transistor Turn-off Losses = Eoff * f 

where Eoff is the transistor turn-off energy losses. 

The energy losses Eon and Eoff are calculated using the rise times and the fall times of the voltage and current
waveforms based on the information of the MOSFET gate current, input/output/reverse transfer capacitances,
and gate charges.
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Please note that the gate charge losses are not included in the switching losses above. The gate charge losses are
usually quite small compared to the turn-on/turn-off switching losses, and can be neglected in the full load
conditions. However, they can become substantial in the light load conditions. To calculate the gate charge
losses Ploss_Qg:

Ploss_Qg = Qg* VGG * fsw 

where Qg is the total gate charge, VGG is the gate source voltage, and fsw is the switching frequency. 

Also, the MOSFET device must be properly selected to ensure that it is sufficiently rated to conduct the current.
If the MOSFET current rating is too low, PSIM will not be able to calculate the switching rise/fall times and
will give an error message. In simulation, the maximum drain-to-source current that a MOSFET device is
allowed to conduct is:

Io,max = gfs * (VGG - VGS(th)) 

If the current exceeds Io,max, one should either increase the gate source voltage level or select another MOSFET
device with a larger forward transconductance value.

The loss calculation for the anti-parallel diode or free-wheeling diode is the same as described in the diode
device section.

The losses Pcond_Q, Psw_Q, Pcond_D, and Psw_D, in watts, are represented in the form of currents which flow out
of these nodes. Therefore, to measure and display the losses, an ammeter should be connected between the
nodes and the ground. When they are not used, these nodes cannot be floating and must be connected to ground. 
Chapter 2: Power Circuit Components 53



2.8  Motor Drive Module
The Motor Drive Module is an add-on module to the basic PSIM program. It provides machine models and
mechanical load models for motor drive system studies. 

The Motor Drive Module includes electric machines as described in this section, and mechanical elements and
speed/torque/position sensors as described in Section 2.11.

2.8.1  Reference Direction of Mechanical Systems
In a motor drive system, in order to formulate equations for the mechanical system, a position notation needs to
be defined. Take the following motor drive system as an example:

The system consists of two induction machines, IM1 and IM2, connected back-to-back. One operates as a
motor, and the other as a generator. From the point of view of the first machine IM1, the mechanical equation
can be written as:

where J1 and J2 are the moment of inertia, and Tem1 and Tem2 are the developed torques of the machine IM1 and
IM2, respectively.

From the point of view of the second machine IM2, however, the mechanical equation can be written as:

These two equations are equally valid, but will produce opposite mechanical speed. 

In order to avoid this ambiguity, in PSIM, the concept "reference direction" is used in the mechanical system so
that the mechanical equation can be uniquely defined. 

In a mechanical system, one element is designated as the master unit (this element is considered to operate in
the master mode), and the rest of the elements are in the slave mode. Elements that can be master units are:
Electric machines, mechanical-to-electrical interface blocks, and gear boxes.

The master unit defines the reference direction of the mechanical system. The direction is define as the direction
from the shaft node of the master unit, along the shaft, to the rest of the mechanical system. 

Once the reference direction of the mechanical system is defined, the speed and torque reference of the
mechanical system can be defined. For example, if we use the right-hand method, with the thumb pointing in
the reference direction of the mechanical system, by rotating the right hand, the fingers will point to the positive
direction of the speed and the torque.

Moreover, each mechanical element has its own reference direction. The following diagram shows the reference
direction of each mechanical element, as indicated by the arrow:

 

J1 J2+( )
dωm

dt
----------⋅ Tem1 Tem2–=

J1 J2+( )
dωm

dt
----------⋅ Tem2 Tem1–=
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The reference direction of each element and the reference direction of the overall mechanical system determine
how the element interacts with the mechanical system. 

For example, if the reference direction of a machine is along the same direction as the reference direction of the
mechanical system, the developed torque of the machine will contribute to the shaft rotation in the positive
direction. However, if the reference direction of the machine is opposite to that of the mechanical system, the
developed torque will contribute to the shaft rotation in the negative direction.

In the two-machine example above, using the notation of the "reference direction", if we define the machine
IM1 as the master unit, the reference direction of the overall mechanical system will be from left to right, as
shown below. Based on this direction, the machine IM1 will be along the reference direction, and the machine
IM2 will be opposite to the reference direction. This leads to the equivalent circuit of the mechanical system as
shown on the right.

Similarly, if we define the machine IM2 as the master unit, the reference direction of the overall mechanical
system will be from right to left, as shown below. Based on this direction, the machine IM1 will be opposite to
the reference direction, and the machine IM2 will be along the reference direction. This leads to the equivalent
circuit of the mechanical system as shown on the right.

The following shows another mechanical system with sensors and loads connected in different ways.

 Machines:

 

Mechanical Loads:

Speed Sensor: Torque Sensor: Gear Box: Mechanical-Electrical
Interface Block:

Encoders:

 
Master Unit

Reference direction

Equivalent Circuit

(J1+J2)*dWm/dt = Tem1 - Tem2

 
Master Unit

Reference direction

Equivalent Circuit

(J1+J2)*dWm/dt = Tem2 - Tem1
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In this mechanical system, the machine on the left is the master unit. The reference direction of the mechanical
system is from left to the right along the mechanical shaft. Comparing this direction with the reference direction
of each element, Load 1, Speed Sensor 1, and Torque Sensor 1, will be along the reference direction, and Load
2, Speed Sensor 2, and Torque Sensor 2 will be opposite to the reference direction of the mechanical system. 

Therefore, if the speed of the machine is positive, Speed Sensor 1 reading will be positive, and Speed Sensor 2
reading will be negative.

Similarly, the two constant-torque mechanical loads, with the amplitudes of TL1 and TL2, interact with the
machine in different ways. Load 1 is along the reference direction, and the loading torque of Load 1 to the
master machine will be TL1. On the other hand, Load 2 is opposite to the reference direction, and the loading
torque of Load 2 to the machine will be -TL2.

2.8.2  DC Machine
The image and parameters of a dc machine are as follows: 

Image: 

Attributes:

Parameters Description

Ra (armature) Armature winding resistance, in Ohm

La (armature) Armature winding inductance, in H

Rf (field) Field winding resistance, in Ohm

Lf (field) Field winding inductance, in H

Moment of Inertia Moment of inertia of the machine, in kg*m2 

Vt (rated) Rated armature terminal voltage, in V

Ia (rated) Rated armature current, in A

Master Reference direction of the mechanical system

Load 1 Load 2Speed
Sensor 1

Torque
Sensor 1

Speed Torque
Sensor 2 Sensor 2TL2TL1

Unit

+

-

+

-

Armature
Winding

Field
Winding

Shaft Node
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When the torque flag is set to 1, the internal torque generated by the machine will be saved to the output file for
display. 

For more details on the definition and use of the master/slave flag, refer to Section 2.8.1.

The operation of a dc machine is described by the following equations:

where vt, vf, ia, and if are the armature and field winding voltage and current, respectively; Ea is the back emf,
ωm is the mechanical speed in rad./sec., Tem is the internal developed torque, and TL is the load torque. The back
emf and the internal torque can also be expressed as:

where Laf is the mutual inductance between the armature and the field windings. It can be calculated based on
the rated operating conditions as:

Note that the dc machine model assumes magnetic linearity. Saturation is not considered.

Example: A DC Motor with a Constant-Torque Load 
The circuit below shows a shunt-excited dc motor with a constant-torque load TL. Since the load is along the
reference direction of the mechanical system, the loading torque to the machine is TL. Also, the speed sensor is
along the reference direction. It will give a positive output for a positive speed. 

The simulation waveforms of the armature current and the speed are shown on the right.

n (rated) Rated mechanical speed, in rpm

If (rated) Rated field current, in A 

Torque Flag Output flag for internal torque Tem

Master/Slave Flag The master/slave flag of the machine (1: master; 0: slave)

vt Ea ia Ra La
dia

dt
-------+⋅+=

vf if Rf Lf
dif

dt
------+⋅=

Ea k φ ωm⋅ ⋅=

Tem k φ ia⋅ ⋅=

J
dωm

dt
----------⋅ Tem TL–=

Ea Laf if ωm⋅ ⋅=

Tem Laf if ia⋅ ⋅=

Laf
Vt Ia Ra⋅–( )

If ωm⋅
------------------------------=
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2.8.3  Induction Machine
Linear and nonlinear models are provided for squirrel-cage and wound-rotor induction machines. The linear
model is further divided into general type and symmetrical type. This section describes the linear models.

Four linear models are provided:

- Symmetrical 3-phase squirrel-cage induction machine
- General 3-phase squirrel-cage induction machine 
- Symmetrical 3-phase wound-rotor induction machine 
- General 3-phase wound-rotor induction machine 

The images and parameters are shown as follows. 

Images: 

Attributes:

Parameters Description

Rs (stator) Stator winding resistance, in Ohm 

Ls (stator) Stator winding leakage inductance, in H 

Rr (rotor) Rotor winding resistance, in Ohm 

Lr (rotor) Rotor winding leakage inductance, in H 

Speed 
Sensor

Constant-

Load
Torque

Speed (in rpm)

Armature current

as+
as-
bs+
bs-
cs+
cs-

Squirrel-cage Squirrel-cage Squirrel-cage 

as

bs

cs

ns

as

bs

cs

as

bs

cs

ns

nr

as+
as-
bs+
bs-
cs+
cs-

ar br cr ar+ br+ cr+ar- br- cr-

Wound-rotor
Wound-rotor 

(with neutral) (unconnected)

(unconnected)
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All the parameters are referred to the stator side. 

For more details on the definition and use of the master/slave flag, refer to Section 2.8.1.

The models of the squirrel-cage induction machine with and without the neutral are the same internally. 

The operation of a 3-phase induction machine is described by the following equations:

where 

               

For squirrel-cage machines, va,r = vb,r = vc,r= 0. The parameter matrices are defined as:

                            

        

                 

where Msr is the mutual inductance between the stator and rotor windings, and θ is the mechanical angle. The
mutual inductance is related to the magnetizing inductance as: 

The mechanical equation is expressed as: 

Lm (magnetizing) Magnetizing inductance, in H 

Ns/Nr Turns Ratio Stator and rotor winding turns ratio (for wound-rotor machine only)

No. of Poles Number of poles P of the machine (an even integer)

Moment of Inertia Moment of inertia J of the machine, in kg*m2 

Torque Flag Output flag for internal torque Tem

Master/Slave Flag Master/slave flag of the machine (1: master; 0: slave)

vabc s, Rs iabc s, Ls
d
dt
----- iabc s, Msr

d
dt
-----⋅ iabc r,+⋅+⋅=

vabc r, Rr iabc r, Lr
d
dt
-----⋅ iabc r, Msr

T d
dt
-----⋅ iabc s,++⋅=

vabc s,

va s,

vb s,

vc s,

= vabc r,

va r,

vb r,

vc r,

= iabc s,

ia s,

ib s,

ic s,

= iabc r,

ia r,

ib r,

ic r,

=

Rs

Rs 0 0
0 Rs 0
0 0 Rs

= Rr

Rr 0 0
0 Rr 0
0 0 Rr

=

Ls

Ls Msr+
Msr

2
--------–

Msr

2
--------–

Msr

2
--------– Ls Msr+

Msr

2
--------–

Msr

2
--------–

Msr

2
--------– Ls Msr+

= Lr

Lr Msr+
Msr

2
--------–

Msr

2
--------–

Msr

2
--------– Lr Msr+

Msr

2
--------–
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2
--------–
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2
--------– Lr Msr+

=

Msr Msr
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3

------+⎝ ⎠
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3
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where the developed torque Tem is defined as: 

For a symmetrical squirrel-cage induction machine, the steady state equivalent circuit is shown below. In the
figure, s is the slip.

Example: A VSI Induction Motor Drive System 
The figure below shows an open-loop induction motor drive system. The motor has 6 poles and is fed by a
voltage source inverter with sinusoidal PWM. The dc bus is fed through a diode bridge.

The simulation waveforms of the mechanical speed (in rpm), developed torque Tem and load torque Tload, and 3-
phase input currents show the start-up transient.

J
dωm

dt
----------⋅ Tem TL–=

Tem
P
2
--- iabc s,

T d
dθ
------ Msr iabc r,⋅ ⋅ ⋅=

Rs RrLs Lr

Lm Rr(1-s)/s

Induction
MotorBridge

Diode

VSI

Speed
Sensor

Torque
Sensor

SPWM

Speed

Tem

Tload

3-phase currents
60    Chapter 2: Power Circuit Components



2.8.4  Induction Machine with Saturation
Two models of induction machines with saturation are provided:

- 3-phase squirrel-cage induction machine 
- 3-phase wound-rotor induction machine 

Images: 

Attributes:

All the parameters are referred to the stator side. 

For more details on the definition and use of the master/slave flag, refer to Section 2.8.1.

The operation of a 3-phase induction machine with saturation is described by the following equations:

where

Parameters Description

Rs (stator) Stator winding resistance, in Ohm 

Ls (stator) Stator winding leakage inductance, in H 

Rr (rotor) Rotor winding resistance, in Ohm 

Lr (rotor) Rotor winding leakage inductance, in H 

Ns/Nr Turns Ratio Stator and rotor winding turns ratio (for wound-rotor machine only)

No. of Poles Number of poles P of the machine (an even integer)

Moment of Inertia Moment of inertia J of the machine, in kg*m2 

Torque Flag Output flag for internal torque Tem

Master/Slave Flag Master/slave flag of the machine (1: master; 0: slave)

Im vs. Lm (Im1,Lm1) ... Characteristics of the magnetizing current Im versus the magnetizing inductance 
[(Im1,Lm1) (Im2,Lm2) ...] where Im is in A and Lm is in H.

as+
as-
bs+
bs-
cs+
cs-

as+
as-
bs+
bs-
cs+
cs-

ar+ br+ cr+ar- br- cr-

Wound-rotor (nonlinear)Squirrel-cage (nonlinear)

vabc s, Rs iabc s, Ls
d
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d
dt
----- λabc s,+⋅+⋅=

vabc r, Rr iabc r, Lr
d
dt
-----⋅ iabc r,

d
dt
----- λabc r,++⋅=
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In this case, the inductance Msr is no longer constant, but a function of the magnetizing current Im. The
magnetizing current Im and inductance Lm are defined by a series of data points in pair, for example, "(0, 0.041)
(5, 0.035) (20, 0.03)". Between two data points, the inductance Lm is interpolated linearly. When the
magnetizing current is less than the minimum or greater than the maximum, the inductance will be clamped to
the value at the first point or the last point. 

2.8.5  Brushless DC Machine
A 3-phase brushless dc machine is a type of permanent magnet synchronous machine with trapezoidal
waveform back emf. It has 3-phase windings on the stator, and permanent magnet on the rotor. 

The image of the 3-phase brushless dc machine is shown below. Two types of parameter inputs are provided:
One based on machine model parameters, and the other based on manufacturer datasheet information. 

Image: 

Attributes based on machine model parameters: 

Parameters Description

R (stator resistance) Stator phase resistance R, in Ohm 

L (stator self ind.) Stator phase self inductance L, in H

M (stator mutual ind.) Stator mutual inductance M, in H
The mutual inductance M is a negative value. Depending on the winding 
structure, the ratio between M and the stator self inductance L is normally 
between -1/3 and -1/2. If M is unknown, a reasonable value of M equal to -0.4*L 
can be used as the default value.

Vpk / krpm Peak line-to-line back emf constant, in V/krpm (mechanical speed)
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Attributes based on manufacturer datasheet information: 

The node assignments of the image are: Nodes a, b, and c are the stator winding terminals for Phase A, B, and C,
respectively. The stator windings are Y connected, and Node n is the neutral point. The shaft node is the
connecting terminal for the mechanical shaft. They are all power nodes and should be connected to the power

Vrms / krpm RMS line-to-line back emf constant, in V/krpm (mechanical speed).
The values of Vpk/krpm and Vrms/krpm should be available from the machine 
data sheet. If these values are not available, they can be obtained through 
experiments by operating the machine as a generator at 1000 rpm and 
measuring the peak and rms values of the line-to-line voltage.

No. of Poles P Number of poles P

Moment of Inertia Moment of inertia J of the machine, in kg*m2 

Mech. Time Constant Mechanical time constant τmech

theta_0 (deg.) Initial rotor angle θr, in electrical deg.

The initial rotor angle is the rotor angle at t=0. The zero rotor angle position is 
defined as the position where Phase A back emf crosses zero (from negative to 
positive) under a positive rotation speed.

theta_advance (deg.) Position sensor advance angle θadvance, in electrical deg.

The advance angle is defined as such that, for a brushless dc machine with a 
120o trapezoidal back emf waveform, if the advance angle is 0, the leading edge 
of the Phase A hall effect sensor signal will align with the intersection of the 
rising ramp and the flat-top of the back emf trapezoidal waveform. 

Conduction Pulse Width Position sensor conduction pulse width, in electrical deg.
Positive conduction pulse can turn on the upper switch and negative pulse can 
turn on the lower switch in a full bridge inverter. The conduction pulse width is 
120 electrical deg. for 120o conduction mode.

Torque Flag Output flag for internal developed torque Tem

Master/Slave Flag Master/slave flag of the machine (1: master; 0: slave)

Parameters Description

Resistance (phase-phase) Phase-to-phase (or line-to-line) resistance, in Ohm 

Inductance (phase-phase) Phase-to-phase (or line-to-line) inductance, in H

Speed Constant Speed constant Kv, defined as the ratio between the speed and the applied 
voltage, in rpm/V

Torque Constant Torque constant Kt, defined as the ratio between the generated torque and the 
applied current, in N*m/A

No. of Poles P Number of poles P

Moment of Inertia Moment of inertia J of the machine, in kg*m2 

No Load Speed The motor speed at no load with the nominal voltage applied, in rpm

No Load Current The current under no load operation, in A

Torque Flag Output flag for internal developed torque Tem

Master/Slave Flag Master/slave flag of the machine (1: master; 0: slave)
Chapter 2: Power Circuit Components 63



circuit.

Node sa, sb, and sc are the outputs of the built-in 6-pulse hall effect position sensors for Phase A, B, and C,
respectively. The sensor output is a bipolar commutation pulse (1, 0, and -1). The sensor output nodes are all
control nodes and should be connected to the control circuit. 

For more details on the definition and use of the master/slave flag, refer to Section 2.8.1.

The equations of the 3-phase brushless dc machine are:

where va, vb, and vc are the phase voltages, ia, ib, and ic are the phase currents, R, L, and M are the stator phase
resistance, self inductance, and mutual inductance, and Ea, Eb, and Ec are the back emf of Phase A, B, and C,
respectively. 

The back emf voltages are a function of the rotor mechanical speed ωm and the rotor electrical angle θr, that is:

The coefficients ke_a, ke_b, and ke_c are dependent on the rotor angle θr. In this model, an ideal trapezoidal
waveform profile is assumed, as shown below for Phase A. Also shown is the Phase A hall effect sensor signal
Sa. 

where Kpk is the peak trapezoidal value, in V/(rad./sec.), which is defined as: .

Given the values of Vpk/krpm and Vrms/krpm, the angle α is determined automatically in the program. 

The developed torque of the machine is:

The mechanical equations are:

where B is the friction coefficient, Tload is the load torque, and P is the number of poles. The coefficient B is
calculated from the moment of inertia J and the mechanical time constant τmech as below:

va R ia L M–( )
dia

dt
------- Ea+⋅+⋅=

vb R ib L M–( )
dib

dt
------- Eb+⋅+⋅=
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dt
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The mechanical time constant τmech, therefore, reflects the effect of the friction and windage of the machine.
Note that when the mechanical time constant is set to 0, the friction term is B*ωm is ignored.

To better understand the definition of the mechanical time constant, we can represent the mechanical equation
with the following equivalent circuit:

This circuit shows that the mechanical time constant τmech is equal to the RC time constant of the resistor 1/B
and the capacitor J. Therefore, the mechanical time constant can be measured by the following test:

- Connect the machine to an external mechanical source. With the stator side in open circuit, drive the
machine to a certain speed.

- Remove the mechanical source. The mechanical time constant will be equal to the time that it takes the
machine to decelerate to 36.8% of its initial speed. 

More Explanation on the Hall Effect Sensor:
A hall effect position sensor consists of a set of hall switches and a set of trigger magnets.

The hall switch is a semiconductor switch (e.g. MOSFET or BJT) that opens or closes when the magnetic field
is higher or lower than a certain threshold value. It is based on the hall effect, which generates an emf
proportional to the flux-density when the switch is carrying a current supplied by an external source. It is
common to detect the emf using a signal conditioning circuit integrated with the hall switch or mounted very
closely to it. This provides a TTL-compatible pulse with sharp edges and high noise immunity for connection to
the controller via a screened cable. For a three-phase brushless dc motor, three hall switches are spaced 120
electrical deg. apart and are mounted on the stator frame.

The set of trigger magnets can be a separate set of magnets, or it can use the rotor magnets of the brushless
motor. If the trigger magnets are separate, they should have the matched pole spacing (with respect to the rotor
magnets), and should be mounted on the shaft in close proximity to the hall switches. If the trigger magnets use
the rotor magnets of the machine, the hall switches must be mounted close enough to the rotor magnets, where
they can be energized by the leakage flux at the appropriate rotor positions.

Example: Defining Brushless DC Motor Parameters from Manufacturer Datasheets
This example illustrates how to define brushless dc motor parameters from manufacturer datasheets. Below is
the information provided on the datasheet of the brushless dc motor Maxon EC-22-16730 (32V, 50W) from
Maxon Motor. 

Values at nominal voltage
Nominal voltage (V) 32
No load speed (rpm) 38700
No load current (mA) 327

Characteristics
Terminal resistance phase to phase (Ohm) 0.363
Terminal inductance phase to phase (mH) 0.049
Torque constant (mNm/A) 7.85
Speed constant (rpm/V) 1220
Rotor inertia (gcm2) 4.2

B J
τmech
------------=

Tem TloadJ
1/B

ωm

(or τmech/J)
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Other specifications:
Number of pole paires 1
Number of phases 3

Using the element based on manufacturer datasheet information, and after converting all the quantities to the SI
units, the motor parameters in PSIM are defined as follows: 

Example: Start-Up of an Open-Loop Brushless DC Motor 
The figure below shows an open-loop brushless dc motor drive system. The motor is fed by a 3-phase voltage
source inverter. The outputs of the motor hall effect position sensors are used as the gatings signals for the
inverter, resulting a 6-pulse operation.

The simulation waveforms show the start-up transient of the mechanical speed (in rpm), developed torque Tem,
and 3-phase input currents.

2.8.6  Synchronous Machine with External Excitation
The structure of a conventional synchronous machine consists of three stator windings, one field winding on
either a salient or cylindrical rotor, and an optional damping winding on the rotor.

Depending on the way the internal model interfaces with the external stator circuitry, there are two types of
interface: one is the voltage-type interface, and the other is the current-type interface. The model for the
voltage-type interface consists of controlled voltage sources on the stator side, and this model is suitable in
situations where the machine operates as a generator and/or the stator external circuit is in series with inductive
branches. On the other hand, The model for the current-type interface consists of controlled current sources on
the stator side, and this model is suitable in situations where the machine operates as a motor and/or the stator
external circuit is in parallel with capacitive branches.

Resistance (phase-phase) 0.363

Inductance (phase-phase) 0.049m

Speed Constant 1220

Torque Constant 7.85m

No. of Poles P 2

Moment of Inertia 4.2e-7

No Load Speed 38700

No Load Current 327m

Torque Flag 1

Master/Slave Flag 1

Brushless DC Motor

Speed

Tem

3-phase currents
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The image and parameters of the machine are shown as follows.

Image: 

Attributes:

All the parameters are referred to the stator side.

For more details on the definition and use of the master/slave flag, refer to Section 2.8.1.

The equations of the synchronous machine can be expressed as follows:

where 

        

            

and [λ] = [L]*[I]. The inductance matrix is defined as follows:

Parameters Description

Rs (stator) Stator winding resistance, in Ohm 

Ls (stator) Stator leakage inductance, in H

Ldm (d-axis mag. ind.) d-axis magnetizing inductance, in H

Lqm (q-axis mag. ind.) q-axis magnetizing inductance, in H.

Rf (field) Field winding resistance, in Ohm

Lfl (field leakage ind.) Field winding leakage inductance, in H

Rdr (damping cage) Rotor damping cage d-axis resistance, in Ohm

Ldrl (damping cage) Rotor damping cage d-axis leakage inductance, in H

Rqr (damping cage) Rotor damping cage q-axis resistance, in Ohm

Lqrl (damping cage) Rotor damping cage q-axis leakage inductance, in H

Ns/Nf (effective) Stator-field winding effective turns ratio

Number of Poles P Number of Poles P

Moment of Inertia Moment of inertia J of the machine, in kg*m2 

Torque Flag Output flag for internal developed torque Tem 

Master/slave Flag Master/slave flag of the machine (1: master; 0: slave)

a

b

c

Shaft Node

n

field-field+

V R I
d
dt
----- λ+⋅=

V va vb vc vf 0 0
T

= I ia ib ic if idr iqr

T
=

R diag Rs Rs Rs Rf Rdr Rqr= λ λa λb λc λf λdr λqr

T
=
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and

where θr is the rotor angle. 

The developed torque can be expressed as:

The mechanical equations are:

2.8.7  Permanent Magnet Synchronous Machine
A 3-phase permanent magnet synchronous machine has 3-phase windings on the stator, and permanent magnet
on the rotor. The difference between this machine and the brushless dc machine is that the machine back emf is
sinusoidal.

The image and parameters of the machine are shown as follows.

Image: 
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Attributes:

The node assignments of the image are: Nodes a, b, and c are the stator winding terminals for Phase a, b, and c,
respectively. The stator windings are Y connected, and Node n is the neutral point. The shaft node is the
connecting terminal for the mechanical shaft. They are all power nodes and should be connected to the power
circuit.

For more details on the definition and use of the master/slave flag, refer to Section 2.8.1.

The equations of the permanent-magnet synchronous machine are:

where va, vb, vc, and ia, ib, and ic, and λa, λb, λc are the stator phase voltages, currents, and flux linkages,
respectively, and Rs is the stator phase resistance. The flux linkages are further defined as:

where θr is the rotor electrical angle, and λpm is a coefficient which is defined as:

where P is the number of poles.

The stator self and mutual inductances are rotor position dependent, and are defined as:

Parameters Description

Rs (stator resistance) Stator winding resistance, in Ohm 

Ld (d-axis ind.) Stator d-axis inductance, in H

Lq (q-axis ind.) Stator q-axis inductance, in H.
The d-q coordinate is defined such that the d-axis passes through the center of the 
magnet, and the q-axis is in the middle between two magnets. The q-axis is leading 
the d-axis.

Vpk / krpm Peak line-to-line back emf constant, in V/krpm (mechanical speed).
The value of Vpk/krpm should be available from the machine data sheet. If this data 
is not available, it can be obtained through an experiment by operating the machine 
as a generator at 1000 rpm and measuring the peak line-to-line voltage.

No. of Poles P Number of poles P

Moment of Inertia Moment of inertia J of the machine, in kg*m2 

Mech. Time Constant Mechanical time constant τmech

Torque Flag Output flag for internal developed torque Tem

Master/slave Flag Master/slave flag of the machine (1: master; 0: slave)
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where Ls is the stator leakage inductance. The d-axis and q-axis inductances are associated with the above
inductances as follows:

The developed torque can be expressed as:

The mechanical equations are:

where B is a coefficient, Tload is the load torque, and P is the no. of poles. The coefficient B is calculated from
the moment of inertia J and the mechanical time constant τmech as below:

2.8.8  Permanent Magnet Synchronous Machine with Saturation
A 3-phase PMSM machine with saturation differs from that of a linear 3-phase PMSM machine in that the d-
axis and q-axis magnetizing inductances Ldm and Lqm can be expressed as a nonlinear function of the d-axis and
q-axis currents in the lookup table form.

The image and parameters of the machine are shown as follows.
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Image: 

Attributes:

For more details on the definition and use of the master/slave flag, refer to Section 2.8.1.

The relationship between the d-axis and q-axis inductances Ld and Lq and the magnetizing inductances Ldm and
Lqm is as follows:

where Ls is the stator leakage inductance. Since Ls is normally very small, Ld can be considered equivalent to
Ldm, and Lq can be considered equivalent to Lqm. 

The Transformation Flag defines the transformation convention between the abc frame and the dq frame. When
the Transformation Flag is 0: 

Parameters Description

Rs (stator resistance) Stator winding resistance, in Ohm 

Ls (stator leakage ind.) Stator d-axis inductance, in H

Vpk / krpm Peak line-to-line back emf constant, in V/krpm (mechanical speed).
This value should be available from the machine data sheet. If not, it can be 
obtained through experiment by operating the machine as a generator at 1000 rpm 
and measuring the peak line-to-line voltage.

No. of Poles P Number of poles P

Moment of Inertia Moment of inertia J of the machine, in kg*m2 

Mech. Time Constant Mechanical time constant τmech, in sec. It is associated with the friction coefficient 
B as: B = J / τmech.

Ld Lookup Table File File name of the lookup table for Ldm

Lq Lookup Table File File name of the lookup table for Lqm

dq Flag Flag for the lookup table. When the flag is 0, Ldm and Lqm are function of Id and Iq. 
When the flag is 1, Ldm and Lqm are function of the current magnitude Im and the 
angle.

Transformation Flag Flag for the transformation convention (see details below)

Torque Flag Output flag for internal developed torque Tem 

Master/Slave Flag Master/slave flag of the machine (1: master; 0: slave)

a

b

c

Shaft Node

n

Ld Ls Ldm+=

Lq Ls Lqm+=
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The current vector angle is in deg., and is from -180o to 180o.

When the Transformation Flag is 1: 

The current vector angle is in deg., and is from 0o to 360o.

The Ldm and Lqm lookup tables have the following format:

m, n
Vr,1, Vr,2, ..., Vr,m
Vc,1, Vc,2, ..., Vc,n
L1,1, L1,2, ..., L1,n
L2,1, L2,2, ..., L2,n
... ... ...
Lm,1, Lm,2, ..., Lm,n

where m is the number of rows and n is the number of columns; Vr is the row vector and Vc is the column vector;
and Li,j is the Ldm or Lqm inductance value, in H, at Row i and Column j. Note that Vectors Vr and Vc must be
monotonically increasing.

When the dq flag is 0, the row vector is Iq and the column vector is Id. When the flag is 1, the row vector is the
angle and the column vector is the amplitude Im.

If the input is between two points, interpolation is used to calculate the value. If the input is less than the
minimum or greater than the maximum value, the input will be set to be the same as the minimum or maximum
value.

This PMSM model with saturation can also be used as the linear PMSM model if the lookup tables are defined
such that Ldm and Lqm are linear function of Id and Iq.

The following shows an example of the lookup table:
4,15
-5.7155 -4.8990 -4.0825 -3.2660 
-5.7155 -4.8990 -4.0825 -3.2660 -2.4495 -1.6330 -0.8165  0 0.8165 1.6330 2.4495 3.2660 4.0825 4.8990 5.7155
 0.0109 0.0109 0.0107 0.0104 0.0102 0.0100 0.0098  0.0098  0.0098  0.0100  0.0102  0.0104  0.0107 0.0109 0.0109
 0.0109 0.0109 0.0109 0.0106 0.0109 0.0106 0.0105  0.0105  0.0105  0.0106  0.0109  0.0106  0.0109 0.0109 0.0109
 0.0109 0.0109 0.0109 0.0109 0.0111 0.0108 0.0106 0.0106  0.0106  0.0108  0.0111  0.0109  0.0109  0.0109  0.0109
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2.8.9  Switched Reluctance Machine
The old switched reluctance machine model with 6 stator poles (or teeth) and 4 rotor poles (teeth) is replaced by
this model. Schematics with the old model will still work.

In this 3-phase model, the numbers of stator poles and rotor poles are no longer limited to 6 and 4. The image
and parameters of the machine are shown as follows.

Image: 

Attributes:

For more details on the definition and use of the master/slave flag, refer to Section 2.8.1. 

The node assignments are: Nodes a+, a-, b+, b-, and c+, c- are the stator winding terminals for Phase a, b, and c,
respectively. The shaft node is the connecting terminal for the mechanical shaft. They are all power nodes and
should be connected to the power circuit.

The equation of the switched reluctance machine for one phase is:

where v is the phase voltage, i is the phase current, R is the phase resistance, and L is the phase inductance. The
phase inductance L is a function of the rotor angle θ (in electrical deg.), as shown in the following figure. The
inductance profile is half-wave symmetrical. That is, it repeats itself after 180o.

Parameters Description

Resistance Stator phase resistance R, in Ohm 

Inductance Lmin Minimum phase inductance Lmin, in H

Inductance Lmax Maximum phase inductance Lmax, in H

Theta_min Duration of the interval θmin where the inductance is at the minimum, in deg.

Theta_max Duration of the interval θmax where the inductance is at the maximum, in deg.

Stator Pole Number Number of stator poles (teeth)

Rotor Pole Number Number of rotor poles (teeth)

Moment of Inertia Moment of inertia J of the machine, in kg*m2 

Torque Flag Output flag for internal torque Tem

Master/Slave Flag Master/slave flag of the machine (1: master; 0: slave)

a+

b+

c+

a-

b-

c-

Shaft Node

v i R d L i⋅( )
dt

-----------------+⋅=
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The rotor angle is defined such that, when the stator and the rotor teeth are completely aligned, θ = 0. The value
of the inductance can be in either rising stage, flat-top stage, falling stage, or flat-bottom stage.

If we define the constant k as the rising slope of the inductance from Lmin to Lmax (which is the same as the
falling slope from Lmax to Lmin), and the interval of the rising/falling slope is θrf, we can express the inductance
L as a function of the rotor angle θ (from 0 to 180o) as follows:

for  

for  

for  

for  

for  

The developed torque of the machine per phase is:

Based on the inductance expression, we have the developed torque in each stage as:

Tem = i2*k / 2 [rising stage]

Tem = 0 [flat-top stage]

Tem = - i2*k / 2 [falling stage]

Tem = 0 [flat-bottom stage]

2.8.10 Nonlinear Switched Reluctance Machine
In the previous switched reluctance model, the inductance is only a function of the rotor position, and it remains
constant during the flat-top and flat-bottom states. In this 3-phase model, the inductance can be a nonlinear
function of not only the rotor position, but also the current. The relationship between the inductance and the
rotor position and current is defined through a 2-dimensional lookup table.

The image and parameters are shown as follows.
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Image: 

Attributes:

The inductance table file has the following format:

m, n
θ1, θ2, ..., θm
I1, I2, ..., In
L1,1, L1,2, ..., L1,n
L2,1, L2,2, ..., L2,n
... ... ...
Lm,1, Lm,2, ..., Lm,n

where m is the number of rows and n is the number of columns; θ1 to θm is the row vector for the rotor position
(in deg.), and I1 and In is the column vector for the phase current (in A); and Li,j is the inductance value (in H) at
Row i and Column j. For example, when the rotor position is θ2 and the phase current is I1, the inductance is
L2,1.

Because of the half-wave symmetry, only inductance values from 0 to 180o need to be provided. Note that the
row vector and column vector must be monotonically increasing.

The machine equations are the same as these in the linear switched reluctance machine model.

Parameters Description

Resistance Stator phase resistance R, in Ohm 

Stator Pole Number Number of stator poles (teeth)

Rotor Pole Number Number of rotor poles (teeth)

Inductance Table File The file that stores the 2-dimensional table of the inductance versus the rotor 
position and the current.

Moment of Inertia Moment of inertia J of the machine, in kg*m2 

Torque Flag Output flag for internal torque Tem

Master/Slave Flag Master/slave flag of the machine (1: master; 0: slave)

a+

b+

c+

a-

b-

c-

Shaft Node
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2.9  MagCoupler Module
The MagCoupler Module provides interface for co-simulation between PSIM and the software JMAG. JMAG is
an electromagnetic field analysis software for the development and design of electric machines, actuators, and
other electrical and electronic devices and components. With the MagCoupler Module, one can perform power
electronics and control in PSIM, and electromagnetic field analysis in JMAG.

The MagCoupler Module includes the MagCoupler-DL block and the MagCoupler block, as well as the
mechanical elements and speed/torque/position sensors as described in Section 2.11.

The differences between the MagCoupler-DL block and the MagCoupler block and are:

- With the MagCoupler block, PSIM and JMAG run at the same time step, whereas with the
MagCoupler-DL block, PSIM and JMAG can run at different time steps. The flexibility to set
different time steps would make it possible to run JMAG at a larger time step and speed up the overall
simulation. 

- The interface ports of the MagCoupler block are signal ports. That is, electric currents do not flow into
or out of the interface ports, and an electric current must first be converted into a voltage signal before
it can be connected to the block. On the other hand, the MagCoupler-DL block is a native power
element, and the interface ports behavior in the same way as other power circuit nodes (i.e. voltages
can be applied and currents can flow in and out of the nodes). Because of the difference, the
MagCoupler-DL block provides more efficient and robust interface between PSIM and JMAG. 

To run the MagCoupler Module, the JMAG installation directory and the directories that include the JMAG
DLL files "jbdll.dll" and "RT_Dll.dll" must be added to the PSIM’s search path. To add to PSIM’s search path,
in PSIM, go to Options -> Set Path, and click on Add Folder. 

Also, the MagCoupler Module requires Microsoft Internet Explorer Version 6 or higher. It will not work with
Internet Explorer Version 5.

The description of the MagCoupler-DL block and the MagCoupler block is given below.

2.9.1  MagCoupler-DL Block
The MagCoupler-DL block has the following image and properties.

Image:

Attributes:

Parameter Description

Netlist XML File The XML file that defines the interface between PSIM and JMAG. It has the .xml 
extension.

JMAG Input File The JMAG input data file. It has the .jcf extension. Note that the .xml and .jcf files 
must be in the same directory.
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The power circuit nodes and mechanical shaft nodes, as well as the rest of the interface between PSIM and the
JMAG data files, are defined in the Netlist XML File. This file is in XML format, and is generated by JMAG. To
specify this file, click on the browse button at the right of the edit field.

When a specific XML is selected, the .jcf data file will be read, and the terminals (nodes) of the block will be
displayed. In the block image, the power circuit nodes will be placed at the top of the block, arranged from the
left to the right. The mechanical shaft nodes will be placed on the left and right of the block, with the first shaft
node on the right, and the second shaft node on the left.

The JMAG Input File is the JMAG data file for the device modeled. The file has the .jcf extension and is
defined in the netlist XML file. Note that the .jcf file and the .xml file must be in the same directory.

The JMAG Case Text is a text identifying the specific JMAG study case. It can be any text.

The parameters of a sample permanent-magnet synchronous machine is shown below: 

Please consult JMAG manuals and documents on how to set up the co-simulation on the JMAG side. 

2.9.2  MagCoupler Block
The MagCoupler block has the following image and properties.

Image:

JMAG Case Text Comments for the JMAG circuit

Terminal Names Terminal names of the block

Parameter Description

dt_of_JMAG Time step used in JMAG. 

Ir Rated current. It is used in JMAG

dl_threshold Current threshold. It is used in JMAG

dr_threshold Displacement threshold. It is used in JMAG

MomentofInertia Moment of inertia of the machine, in kg*m2. 

MechTimeConstant Mechanical time constant of the machine, in sec.

Back emf Flag Display flag for all FEM coil currents (1: display; 0: no display)

Rotor Angle Flag Display flag for all shaft angles

Speed Flag Display flag for all shaft speeds

Torque Flag Display flag for all developed torques

shaft1 Master Flag Master/slave flag of the machine (1: master; 0: slave)

Block with 4 inputs and 4 outputs
Chapter 2: Power Circuit Components 77



Attributes:

The number of input and output nodes may vary, depending on the actual number of input/output nodes in a
particular circuit.

The MagCoupler block accepts voltages, currents, and positions as inputs, and it provides voltages, currents,
positions, torques, and force as the outputs. In PSIM, the MagCoupler block is a power circuit element. The
way it interfaces with the rest of the circuit is that both the inputs and outputs are voltage signals (no electric
current flows into the input node). To convert a branch current into a voltage signal, or vice versa, one can use a
current-controlled voltage source, or voltage-controlled current source. 

The Link Table File, in XML format, defines the input/output interface and corresponding functions in JMAG.
This file is generated automatically by JMAG. To locate this file, click on the browse button  at the right of
the edit field.

The JMAG Input File is the JCF input data file that is read by the JMAG solver. The name is defined in the Link
Table File.

Note that JCF input file .jcf must be in the same directory as the input link table file .xml. If any material
database is used in JMAG, it should also be placed in the directory of the .xml file. Also, the .xml file does not
have to be in the same directory as the schematic file. However, if a .xml file with the same name is present in
the schematic directory, PSIM will read the one in the schematic directory first.

The JMAG Case Text is a text identifying the specific JMAG circuit. It can be any text describing the JMAG
circuit.

The IN Nodes are the nodes through which PSIM passes the values to JMAG. In the MagCoupler block image,
the order of the input nodes is from the top to the bottom. The order can be changed by highlighting the node
and click on the upper or down arrow.

The OUT Nodes are the nodes through which JMAG passes the values back to PSIM. In the MagCoupler block
image, the order of the output nodes is from the top to the bottom. The order can be changed by highlighting the
node and click on the upper or down arrow.

By clicking on the Edit Image button, one can edit and customize the image of the MagCoupler block. Clicking
on the Display File button will display the Link Table File in the Microsoft Internet Explorer environment, and
clicking on the Read File button will read or re-load the Link Table File.

Set-up in JMAG and PSIM:
Using the MagCoupler block, it is easy to set up the link between JMAG and PSIM for co-simulation. It
involves two main steps: setting up the circuit in JMAG and generating the link table file, and loading the link
table file into PSIM. 

An inductor example below is used to illustrate this process.

In the PSIM circuit of this example, the circuit on the left uses the built-in inductor element from the PSIM
library, and the circuit on the right has the inductor implemented in JMAG. In this case, the inductor is modelled
as a controlled current source in PSIM. The voltage across the inductor is first converted to a node-to-ground
voltage through a voltage-controlled voltage source, and the value is passed to the input node VL of the

Parameter Description

Link Table File The XML file that defines the interface between PSIM and JMAG. It has the .xml 
extension.

JMAG Input File The JCF input data file for JMAG. It has the .jcf extension. Note that the .xml file 
and the .jcf file must be in the same directory.

JMAG Case Text Comments for the JMAG circuit

IN Nodes Nodes that pass the values from PSIM to JMAG

OUT Nodes Nodes that pass the values from JMAG to PSIM
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MagCoupler block. At each time step, PSIM calls JMAG functions which calculate the inductor current based
on the voltage input. This current is then sent back to PSIM in the voltage form, and is used to control the
current source that represents the inductor.

In the JMAG circuit of this example, the voltage function (on the left side) receives the voltage from PSIM, and
through the current probe in series with the FEM coil, the current is calculated and sent back to PSIM. The
inductor structure in the JMAG environment is shown on the lower right. 

The setup process of calling JMAG in PSIM through the MagCoupler block is as follows.

In JMAG:
- In the JMAG circuit, connect a voltage function to the right of the FEM coil. Under Electrical

Potential in the property window, choose Constant Value, and set Constant Value[V] to 0.

- Connect a current probe to the left of the FEM coil.

- Connect another voltage function to the left of the current probe (the circuit will look like what is
shown above). In the property window, choose Cooperates with an external circuit simulator.

- Highlight the inductor structure window. Go to the menu Conditions -> Create Conditions. From the
Conditions List, highlight Coupled External Circuit Simulator, and click Modify.

- On the Coupled External Circuit Simulator dialog window, there are two lists. The list on the right,
called JMAG, contains all the functions that can be used to interface with PSIM. The list on the left,
called External Circuit Simulator, contains the functions that are selected to interface with PSIM. In
this case, there are two items in the JMAG list, one is the Voltage Function, and the other is the
Current Probe. 

- Highlight the Voltage Function, and click on the <- button to move the item from the list on the right to
the list on the left. Repeat the same step to the Current Probe. Now both items should appear in the list
on the left.

- Highlight the Voltage Function, and change the terminal name to VL. Also, change the Current Probe

Circuit in PSIM (file: inductor_jmag.sch)

Circuit and Structure in JMAG (file: inductor.jsp)
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terminal name to iL. Close the dialog window.

- Go to the menu File -> Export and select JCF.... With the JCF file name defined as "inductor", the
JCF file "inductor.jcf" and the link table file "inductor_csl.xml" will be generated. 

- Copy the JCF file "inductor.jcf" and the link table file "inductor_csl.xml" to the folder containing the
PSIM schematic file "inductor_jmag.sch". Rename the link table file to "inductor_jmag.xml". Note
that the XML file does not have to be renamed, and both the JCF and XML files do not have to be
moved to the folder of the schematic file. They are done here for the simplicity of file management

In PSIM:
- After the rest of the power circuit is created, go to Elements -> Power -> MagCoupler Module, and

select MagCoupler Block. Place the block on the schematic.

- Double click on the MagCoupler block to bring out the property window. click on the browser button

next to the Link Table File edit field to locate and select the file "inductor_jmag.xml". After the
file is read, the property window will display the IN node VL and the OUT node iL.

- Connect the MagCouple block to the rest of the circuit in the schematic.

The setup is now complete and the simulation is ready to run.
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2.10  MagCoupler-RT Module
The MagCoupler-RT Module provides interface between PSIM and JMAG-RT data files. JMAG-RT is another
way of modeling electromagnetic devices. The JMAG-RT data files are obtained by running the JMAG
simulation in advance, and the data files are stored in a lookup table form. During the PSIM simulation, JMAG
is not needed, and PSIM interfaces directly with the JMAG-RT data.

The biggest advantage of JMAG-RT is that, since the JMAG-RT data files are obtained from the JMAG
dynamic simulation, the accuracy of the JMAG-RT model is comparable to that of a JMAG dynamic model.
However, since JMAG is not involved in the PSIM simulation, the PSIM simulation is significantly faster.

The MagCoupler-RT Module includes the blocks described in this section, and mechanical elements and speed/
torque/position sensors as described in Section 2.11.

Four MagCoupler-RT blocks are provided:

- 3-phase permanent-magnet synchronous machine (PMSM)
- 2-phase step machine
- Linear synchronous machine
- Linear solenoid 

Each block has the dedicated image, as shown below.

Images:

Attributes:

Parameter Description

Netlist XML File The XML file that defines the interface between PSIM and JMAG-RT. It has the 
.xml extension.

JMAG-RT Input File The JMAG-RT data file. It has the .rtt extension. Note that the .xml file and the .rtt 
file must be in the same directory.

Step MachinePMSM
A B C A+ A-

B+ B-
C+ C-

M+M- M+ M-

D+ D-

Linear Synchronous Machine
A B C

M- M+

Linear Solenoid
A+ A-

M- M+
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In the MagCoupler-RT block images, the power circuit nodes (such as A, B, C, A+, A-, B+, B-, C+, C-, D+, and
D- as shown above) are placed at the top of the block, arranged from the left to the right. The mechanical shaft
nodes are placed on the left and right of the block, with the first shaft node (such as M+ as shown above) on the
right, and the second shaft node (such as M-) on the left.

The electric nodes and rotor shaft nodes, as well as the rest of the interface between PSIM and the JMAG-RT
data files (.rtt file), are defined in the Netlist XML File. This file is in XML format, and is generated by the
JMAG-RT Manager. To specify this file, click on the browse button at the right of the edit field.

Note that for each type of MagCoupler-RT block, the "NetlistElement" must be the same as the predefined
name. The predefined names are:

- "PM Synchronous Machine" for 3-phase PMSM
- "Step Machine" for 2-phase step machine
- "Linear Synchronous Machine" for linear synchronous machine
- "Linear Solenoid" for linear solenoid 

For example, the first several lines of a netlist XML file for a PMSM may look like the following:

<?xml version="1.0" encoding="UTF-8" ?>
<CircuitElement file="imp.rtt" name="MagCoupler-RT">
<NetlistElement type="JMAGRT" element="PM Synchronous Machine" pole_number="4">
... ... ...

The JMAG-RT Input File is the JMAG-RT data file for the device modeled. The file has the .rtt extension and is
defined in the netlist XML file. Note that the .rtt file and the .xml file must be in the same directory.

The JMAG Case Text is a text identifying the specific JMAG-RT study case. It can be any text.

The Terminal Names are the names of the interface nodes. 

The parameters of a 3-phase PMSM is shown below: 

JMAG Case Text Comments for the JMAG-RT circuit

Terminal Names Terminal names of the block

Parameter Description

shaft1_MomentofInertia Moment of inertia of the machine, in kg*m2 

shaft1_MechTimeConstant Mechanical time constant of the machine, in sec.

RU_resistance Resistance of Phase U, in Ohm

RV_resistance Resistance of Phase V, in Ohm

RW_resistance Resistance of Phase W, in Ohm

OffsetAngle Initial rotor angle, in mechanical deg.

coef_inductance Inductance coefficient (used in JMAG-RT)

coef_flux Flux coefficient (used in JMAG-RT)

coef_torque Torque coefficient (used in JMAG-RT)

coef_magnet Magnet coefficient (used in JMAG-RT)

coef_material Material coefficient (used in JMAG-RT)

turns_coil1 Coil 1 turns (used in JMAG-RT)

turns_coil2 Coil 2 turns (used in JMAG-RT)

Current Flag Display flag for 3-phase FEM coil currents (1: display; 0: no display)

Back emf Flag Display flag for 3-phase FEM coil back emf 
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The parameters of a 2-phase step machine is shown below: 

The parameters of a linear solenoid is shown below: 

Rotor Angle Flag Display flag for the rotor angle in mechanical deg.

Speed Flag Display flag for the shaft mechanical speed in rad./sec.

Torque Flag Display flag for the developed torque in N*m

shaft1 Master Flag Master/slave flag of the machine (1: master; 0: slave)

Parameter Description

RA+ Resistance of Phase A+, in Ohm 

RA- Resistance of Phase A-, in Ohm

RB+ Resistance of Phase B+, in Ohm

RB- Resistance of Phase B-, in Ohm

MomentofInertia Moment of inertia of the machine, in kg*m2 

MechTimeConstant Mechanical time constant of the machine, in sec.

OffsetAngle Initial rotor angle, in mechanical deg.

turns_coil2 Coil 2 turns (used in JMAG-RT)

coef_inertia1 Inertia 1 coefficient (used in JMAG-RT)

coef_inertia2 Inertia 2 coefficient (used in JMAG-RT)

Current Flag Display flag for 3-phase FEM coil currents (1: display; 0: no display)

Back emf Flag Display flag for 3-phase FEM coil back emf 

Rotor Angle Flag Display flag for the rotor angle in mechanical deg.

Speed Flag Display flag for the shaft mechanical speed in rad./sec.

Torque Flag Display flag for the developed torque in N*m

shaft1 Master Flag Master/slave flag of the machine (1: master; 0: slave)

Parameter Description

RA Resistance of the solenoid, in Ohm 

Mass Mass of the solenoid, in kg

MechTimeConstant Mechanical time constant of the solenoid, in sec.

SpringConstant Spring constant of the solenoid (used in JMAG-RT)

DispLimitMax Maximum limit of the displacement of the solenoid, in m

DispLimitMin Minimum limit of the displacement of the solenoid, in m

OffsetDisp Initial displacement, in m

turns_coil2 Coil 2 turns (used in JMAG-RT)

coef_mass1 Mass 1 coefficient (used in JMAG-RT)

coef_mass2 Mass 2 coefficient (used in JMAG-RT)

Current Flag Display flag for 3-phase FEM coil currents (1: display; 0: no display)

Back emf Flag Display flag for 3-phase FEM coil back emf 
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The parameters of a linear synchronous machine is shown below: 

In all the parameter definitions above, except the flags (current flag, back emf flag, rotor angle/position flag,
speed/velocity flag, torque/force flag, and master flag), all other parameters are read from the .rtt file defined in
the XML file. These values can be changed, and for these parameters noted with "used in JMAG-RT", the
changed values will be sent back to JMAG-RT for calculation. 

Several MagCoupler-RT examples are provided under the "examples\MagCoupler-RT" folder.

Position Flag Display flag for the solenoid position in m

Velocity Flag Display flag for the solenoid velocity in m/sec.

Force Flag Display flag for the developed force in N

mass1 Master Flag Master/slave flag of the solenoid (1: master; 0: slave)

Parameter Description

RU Resistance of Phase U, in Ohm 

RV Resistance of Phase V, in Ohm 

RW Resistance of Phase W, in Ohm 

Mass Mass of the machine, in kg

MechTimeConstant Mechanical time constant of the solenoid, in sec.

OffsetDisp Initial displacement, in m

coef_inductance Inductance coefficient (used in JMAG-RT)

coef_flux Flux coefficient (used in JMAG-RT)

coef_force Torque coefficient (used in JMAG-RT)

coef_magnet Magnet coefficient (used in JMAG-RT)

coef_material Material coefficient (used in JMAG-RT)

turns_coil1 Coil 1 turns (used in JMAG-RT)

turns_coil2 Coil 2 turns (used in JMAG-RT)

coef_mass1 Mass 1 coefficient (used in JMAG-RT)

coef_mass2 Mass 2 coefficient (used in JMAG-RT)

Current Flag Display flag for 3-phase FEM coil currents (1: display; 0: no display)

Back emf Flag Display flag for 3-phase FEM coil back emf 

Position Flag Display flag for the solenoid position in m

Velocity Flag Display flag for the solenoid velocity in m/sec.

Force Flag Display flag for the developed force in N

mass1 Master Flag Master/slave flag of the solenoid (1: master; 0: slave)
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2.11  Mechanical Elements and Sensors
This section describes elements that are shared by Motor Drive Module, MagCoupler Module, and
MagCoupler-RT Module. The elements include mechanical loads, gear boxes, mechanical coupling blocks,
mechanical-electrical interface blocks, and various speed/torque/position sensors. 

2.11.1 Mechanical Loads
Several mechanical load models are provided: constant-torque, constant-power, constant-speed, general-type,
and externally controlled loads. 

2.11.1.1  Constant-Torque Load
The image of a constant-torque load is:

Image:

Attributes:

If the reference direction of a mechanical system enters the dotted terminal, the load is along the reference
direction, and the loading torque to the master machine is Tconst. Otherwise the loading torque will be -Tconst.
See Section 2.6.1 for more detailed explanation on the reference direction.

A constant-torque load is expressed as:

The torque does not depend on the speed direction. 

2.11.1.2  Constant-Power Load
The image of a constant-power load is:

Image:

Attributes:

The torque-speed curve of a constant-power load is shown below: 

Parameters Description

Constant Torque Torque constant Tconst, in N*m

Moment of Inertia Moment of inertia of the load, in kg*m2

Parameters Description

Maximum Torque Maximum torque Tmax of the load, in N*m

Base Speed Base speed nbase of the load, in rpm

Moment of Inertia Moment of inertia of the load, in kg*m2

TL Tconst=
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When the mechanical speed is less than the base speed nbase, the load torque is:

When the mechanical speed is above the base speed, the load torque is:

where P = Tmax*ωbase and ωbase = 2π∗nbase/60. The mechanical speed ωm is in rad./sec. 

2.11.1.3  Constant-Speed Load
The image of a constant-speed load is:

Image:

Attributes:

A constant-speed mechanical load defines the speed of a mechanical system, and the speed will remain
constant, as defined by the speed constant. 

2.11.1.4  General-Type Load
The image of a general-type mechanical load is as follows.

Image:

Attributes:

Parameters Description

Constant Speed (rpm) Speed constant, in rpm

Moment of Inertia Moment of inertia of the load, in kg*m2

Parameters Description

Tc Constant torque term

k1 (coefficient) Coefficient for the linear term

Speed (rpm)

Tmax

0

Torque

(N*m)

nbase

TL Tmax=

TL
P

ωm
----------=
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A general-type load is expressed as:

where ωm is the mechanical speed in rad./sec. 

Note that the torque of the general-type load is dependent on the speed direction.

2.11.1.5  Externally-Controlled Load
An externally-controlled mechanical load is used to define a load of an arbitrary load profile. 

Image:

Attributes:

The value of the mechanical load is defined by the voltage value at the control node (1V corresponds to 1 N*m).
This node is a control circuit node.

2.11.2 Gear Box
The image is a gear box is shown below. 

Image:

Attribute:

The shaft with the bigger dot is Shaft 1.

k2 (coefficient) Coefficient for the quadratic term

k3 (coefficient) Coefficient for the cubic term

Moment of Inertia Moment of inertia of the load, in kg*m2

Parameters Description

Speed Flag Flag for speed dependency 
Flag = 0: The load is frictional and is always against the rotational direction; 
Flag = 1: The load is independent of the rotational direction.

Moment of Inertia Moment of inertia of the load, in kg*m2

Parameter Description

Gear Ratio The gear ratio a

Shaft 1 Master/Slave Flag Master/slave flag for Shaft 1

Shaft 2 Master/Slave Flag Master/slave flag for Shaft 2

TL sign ωm( ) Tc k1 ωm k2 ωm
2 k3 ωm

3⋅+⋅+⋅+( )⋅=

Shaft 1
Shaft 2
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If the numbers of teeth of the first gear and the second gear are n1 and n2, respectively, the gear ratio a is defined
as: a = n1 / n2. Let the radius, torque, and speed of these two gears be: r1, r2, T1, T2, ω1, and  ω2, we have: T1 /
T2 = r1 / r2 = ω2 / ω1= a.

The two shafts of the gear box can be in either master mode or slave mode. For more information on the
definition and use of the master/slave flag, refer to Section 2.8.1. 

2.11.3 Mechanical Coupling Block
The mechanical coupler block is used to couple two mechanical systems. 

Image:

This block is used in situations where both mechanical systems have a device in the master mode, and they must
be connected together to form one system. Based on the connection convention in PSIM, a mechanical system
can have only one master device. In this case, the mechanical coupling block can be inserted in between, and
the mechanical system on each side of the coupling block can have its own device in the master mode.

2.11.4 Mechanical-Electrical Interface Block
This block allows users to access the internal equivalent circuit of the mechanical system of a machine. 

Image:

Attribute:

Similar to electric machines, the mechanical-electrical interface block can be used to define the reference
direction of a mechanical system through the master/slave flag. When the interface block is set to the master
mode, the reference direction is along the mechanical shaft, away from the mechanical node, and towards the
rest of the mechanical elements.

Let’s assume that a drive system consists of a motor (with a developed torque of Tem and a moment of inertia of
J1) and a mechanical load (with a load torque of Tload and a moment of inertia of J2). The equation that
describes the mechanical system is:

where ωm is the shaft mechanical speed. In PSIM, this equation is modelled by an equivalent circuit as shown
below.

Parameter Description

Master/Slave Flag Flag for the master/slave mode (1: master, 0: slave)

Mechanical System #1 Mechanical System #2

Mechanical Side Electrical Side

J1 J2+( )
dωm

dt
----------⋅ Tem Tload–=

Tem TloadJ1 J2

ωm speed node
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In this circuit, the two current sources have the values of Tem and Tload, and the capacitors have the values of J1
and J2. The node-to-ground voltage (speed node voltage) represents the mechanical speed ωm. This is
analogous to C*dV/dt = i for a capacitor where C = J1+J2, V = ωm, and i = Tem-Tload.

In PSIM, mechanical equivalent circuits for motors and mechanical loads all use the capacitor-based circuit
model. The mechanical-electrical interface block provides the access to the internal mechanical equivalent
circuit. If the mechanical side of an interface block (with the letters “M”) is connected to a mechanical shaft, the
electrical side (with the letters “E”) will be the speed node of the mechanical equivalent circuit. One can thus
connect any electrical circuits to this node. 

With this element, users can connect built-in motors or mechanical loads with user-defined load or motor
models.

Example: An induction machine with a custom mechanical load model
The figure below shows an induction machine connected to a user defined mechanical load model through the
mechanical-electrical interface block. As explained above, the voltage at the electrical side represents the shaft
mechanical speed. A current source flowing out of this node represents a mechanical load, and a capacitor
connected to this node represents the load moment of inertia.

Example: A custom machine model with a constant-torque load
Similarly, one can build a custom machine model and connect it to the mechanical load in PSIM. The figure
below shows such a circuit. The custom machine model must use the capacitor analogy to model the
mechanical equation. The node representing the mechanical speed is then made available and is connected to
the electrical side of the mechanical-electrical interface block.

2.11.5 Speed/Torque Sensors
A speed sensor or torque sensor is used to measure the mechanical speed or torque. 

Images:

Mechanical load model

Custom machine model (in subcircuit form)

Mechanical
speed

Wm

Torque SensorSpeed Sensor
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Attribute:

The output of the speed sensor is in rpm.

The output of the speed/torque sensor depends on how the sensor is connected in a mechanical system. 

For the speed sensor, if the sensor is along the reference direction of the mechanical system (refer to Section
2.8.1 for more details on the definition and use of the reference direction), a positive mechanical speed would
give a positive sensor output. Otherwise, if the sensor is opposite to the reference direction of the mechanical
system, a positive mechanical speed would give a negative sensor output.

For example, in the mechanical system below, Speed Sensor 1 is along the reference direction, and Speed
Sensor 2 is opposite to the reference direction of the mechanical system. If the actual mechanical speed is
positive, the output of Speed Sensor 1 will be positive, and the output of Speed Sensor 2 will be negative.

The torque sensor measures the torque difference between the dotted side of the sensor and the undotted side.
To understand the physical meaning of the torque sensor measurement, we use the diagram below as an
illustration.

The figure on the left shows a torque sensor connected with a 10-N*m mechanical load, and the reference
direction of the mechanical system is from left to right. Based on the reference direction, if we use the right-
hand method, by pointing the thumb in the reference direction and rotating the right hand, the direction of the
fingers will show the direction of the positive speed and torque. The physical interpretation of the system is
shown on the right.

In this case, the direction of the positive speed and torque is in the clockwise direction. The dotted side of the
sensor is on the left, and the load is in such a way that it tries to slow down the shaft (the load torque is in the
counter-clockwise direction).

The physical meaning of the torque sensor is that, if the dotted side of the sensor is fixed, the sensor will
measure the torque tension on the undotted side of the sensor, and a positive sensor output would mean that the
torque is opposite to the direction of the speed reference. Therefore, for the example above, the positive speed
reference is in the clockwise direction, and the load torque is in the counter-clockwise direction. This will give
a torque sensor reading of 10 N*m.

Similarly, if the undotted side of the sensor is fixed, the sensor will measure the torque tension on the dotted
side of the sensor, in the positive direction of the speed reference. For example, in the system below, the torque
sensor is flipped with the dotted side on the right. If the undotted side is fixed, the load torque is applied to the
dotted side of the sensor, in the opposite direction of the speed reference. The torque sensor output will be -10
N*m instead.

Parameter Description

Gain Gain of the sensor

Reference direction of the mechanical system

Speed Sensor 1 Speed Sensor 2

Physical interpretation

*

Reference direction of the mechanical system

10
10

Wm
Torque sensor

Load
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To understand how the torque sensor is modeled in the equivalent circuit of the mechanical system, we use the
following system as an example. 

The system consists of one machine, 2 torque sensors, and 2 mechanical loads. The torques and moment of
inertia for the machine and the loads are as labelled in the diagram. The reference direction of this mechanical
system is from left to right. The equation for this system can be written as:

The equivalent electrical circuit of the equation is shown below: 

The node voltage in the circuit represents the mechanical speed ωm. The current probe on the left represents the
reading of the Torque Sensor 1. Similarly, the current probe on the right represents the reading of the Torque
Sensor 2. Note that the second current probe is from right to left since Sensor 2 is opposite to the reference
direction of the mechanical system.

The equivalent circuit also illustrates how mechanical power is transferred. The multiplication of the current to
the voltage, which is the same as the torque times the mechanical speed, represents the mechanical power. If the
power is positive, it is transferred in the direction of the speed ωm. 

2.11.6 Position Sensors
Four types of position sensors are provided: absolute encoder, incremental encoder, resolver, and hall effect
position sensor. They are connected to the mechanical shaft, similar to the speed sensor and torque sensor, and
the output signals are control signals. 

2.11.6.1  Absolute Encoder

An absolute encoder is a position sensor that provides the shaft position within a 360o range (mechanical
degree). 

Physical interpretation

*

Reference direction of the mechanical system

10
10

Wm
Torque sensor

Load

Load 1 Load 2
Sensor 1 Sensor 2

TL1 TL2
J JL1 JL2

Tem

J JL1 JL2+ +( )
dωm

dt
----------⋅ Tem TL1– TL2–=

Load 1 Load 2

Sensor 1 Sensor 2

-TL1 -TL2J JL1 JL2Tem

ωm

Machine
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Image:

Attribute:

The encoder output resolution is determined by the number of bits N. The encoder has two outputs: one is the
number of counts (the range is from 0 to 2N-1), and the other is the position, in mechanical deg. (the range is
from 0 to 360o).

An example of a PMSM drive system using the absolute encoder is given in the sample file "Absolute Encoder
PMSM Drive.sch".

2.11.6.2  Incremental Encoder
An incremental encoder is a position sensor that produces quadrature outputs which indicate the speed, angle,
and direction of the shaft. 

Image:

Attribute:

The two quadrature outputs are A and A (A is the inverse of A), and B and B. They are offset by 90o. In
addition, the encoder provides separate index signal output Z and Z that provide one count per revolution.

An example of an induction motor drive system using the incremental encoder is given in the sample file 
"Incremental Encoder INDM Drive.sch".

2.11.6.3  Resolver
A resolver is essentially a rotary transformer with one rotor winding and two stator windings. These two stator
windings, referring to as the COS winding and SIN winding, are located 90o apart.

As the shaft rotates, the output voltages of the COS and SIN windings vary as the cosine and sine functions of
the shaft angle. 

Parameter Description

Initial Position (deg.) Initial shaft position, in deg.

No. of Bits of Resolution Number of Bits of resolution N

Parameter Description

Initial Position (deg.) Initial shaft position, in deg.

No. of Lines Number of lines that are in the code pattern of the code disk of the encoder
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Image:

Attribute:

The resolver has four outputs: cos+, cos- (the inverse of cos+), sin+, and sin- (the inverse of sin+). The peak
amplitude of all the outputs is 1. 

An example of a PMSM drive system using the resolver is given in the sample file "Resolver PMSM
Drive.sch".

2.11.6.4  Hall Effect Sensor
A hall effect sensor is a type of position sensors that provides three pulses depending on the shaft position. The
sensor consists of a set of semiconductor switches and trigger magnets. The switches open or close when the
magnetic field is higher or lower than a certain threshold value. 

Image:

Attribute:

The hall effect sensor provides three logic signal outputs A, B, and C, which are spaced 120 electrical deg.
apart. 

The hall effect sensor is the same as the built-in hall effect sensor in the brushless dc machine.

Examples of BDCM motor drive systems using the hall effect sensor are given in the "examples" sub-folder of
the PSIM directory.

Parameter Description

Initial Position (deg.) Initial shaft position, in deg.

No. of Poles Number of poles of the resolver

Parameter Description

Initial Position (deg.) Initial shaft position, in deg.

No. of Poles Number of poles of the sensor

co
s+

co
s-

si
n+

si
n-
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2.12  Renewable Energy Models
Several elements related to renewable energy applications are included here. 

2.12.1 Solar Modules
Two types of solar module models are provided: physical model and functional model, as described below. 

The differences between the physical model and the function model are that the physical model can simulate the
behavior of the solar module more accurately, and can take into account the light intensity and temperature
variation. On the other hand, the functional model cannot take into account the light intensity and temperature
variation, but requires the minimum amount of parameter input and is easier to define and use.

Images:

Attributes for Physical Model:

Parameter Description

Number of Cells Ns Number of cells Ns of the solar module. A solar module consists of Ns solar 
cells in series.

Standard Light Intensity S0 Light intensity S0 under the standard test conditions, in W/m2. The value is 
normally 1000 W/m2 in manufacturer datasheet.

Ref. Temperature Tref Temperature Tref under the standard test conditions, in oC

Series Resistance Rs Series resistance Rs of each solar cell, in Ohm

Shunt Resistance Rsh Shunt resistance Rsh of each solar cell, in Ohm

Short Circuit Current Isc0 Short circuit current Isc0 of each solar cell at the reference temperature Tref, 
in A

Saturation Current Is0 Diode saturation current Is0 of each solar cell at the reference temperature 
Tref, in A

Band Energy Eg Band energy of each solar cell, in eV. It is around 1.12 for crystalline 
silicon, and around 1.75 for amorphous silicon.

Ideality Factor A Ideality factor A of each solar cell, also called emission coefficient. It is 
around 2 for crystalline silicon, and is less than 2 for amorphous silicon.

Temperature Coefficient Ct Temperature coefficient Ct, in A/oC or A/oK

Coefficient Ks Coefficient ks that defines how light intensity affects the solar cell 
temperature. 

Light Intensity

Ambient Temperature

Pmax
Physical Model Functional Model

Pmax
94    Chapter 2: Power Circuit Components



Attributes for Functional Model:

In the image for the solar module physical model, the nodes with the "+" and "-" signs are the positive and
negative terminals. The node with the letter "S" refers to the light intensity input (in W/m2), and the node with
the letter "T" refers to the ambient temperature input (in oC). The node on the top is for the theoretical
maximum power (in W) given the operating conditions. While the positive and negative terminal nodes are
power circuit nodes, the other nodes are all control circuit nodes.

Similarly, in the image for the solar module functional model, the nodes with the "+" and "-" signs are the
positive and negative terminals. The node on the top is for the theoretical maximum power given the operating
conditions. 

A solar module consists of Ns solar cells in series, and the equivalent circuit of the physical model of one solar
cell is shown below:

The equations that describe a solar cell are:

and

where q is the electron charge (q = 1.6 x 10-19 C); k is the Boltzmann constant (k = 1.3806505 x 10-23); S is the
light intensity input; Ta is the ambient temperature input; v is the voltage across the entire solar module; and i is
the current flowing out of the positive terminal of the solar module. 

Parameter Description

Open Circuit Voltage Voc Voltage measured when the solar module terminals are open circuit, in V

Short Circuit Current Isc Current measured when the solar module terminals are short circuit, in A

Maximum Power Voltage Vm Solar module terminal voltage when the output power is at the maximum, 
in V.

Maximum Power Current Im Solar module terminal current when the output power is at the maximum, 
in A.

i

id ir

iph v/Nsvd

+

--

+

--

Rs

Rsh

i iph id– ir–=

iph Isc0
S
S0
----- Ct T Tref–( )⋅+⋅=

id I0 e
qvd
AkT
----------

1–
⎝ ⎠
⎜ ⎟
⎛ ⎞

⋅=

I0 Is0
T

Tref
--------⎝ ⎠

⎛ ⎞ 3
e

qEg
Ak
--------- 1

Tref
-------- 1

T
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⎛ ⎞

⋅ ⋅=
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vd

Rsh
-------=

vd
v

Ns
----- i Rs⋅+=
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Some of the parameters of the physical model can be obtained from manufacturer datasheets, and the rest of the
parameters can be obtained by trial-and-error. A utility tool Solar Module (physical model) under the Utilities
menu is provided to help obtaining the parameters from manufacturer datasheet. The interface of the tool is
shown below.

For more details on how to use this tool to obtain the model parameters, please refer to the tutorial Tutorial -
Solar Module (physical module).pdf in the "doc" sub-folder in the PSIM directory.

On the other hand, the functional model of the solar module represents the solar module based on the i-v
characteristics. Using the four parameters, i.e. open circuit voltage, short circuit current, and voltage and current
at the maximum power point, the model creates the i-v characteristics of the solar module. All these four
parameters can be obtained from manufacturer datasheets.

The figure below shows the current and power of a solar module versus the voltage. 

As shown in the figure, as the voltage increases, the solar module output power increases. At one point, the
output power will reach the maximum. Many control schemes have been proposed to track the maximum power
point (so called Maximum Power Point Tracking, or MPPT) under different operating conditions. Several
MPPT examples have been included in the PSIM example set. 
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2.12.2 Wind Turbine
The image and parameter of the wind turbine are described below. 

Images:

Attributes:

In the image, the node with the letter "w" is for the wind speed input in m/s, and the node with the letter "p" is
for the blade pitch angle input in deg. Both nodes are control circuit nodes. 

The power generated by a wind turbine can be expressed as:

where A is the area of the rotor blade, vwind is the wind speed, ρ is the air density, and Cp is the power
coefficient. The power coefficient Cp is a function of the tip speed ratio λ and the blade pitch angle β. It can be
expressed as [Heier1]:

where c1 = 0.5, c2 = 116*λ', c3 = 0.4, c4 = 0, c5 = 5, c6 = 21*λ', c7 = 0.01*λ, and 

The relationship between the power coefficient Cp and the tip speed ratio λ and the blade pitch angle β can be
plotted in the figure below.

Parameter Description

Nominal Output Power The maximum output power of the wind turbine, in W, at 0o pitch angle. This 
power is considered as the maximum power operating point of the turbine, 
and it should not exceed the rated power of the generator.

Base Wind Speed The base wind speed that would produce the nominal output power, in m/s

Base Rotational Speed The base rotational speed of the turbine that would produce the nominal 
output power, in rpm

Initial Rotational Speed The initial rotational speed of the turbine, in rpm

Moment of Inertia Moment of inertia of the wind turbine blade, in kg*m2

Torque Flag Flag to display the internal torque of the wind turbine (0: no display; 1: 
display)

Master/Slave Flag Master/slave flag for the connected mechanical system (0: slave; 1: master)

Wind Speed

Pitch Angle

Wind Turbine Shaft

Wind Turbine

P 1
2
--- A vwind

3 ρ Cp⋅ ⋅ ⋅ ⋅=

Cp c1 c2 c3β– c4βx– c5–( ) e
c6–

⋅ ⋅ c7+=

λ′ 1
λ 0.08β+
----------------------- 0.035

β3 1+
---------------–=

1. S. Heier and R. Waddington, Grid Integration of Wind Energy Conversion Systems, Wiley, 2006
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The figure shows that the power coefficient Cp reaches the maximum of 0.49 when the tip speed 
ratio λ is 8.18. We choose the values of Cp and λ at the maximum as the nominal values, i.e., Cp_nom 
= 0.49, λnom = 8.18. One way to control the wind turbine, therefore, is to maintain the tip speed 
ratio at or close to the nominal value so that the power that the wind turbine generates is at the 
maximum.
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3
  Control Circuit Components

3.1  Transfer Function Blocks
A transfer function block is expressed in polynomial form as: 

Two types of transfer function blocks are provided: one with zero initial values (the element is called s-domain
Transfer Function in the PSIM library) and the other with initial values as input parameters (called s-domain
Transfer Function (initial value) in the PSIM library). 

Images:

Attributes:

Let Y(s) = G(s)*U(s) where Y(s) is the output and U(s) is the input, we can convert the s-domain expression into
the differential equation form as follows:

The output equation in the time domain can be expressed as:

The initial values of the state variables xn to x1 can be specified as the inputs in the element s-domain Transfer
Function (initial value).

Example:
The following is a second-order transfer function: 

Parameters Description

Order n Order n of the transfer function 

Gain Gain k of the transfer function

Coeff. Bn...Bo Coefficients of the numerator (from Bn to Bo)

Coeff. An...Ao Coefficients of the denominator (from An to Ao)

Initial Values xn..x1 Initial values of the state variables xn to x1 (for the element s-domain Transfer 
Function (initial value) only)

G s( ) k
Bn sn ... B2 s2 B1 s B0+⋅+⋅+ +⋅

An sn ... A2 s2 A1 s A0+⋅+⋅+ +⋅
-------------------------------------------------------------------------------⋅=

d
dt
-----

x1

x2

x3

...
xn

0 0 0 ... 0 A0 An⁄–
1 0 0 ... 0 A1 An⁄–
0 1 0 ... 0 A2 An⁄–
... ... ... ... ... ...
0 0 0 ... 1 An 1– An⁄–

x1

x2

x3

...
xn

k
An
-----

B0 A0 Bn An⁄⋅–
B1 A1 Bn An⁄⋅–
B2 A2 Bn An⁄⋅–

...
Bn 1– An 1– Bn An⁄⋅–

u⋅ ⋅+⋅=

y xn k
Bn

An
----- u⋅ ⋅+=
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In PSIM, the specification will be:

3.1.1  Proportional Controller
The output of a proportional (P) controller is equal to the input multiplied by a gain.

Image:

Attribute:

3.1.2  Integrator
There are three types of integrators: regular integrator, external resettable integrator, and internal resettable
integrator. 

Images:

Attributes:

For Regular Integrator:

For External Resettable Integrator:

Order n 2

Gain 1.5

Coeff. Bn...Bo 0.    0.     400.e3

Coeff. An...Ao 1.  1200.  400.e3

Parameter Description

Gain Gain k of the transfer function

Parameters Description

Time Constant Time constant T of the integrator, in sec.

Initial Output Value Initial value of the output

Parameters Description

Time Constant Time constant T of the integrator, in sec.

Initial Output Value Initial value of the output

Reset Flag Reset flag (0: edge reset; 1: level reset) 

G s( ) 1.5 400.e3

s2 1200 s 400.e3+⋅+
----------------------------------------------------⋅=

Regular Integrator External Resettable Integrator Internal Resettable Integrator
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For Internal Resettable Integrator:

The transfer function of an integrator is: 

The Bode plot of the amplitude |G| and the phase angle Φ of the integrator is shown as below:

The output of the external resettable integrator can be reset by an external control signal (at the bottom of the
block). For the edge reset (reset flag = 0), the integrator output is reset to zero at the rising edge of the control
signal. For the level reset (reset flag = 1), the integrator output is reset to zero as long as the control signal is
high (1).

The output of the internal resettable integrator is reset to 0 when the output reaches either the lower limit or the
upper limit. It works in the same way as the external resettable integrator with the edge reset, except that in this
case users do not need to set up the external reset circuit. 

To avoid over saturation, a limiter should be placed at the integrator output. 

Example: 
The following circuit illustrates the use of the resettable integrator. The input of the integrator is a dc quantity.
The control input of the integrator is a pulse waveform which resets the integrator output at the end of each
cycle. The reset flag is set to 0.

Parameters Description

Time Constant Time constant T of the integrator, in sec.

Initial Output Value Initial value of the output

Lower Output Limit Lower limit of the output

Upper Output Limit Upper limit of the output

G s( ) 1
sT
------=

|G|

-90o

ω (rad/sec)

Φ

1/T 

-20dB/dec

ω 

0

0

Vd

vctrl

vo
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3.1.3  Differentiator
The transfer function of a differentiator is: 

A differentiator is calculated as follows: 

where Δt is the simulation time step, vin(t) and vin(t-Δt) are the input values at the present and the previous time
step.

Image: 

Attribute:

Since sudden changes of the input will generate spikes at the output, it is recommended that a low-pass filter be
placed at the input of the differentiator. 

3.1.4  Proportional-Integral Controller
A proportional-integral (PI) controller is defined as below.

Image:

Attributes:

The transfer function of a PI controller is defined as:

The Bode plot of the amplitude |G| and the phase angle Φ of the PI controller is shown as below:

To avoid over saturation, a limiter should be placed at the PI output. 

Parameter Description

Time Constant Time constant T of the differentiator, in sec.

Parameters Description

Gain Gain k of the PI controller 

Time Constant Time constant T of the PI controller 

G s( ) sT=

vo t( ) T
vin t( ) vin t Δt–( )–

Δt
--------------------------------------------⋅=

G s( ) k 1 sT+
sT

---------------⋅=

|G|

-90o

ω (rad/sec)

Φ

1/T 

-20dB/dec

ω 

0

0
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3.1.5  Single-Pole Controller
A single-pole controller is a proportional controller with a pole. It is defined as below. 

Image:

Attributes:

The transfer function of the single-pole is defined as:

where .

The Bode plot of the amplitude |G| and the phase angle Φ of the single-pole controller is shown as below:

3.1.6  Modified PI Controller
A modified PI controller (Type-2) consists of a PI with a pole.

Image:

Attributes:

The transfer function of a modified PI controller is defined as:

where and .

Parameters Description

Gain Gain k of the controller 

Pole Frequency Frequency of the pole fc, in Hz

Parameters Description

Gain Gain k of the PI controller 

Time Constant Time constant T of the PI portion of the controller 

Pole Frequency Frequency of the pole fc, in Hz

G s( ) k
ωc

s ωc+
--------------⋅=

ωc 2πfc=

|G|

-90o

ω (rad/sec)

Φ

-20dB/dec

ω 

0

0

ωc 

G s( ) k 1 sT+
sT

--------------- 1
1 sTc+
-----------------⋅ ⋅=

Tc
1

ωc
------= ωc 2πfc=
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The Bode plot of the amplitude |G| and the phase angle Φ of the PI controller is shown as below:

3.1.7  Type-3 Controller
A Type-3 controller consists of two zeros and two poles. 

Image:

Attributes:

The transfer function of a Type-3 controller is defined as:

where , , , and .

The Bode plot of the amplitude |G| and the phase angle Φ of the Type-3 controller is shown as below:

Parameters Description

Gain Gain k of the PI controller 

Frequency fz1 Frequency fz1 of the first zero, in Hz

Frequency fz2 Frequency fz2 of the second zero, in Hz

Frequency fp1 Frequency fp1 of the first pole, in Hz

Frequency fp2 Frequency fp2 of the second pole, in Hz 

|G|

-90o

ω (rad/sec)

Φ

1/T 

-20dB/dec

ω 

0

0

1/Tc -20dB/dec

G s( ) k
1 sTz1+

sTz1
-------------------

1 sTz2+
1 sTp1+( ) 1 sTp2+( )⋅

------------------------------------------------------⋅ ⋅=

Tz1
1

2πfz1
------------= Tz2

1
2πfz2
------------= Tp1

1
2πfp1
-------------= Tp2

1
2πfp2
-------------=

|G|

-90o

ω (rad/sec)

Φ

1/Tz1 

-20dB/dec

ω 

0

0

90o

20dB/dec

1/Tz2 1/Tp1 1/Tp2 
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3.1.8  Built-in Filter Blocks
Four second-order filters and one first-order filter are provided as built-in blocks in PSIM. 

Images:

Attributes for second-order filters:

Attributes for first-order low-pass filter:

The transfer function of these filters are listed below.

For second-order low-pass filter:

For second-order high-pass filter:

For second-order band-pass filter:

For second-order band-stop filter:

For first-order low-pass filter:

Parameters Description

Gain Gain k 

Damping Ratio Damping ratio ξ 

Cut-off Frequency Cut-off frequency fc ( ) for low-pass and high-pass filters, in Hz

Center Frequency Center frequency fo ( ) for band-pass and band-stop filter, in Hz

Passing Band; 
Stopping Band

Frequency width fb ( ) of the passing/stopping band for band-pass/band-
stop filters, in Hz 

Parameters Description

Gain Gain k 

Cut-off Frequency Cut-off frequency fc ( ) of the low-pass filter, in Hz 

2nd-order band-pass 2nd-order band-stop2nd-order high-pass2nd-order low-pass 1st-order low-pass

fc
ωc

2π
------=

fo
ωo

2π
------=

fb
B

2π
------=

fc
ωc

2π
------=

G s( ) k
ωc

2

s2 2ξωcs ωc
2+ +

---------------------------------------⋅=

G s( ) k s2

s2 2ξωcs ωc
2+ +

---------------------------------------⋅=

G s( ) k B s⋅

s2 B s⋅ ωo
2+ +

----------------------------------⋅=

G s( ) k
s2 ωo

2+

s2 B s⋅ ωo
2+ +

----------------------------------⋅=

G s( ) k
ωc

s ωc+
--------------⋅=
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3.2  Computational Function Blocks

3.2.1  Summer
The input of a one-input summer or two-input summer can be either a scalar or a vector. The input of a three-
input summer can only be a scalar.

Images:

Attribute:

For the three-input summer, the input with a dot is the first input. 

If the inputs are scalar, the output of a summer with n inputs is defined as:

If the input is a vector, the output of a two-input summer will also be a vector, which is defined as:

V1 = [a1 a2 ... an]

V2 = [b1 b2 ... bn]

Vo = V1 + V2 = [a1+b1 a2+b2 ... an+bn]

The output of a one-input summer, however, will still be a scalar which is equal to the summation of the input
vector elements, that is, Vo = a1 + a2 + ... an.

3.2.2  Multiplier and Divider
The output of a multipliers or divider is equal to the multiplication or division of two inputs.

Images:

For the divider, the dotted node is for the numerator input.

The input of a multiplier can be either a vector or a scalar. If the two inputs are vectors, their dimensions must
be equal. Let the two inputs be:

V1 = [a1 a2 ... an]
V2 = [b1 b2 ... bn]

The output, which is a scalar, will be:

Vo = V1 * V2
T = a1*b1 + a2*b2 + an*bn

Parameter Description

Gain_i Gain ki for the ith input 

2-input 2-input 3-input

Input 1
Input 2

Input 1

Input 2

Input 1

Input 2 Input 3

1-input

Vo k1V1 k2V2 ... knVn+ + +=

Multiplier Divider

Numerator

Denominator
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3.2.3  Square-Root Block
A square-root function block calculates the square root of the input.

Image:

3.2.4  Exponential/Power/Logarithmic Function Blocks
The images and attributes of these function blocks are shown below.

Images:

Attributes (for exponential and power blocks):

The output of an exponential function block is defined as: 

For example, if k1 = 1, k2 = 2.718281828, and Vin = 2.5, then Vo = e2.5 where e is the base of the natural
logarithm.

The output of a power function block is defined as: 

The function block LOG gives the natural logarithm (base e) of the input, and the block LOG10 gives the
common logarithm (base 10) of the input.

3.2.5  Root-Mean-Square Block
A root-mean-square function block calculates the RMS value of the input over a period specified by the base
frequency fb. The output is defined as:

where T = 1/fb. The output is only updated at the beginning of each period.

Image:

Attribute:

Parameters Description

Coefficient k1 Coefficient k1

Coefficient k2 Coefficient k2

Parameter Description

Base frequency Base frequency fb, in Hz

Exponential Power LOG LOG10

Vo k1 k2
Vin⋅=

Vo k1 Vin
k2⋅=

Vrms
1
T
--- vin

2 t( )dt
0

T
∫=
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3.2.6  Absolute and Sign Function Blocks
An absolute value function block gives the absolute value of the input. A sign function block gives the sign of
the input, i.e., the output is 1 if the input is positive, 0 if the input is 0, and -1 if the input is negative.

Images:

3.2.7  Trigonometric Functions
The following trigonometric functions are provided: two sine (sin) blocks, two cosine (cos) blocks, arcsine
(sin-1), arccosine (cos-1), tangent (tan), arctangent (tg-1), and arctangent 2 (atan2). 

The output is equal to the corresponding trigonometric function of the input. For the sin, cos, and tan blocks, the
input is in deg., and for the arcsin, arccos, and arctangent blocks, the output is in deg. For the sin and cos blocks
that have the letter "r" at the upper left corner and the atan2 block, the input is in radian.

Images:

In the arctangent and arctangent 2 blocks, the input node marked with x is the real part, and the other input node
marked with y is the imaginary part. 

The output of the arctangent and arctangent 2 blocks is the inverse tangent of the ratio between the imaginary

part y and the real part x, i.e. . The output of the arctangent block is in degree, and the range is from

0 to 360o. On the other hand, the output of the arctangent 2 block is in radian, and the range is from -π to +π.
The arctangent 2 block behaves in the same way as the function atan2(y,x) in the C language.

3.2.8  Fast Fourier Transform Block
A Fast Fourier Transform block calculates the fundamental component of the input signal. The FFT algorithm is
based on the radix-2/decimation-in-frequency method. The number of sampling points within one fundamental
period should be 2N (where N is an integer). The maximum number of sampling points allowed is 1024. 

The output gives the peak amplitude and the phase angle of the input fundamental component. The output
voltage (in complex form) is defined as:

Image:

Absolute Sign

(input in rad.) (input in rad.)(input in deg.) (input in deg.)

θ tg 1– y
x
--⎝ ⎠

⎛ ⎞=

vo
2
N
---- vin n( ) vin n N

2
----+⎝ ⎠

⎛ ⎞– e
j2πn

N
----------–

⋅
⎝ ⎠
⎜ ⎟
⎛ ⎞

n 0=

n N
2
---- 1–=

∑⋅=

Amplitude

Phase Angle
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Attributes: 

The dotted node of the block refers to the output of the amplitude. Note that the phase angle output has been
internally adjusted such that a sine function Vm*sin(ωt) will give a phase angle output of 0.

Note that the FFT block only works if the input signal contains dc, the fundamental component, and harmonics
of the fundamental components (with the frequencies at multiple integer times of the fundamental frequency). If
the input signal contains another component that is not multiple integer of the fundamental frequency, the FFT
block will not give the correct result. 

Also, the FFT block only measures the fundamental component, not any other harmonics. For example, if the
input signal contains 60 Hz (fundamental) and 180 Hz, if the parameter "Fundamental Frequency" is set to 180,
the FFT block output will be incorrect. 

Example: 
In the circuit below, the voltage vin contains a fundamental component v1 (100 V at 60 Hz), a 5th harmonic
voltage v5 (25 V at 300 Hz), and a 7th harmonic v7 (25 V at 420 Hz). After one cycle, the FFT block output
reaches the steady state with the amplitude of 100 V and the phase angle of 0o. 

3.2.9  Maximum/Minimum Function Block
A maximum/minimum function block detects the maximum or minimum of the inputs. 

Image:

Attributes: 

The number of inputs can be changed through the drop-down menu. 

Parameters Description

No. of Sampling Points No. of sampling points N

Fundamental Frequency Fundamental frequency fb, in Hz. 

Parameters Description

Number of Inputs Number of inputs

Block Function Type Function type of the block. It can be either Maximum or Minimum. 

v1

v5

v7

vin vamp

Angle

v1
vin

vamp

Angle
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3.3  Other Function Blocks

3.3.1  Comparator
The output of a comparator is high when the positive input is higher than the negative input. When the positive
input is lower, the output is zero. If the two input are equal, the output is undefined and it will keep the previous
value. 

Image: 

Note that the comparator image is similar to that of the op. amp. For the comparator, the noninverting input is at
the upper left and the inverting input is at the lower left. For the op. amp., however, it is the opposite. 

3.3.2  Limiters
Four types of limiters are provided to limit the amplitude of a signal: lower/upper limiter, lower limiter, upper
limiter, and range limiter.

Images: 

Attributes: 

For a lower/upper limiter, or lower limiter, or upper limiter, the output of the limiter is clamped to the upper or
lower limit whenever the input exceeds the limiter range. If the input is within the limit, the output is equal to
the input.

For a range limiter, let the range of the upper limit and the lower limit be Vrange. When the input is within the
limit, the output is equal to the input. When the output exceeds the upper limit, the output is subtracted by the
range Vrange until it is within the range. When the output is below the lower limit, it is added by range Vrange
until it is within the range. 

3.3.3  Gradient (dv/dt) Limiter
A gradient (dv/dt) limiter limits the rate of change of the input. If the rate of change is within the limit, the
output is equal to the input.

Image: 

Parameters Description

Lower Limit Lower limit of the limiter

Upper Limit Upper limit of the limiter

Lower Limiter Upper Limiter Range LimiterLower/upper Limiter
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Attribute: 

3.3.4  Trapezoidal and Square Blocks
Trapezoidal waveform blocks and square waveform blocks are specific types of lookup tables: the output and
the input relationship is either a trapezoidal or a square waveform. 

Images:

For the trapezoidal waveform block:

Attributes:

For the square waveform block:

Attribute:

The waveforms of these two blocks are shown below. Note that the input vin is in deg., and can be in the range
of -360o to 360o. Both waveforms are half-wave and quarter-wave symmetrical.

3.3.5  Sampling/Hold Block
A sampling/hold block samples the input when the control signal changes from low to high (from 0 to 1), and
holds this value until the next point is sampled.

Image:

The difference between this block and the zero-order hold block (ZOH) in Digital Control Module is that this
block is treated as a continuous element and sampling moments can be controlled externally; whereas the zero-

Parameter Description

dv/dt Limit Limit of the rate of change (dv/dt) of the input

Parameters Description

Rising Angle theta Rising angle θ, in deg.

Peak Value Peak value Vpk of the waveform

Parameter Description

Pulse Width (deg.) Pulse width θ in half cycle, in deg.

Trapezoidal Waveform Square Waveform

θ

vo

Vpk

-Vpk

180
o

360
o

vin θ

vo

1

-1
180

o
360

o

vin

Trapezoidal Waveform Square Waveform

00

Input

Control 
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order hold block is a discrete element and the sampling moments are fixed and of equal distance. 

For a discrete system, the zero-order hold block should be used. 

Example:
In this example, a sinusoidal input is sampled. The control signal is a square wave voltage source with an
amplitude of 1.

3.3.6  Round-Off Block
The image of a round-off block is shown below: 

Image:

Attributes:

Let the input of the round-off block be Vin. The input is first scaled based on the following expression:

If the truncation flag is 1, the output will be equal to Vin,new truncated, and then divided by 10N. Otherwise, the
output will be equal to Vin,new rounded off to the nearest integer, and then divided by 10N.

Examples:
If Vin = 34.5678, N = 0, truncation flag = 0, then we have the output Vout = 35. Similarly, if Vin = 34.5678, N = 0,
truncation flag = 1, then Vout = 34. 

If Vin = 34.5678, N = 1, truncation flag = 1, then Vout = 34.5. If Vin = 34.5678, N = -1, truncation flag = 1, then
Vout = 30.

3.3.7  Time Delay Blocks
Two types of time delay blocks are provided: one with arbitrary delay time, and the other with only one
simulation time step. 

Parameters Description

No. of Digits No. of digits N after the decimal point

Truncation Flag Truncation flag (1: truncation; 0: round-off)

vin
vo

vctrl

Vin new, Vin 10N⋅=
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Images:

Attribute:

A time delay block delays the input signal by a specified amount of time interval. It, for example. can be used to
model the propagation delay of a logic element.

A unit time delay block delays the input signal by just one simulation time step. If the simulation time step is
changed, the delay time will be changed accordingly.

Note that the difference between the unit time delay block and the unit delay block in Digital Control Module is
that this block is a continuous element and the delay time is one simulation time step; whereas the unit delay
block is a discrete element and the delay time is equal to the sampling period.

For a discrete system, the unit delay block should be used. 

Example:
In this circuit, the first time delay block has a delay time of 1 ms, and the second block has a delay time of 4 ms.
This example illustrates that the input of the time delay block can be either an analog or a digital signal.

3.3.8  Multiplexer
The output of a multiplexer is equal to a selected input depending on the control signal. Three multiplexers are
provided: multiplexers with 2 inputs; 4 inputs; and 8 inputs.

Images:

In the images, d0..d7 are the data inputs; and s0..s2 are the control signals. The truth tables of the multiplexers

Parameter Description

Delay Time Delay time, in sec. (for the Time Delay block only)

Time Delay Unit Time Delay

vin1 vo1

vin2

vin2
vo2

vo2

1 ms

4 ms

2-input 4-input 8-input

d0

d1

s0

s1s0 s2s1 s0

d0
d1

d2
d3

d0

d7

Y Y
Y
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are as follows. 

Note that the data input could be either an analog or digital signal. 

Example:
The following circuit selects the maximum value out of two inputs. When Va is greater than Vb, the comparator
output will be 1, and Vo = Va. Otherwise Vo = Vb.

3.3.9  THD Block
The total harmonic distortion (THD) of an ac waveform that contains both the fundamental and harmonic
components is defined as:

where V1 is the fundamental component (rms), Vh is the harmonic rms value, and Vrms is the overall rms value
of the waveform. The THD block is modelled as shown below. 

Image:

A second-order band-pass filter is used to extract the fundamental component. The center frequency and the
passing band of the band-pass filter need to be specified.

2-Input MUX 4-Input MUX 8-Input MUX
s0 Y s1 s0 Y s2 s1 s0 Y
0 d0 0 0 d0 0 0 0 d0
1 d1 0 1 d1 0 0 1 d1

1 0 d2 0 1 0 d2
1 1 d3 0 1 1 d3

1 0 0 d4
1 0 1 d5
1 1 0 d6
1 1 1 d7

THD
Vh

V1
-----

Vrms
2 V1

2–
V1

---------------------------= =

THD Circuit Model of the THD Block

vin(t) THD

v1(t)

V1

VhVrmsTHD

v1(t)

vin(t)
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Attributes:

Example: 
In the single-phase thyristor circuit below, a THD block is used to measure the THD of the input current. The
delay angle of the thyristor bridge is chosen as 30o. For the THD block, the fundamental frequency is set at 60
Hz and the passing band of the filter is set at 20 Hz. The simulation results are shown on the right.

One of the THD block output is the input current fundamental component is1. By comparing the phase
difference between the input voltage vs and the current is1, one can calculate the input displacement power
factor. This, together with the THD value, can be used to calculate the input power factor.

3.4  Logic Components

3.4.1  Logic Gates
Basic logic gates are AND, OR, XORGATE (exclusive-OR), NOT, NAND, and NOR gates. 

Images:

3.4.2  Set-Reset Flip-Flop
There are two types of set-reset flip-flops. One is edge-triggered and the other is level-triggered. 

Image:

Parameters Description

Fundamental Frequency Fundamental frequency of the input, in Hz 

Passing Band Passing band of the band-pass filter, in Hz

vs

is
is1

alpha=30 deg.

THD

NOR

AND OR NOT

NAND3-input AND 3-input OR

XOR
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Attribute:

An edge-triggered flip-flop only changes the states at the rising edge of the set/reset input. The truth table of an
edge-triggered flip-flop is:

A level-triggered flip-flop, on the other hand, changes the states based on the input level. The truth table of a
level-triggered set-reset flip-flop is:

3.4.3  J-K Flip-Flops
Two types of J-K flip-flops are provided: One without the set/reset inputs, and the other with the set input (S)
and reset input (R). For the element without the set and reset inputs, it is assumed that both set/reset inputs are
high (1).

Images:

A J-K flip-flop is positive edge triggered, and the truth table is: 

x: Do not care 

Parameter Description

Trigger Flag Trigger flag (0: edge-triggered; 1: level-triggered)

S R Q Qn
0 0 no change
0 ↑ 0 1
↑ 0 1 0
↑ ↑ not used

S R Q Qn
0 0 no change
0 1 0 1
1 0 1 0
1 1 not used

S R J K Clock Q Qn
0 1 x x x 1 0
1 0 x x x 0 1
0 0 x x x 0 0
1 1 0 0 ↑ no change
1 1 0 1 ↑ 0 1
1 1 1 0 ↑ 1 0
1 1 1 1 ↑ Toggle
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3.4.4  D Flip-Flops
Two types of D flip-flops are provided: One without the set/reset inputs, and the other with the set input (S) and
reset input (R). For the element without the set and reset inputs, it is assumed that both set/reset inputs are high
(1).

Image:

A D flip-flop is positive edge triggered, and the truth table is: 

x: Do not care 

3.4.5  Monostable Multivibrator
In a monostable multivibrator, the positive (or negative) edge of the input signal triggers the monostable. A
pulse, with the specified pulse width, will be generated at the output.

The output pulse width can be either fixed or adjusted through another input variable. The latter type of
monostables is referred to as controlled monostables. Its on-time pulse width, in second, is determined by the
control input.

Images:

Attribute:

The input node at the bottom of the controlled monostable block is for the pulse width input. 

S R D Clock Q Qn
0 1 x x 1 0
1 0 x x 0 1
0 0 x x 0 0
1 1 0 ↑ 0 1
1 1 1 ↑ 1 0

Parameter Description

Pulse Width On-time pulse width, in sec.

Controlled MonostableMonostable
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3.4.6  Pulse Width Counter
A pulse width counter measures the width of a pulse. The rising edge of the input activates the counter. At the
falling edge of the input, the output gives the width of the pulse (in sec.). During the interval of two falling pulse
edges, the pulse width counter output remains unchanged.

Image:

3.4.7  Up/Down Counter
An up/down counter increments or decrements by 1 at each rising edge of the clock.

Image:

Attribute:

When the Up/Down input is 0, the counter decrements, and when the Up/Down input is 1, the counter
increments.

The Reset input resets the counter to 0 when it is high (1). The Preset Enable input sets the counter to the preset
value when it is high.

The truth table of the counter is:

x: Do not care 

Parameter Description

No. of Bits Number of bits N

Up/Down Preset Enable Reset Clock Action
x 0 0 x No count
1 0 0 ↑ Count up
0 0 0 ↑ Count down
x 1 0 x Preset
x x 1 x Reset

Preset Value
Preset Enable

Up/Down
Reset

Clock Output
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3.4.8  A/D and D/A Converters
A/D and D/A converters perform analog-to-digital and digital-to-analog conversion. Both 8-bit and 10-bit
converters are provided.

Images:

Let N be the number of bits. The output of the A/D converter is calculated as:

For example, if Vref = 5 V, Vin = 3.2 V, N = 8 bits, then 

Vo = 256/5*3.2 = 163.84 = 10100011 (binary)

The output of the D/A converter is calculated as:

For example, if Vref = 5 V, Vin = 10100011 (binary) = 163, N = 8 bits, then 

Vo = 163/256*5 = 3.1836 

ADC (8-bit) ADC (10-bit) DAC (8-bit) DAC (10-bit)

Vin Vo

Vref Vref

Clock

Vo Vin

Vo
2N

Vref
--------- Vin⋅=

Vo
Vref

2N
--------- Vin⋅=
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3.5  Digital Control Module
The Digital Control Module is an add-on module to the basic PSIM program. It provides discrete elements, such
as zero-order hold, z-domain transfer function blocks, digital filters, etc., for digital control system simulation. 

In contrary to a s-domain circuit which is continuous, a z-domain circuit is discrete, and the calculation is only
performed at the discrete sampling points. There is no calculation between two sampling points.

3.5.1  Zero-Order Hold
A zero-order hold samples the input at the point of sampling. The output remains unchanged between two
sampling points.

Image:

Attribute:

Like all other discrete elements, the zero-order hold has a free-running timer which determines the moment of
sampling. The sampling moment is synchronized with the origin of the simulation time. For example, if the
zero-order hold has a sampling frequency of 1000 Hz, the input will be sampled at 0, 1 msec., 2 msec., 3 msec.,
and so on.

Example: 
In the following circuit, the zero-order hold sampling frequency is 1000 Hz. The input and output waveforms
are shown on the left. 

Note that in above circuit, a continuous-domain integrator is also connected to the input sine source. This makes
it a mixed continuous-discrete circuit, and a simulation time step selected for the continuous circuit will be
used. With this time step, the familiar staircase-like waveform can be observed at the zero-order hold output. 

Without the integrator, the circuit becomes a discrete circuit. Since only the calculation at the discrete sampling
points is needed, the simulation time step will be equal to the sampling period, and only the results at the
sampling points are available. The waveforms, as shown below, appear continuous. In fact the waveforms are
discrete, and the connection between two sampling points makes it look like continuous. 

Parameter Description

Sampling Frequency Sampling frequency of the zero-order hold, in Hz
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3.5.2  z-Domain Transfer Function Block
A z-domain transfer function block is expressed in polynomial form as: 

If a0 = 1, the expression Y(z) = H(z) * U(z) can be expressed in difference equation as:

 

Image:

Attributes:

Example:
The following is a second-order transfer function: 

Assuming a sampling frequency of 3 kHz, the specification will be:

Parameters Description

Order N Order N of the transfer function 

Coeff. b0...bN Coefficients of the numerator (from b0 to bN) 

Coeff. a0...aN Coefficients of the denominator (from a0 to aN) 

Sampling Frequency Sampling frequency, in Hz

Order N 2

Coeff. b0...bN 0.    0.     400.e3

Coeff. a0...aN 1.  1200.  400.e3

Sampling Frequency 3000.

H z( )
b0 zN b1 zN 1–⋅ ... bN 1– z bN+⋅+ + +⋅

a0 zN a1 zN 1–⋅ ... aN 1– z aN+⋅+ + +⋅
-------------------------------------------------------------------------------------------=

y n( ) b0 u n( ) b1 u n 1–( )⋅ ... bN u n N–( ) –⋅+ + +⋅=

a1 y n 1–( )⋅ a2 y n 2–( )⋅ ... aN y n N–( )⋅+ + +[ ]

H z( ) 400.e3

z2 1200 z 400.e3+⋅+
----------------------------------------------------=
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3.5.2.1  Integrator
There are three types of integrators: regular integrator, external resettable integrator, and internal resettable
integrator. 

Images:

Attribute:

The output of an external resettable integrator can be reset by an external control signal (at the bottom of the
block). With the edge reset (reset flag = 0), the integrator output is reset to zero at the rising edge of the control
signal. With the level reset (reset flag = 1), the integrator output is reset to zero as long as the control signal is
high (1).

The output of an internal resettable integrator is reset to 0 whenever the output reaches either the lower limit or
the upper limit. The integrator works in the same way as the external resettable integrator with the edge reset,
except that users do not need to set up the external reset circuit in this case. 

If we define u(t) as the input, y(t) as the output, T as the sampling period, and H(z) as the discrete transfer
function, the input-output relationship of an integrator can be expressed under different integration algorithms
as follows.

With trapezoidal rule:

 

With backward Euler:

 

With forward Euler:

 

Parameters Description

Algorithm Flag Flag for integration algorithm
0: trapezoidal rule
1: backward Euler
2: forward Euler

Initial Output Value Initial output value

Reset Flag Reset flag (0: edge reset; 1: level reset) (for external resettable integrator only)

Lower Output Limit Lower limit of the output (for internal resettable integrator only)

Upper Output Limit Upper limit of the output (for internal resettable integrator only)

Sampling Frequency Sampling frequency, in Hz

Regular Integrator External Resettable Integrator Internal Resettable Integrator

H z( ) T
2
--- z 1+

z 1–
-----------⋅=

y n( ) y n 1–( ) T
2
--- u n( ) u n 1–( )+( )⋅+=

H z( ) T z
z 1–
-----------⋅=

y n( ) y n 1–( ) T u n( )⋅+=

H z( ) T 1
z 1–
-----------⋅=
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3.5.2.2  Differentiator
The transfer function of a discrete differentiator is: 

 

where T is the sampling period. The input-output relationship can be expressed in difference equation as: 

Image: 

Attribute:

3.5.2.3  Digital Filters
Two types of digital filters are provided: general digital filter and finite impulse response (FIR) filter. For both
types, the filter coefficients can either be entered directly through the element property window, or be specified
through a text file. 

Images:

Attributes:
For elements that read the coefficients directly:

For elements that read the coefficients from a text file:

The transfer function of the general digital filter is expressed in polynomial form as: 

Parameter Description

Sampling Frequency Sampling frequency, in Hz

Parameters Description

Order N Order N of the transfer function 

Coeff. b0...bN Coefficients of the numerator (from b0 to bN) 

Coeff. a0...aN Coefficients of the denominator (from a0 to aN) 

Sampling Frequency Sampling frequency, in Hz

Parameters Description

File for Coefficients Name of the file storing the filter coefficients

Sampling Frequency Sampling frequency, in Hz

y n( ) y n 1–( ) T u n 1–( )⋅+=

H z( ) 1
T
--- z 1–

z
-----------⋅=

y n( ) 1
T
--- u n( ) u n 1–( )–( )⋅=

FIR FilterGeneral Digital Filter
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If a0 = 1, the output y and input u can be expressed in difference equation form as:

If the denominator coefficients a0..aN are not zero, this type of filter is called infinite impulse response (IIR)
filter.

The transfer function of the FIR filter is expressed in polynomial form as: 

If a0 = 1, the output y and input u can be expressed in difference equation form as:

The coefficient file for block Digital Filter (file) and FIR Filter (file) has the following format:

For FIR Filter (file):

For Digital Filter (file), the format can be either one of the following:  

Example:
To design a 2nd-order low-pass Butterworth digital filter with the cut-off frequency fc =   1 kHz, assuming the
sampling frequency fs = 10 kHz, using MATLAB, we have:

Nyquist frequency fn = fs / 2 = 5 kHz

Normalized cut-off frequency fc* = fc/fn = 1/5 = 0.2

[B,A] = butter (2, fc*)

which will give:

B = [0.0201   0.0402   0.0201 ] = [b0   b1   b2]

A = [     1   -1.561   0.6414 ] = [a0   a1   a2]

N
b0
b1
... ... ...
bN

N
b0 
b1 
... ... ...
bN 
a0
a1
... ... ...
aN

or N
b0, a0
b1, a1
... ... ...
bN, aN

H z( )
b0 b1 z 1–⋅ ... bN 1– z N 1–( )– bN z N–⋅+⋅+ + +

a0 a1 z 1–⋅ ... aN 1– z N 1–( )– aN z N–⋅+⋅+ + +
--------------------------------------------------------------------------------------------------------=

y n( ) b0 u n( ) b1 u n 1–( )⋅ ... bN u n N–( ) –⋅+ + +⋅=

a1 y n 1–( )⋅ a2 y n 2–( )⋅ ... aN y n N–( )⋅+ + +[ ]

H z( ) b0 b1 z 1–⋅ ... bN 1– z N 1–( )– bN z N–⋅+⋅+ + +=

y n( ) b0 u n( ) b1 u n 1–( )⋅ ... bN u n N–( )⋅+ + +⋅=
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The transfer function is: 

The input-output difference equation is:

The parameter specification of the filter in PSIM will be: 

If the coefficients are stored in a file, the file content will be:

2
0.0201
0.0402
0.0201
1.
-1.561
0.6414

Or the file can also have the content as follows:

2
0.0201,  1
0.0402,  -1.561
0.0201,  0.6414

3.5.3  Unit Delay
A unit delay block provides one sampling period delay to the input. 

Image:

Attribute:

The difference between the unit delay block and the time delay block is that the unit delay block is a discrete
element and it delays the sampled points by one sampling period, whereas the time delay block is a continuous
element and it delays the whole waveform by the delay time specified. 

Order N 2

Coeff. b0...bN 0.0201    0.0402     0.0201

Coeff. a0...aN 1.           -1.561      0.6414

Sampling Frequency 10000.

Parameter Description

Initial Output Value Initial value of the output of the block

Sampling Frequency Sampling frequency, in Hz

H z( ) 0.0201 0.0402 z 1–⋅ 0.0201 z 2–⋅+ +
1 1.561– z 1–⋅ 0.6414 z 2–⋅+

-------------------------------------------------------------------------------------=

y n( ) 0.0201 u n( ) 0.0402 u n 1–( )⋅ 1.561 y n 1–( )⋅ 0.6414– y n 2–( )⋅+ +⋅=
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3.5.4  Quantization Blocks
Quantization blocks simulate the quantization process of an A/D converter. Two quantization blocks are
provided: One with 1 LSB (least significant bit) quantization error, and the other with input offset with 0.5 LSB
quantization error.

Image:

Attributes:

To understand how the quantization blocks work, we will look at a special case where N = 3, Vin,min = 0, and
Vin,max = 1. The input will be divided into 23 (or 8) stages. Depending on the input level, the output will be one
of the 3-bit discrete numbers 000, 001, 010, 011, 100, 101, 110, and 111. The output will have 23 (or 8) levels,
and 23-1 (or 7) steps. If the binary number 000 corresponds to the decimal number 0, and the binary number 111
corresponds to the decimal number 0.875, and Vo,min = 0, and Vo,max = 1, we can plot the waveforms of the
input, output, and the quantization error Vin-Vo of the two quantization blocks as below. 

The waveforms on the left are from the quantization block without the offset, and the waveforms on the right
are from the quantization block with the offset. 

Parameters Description

No. of Bits Number of bits N

Vin_min Lower limit of the input value Vin,min

Vin_max Upper limit of the input value Vin,max

Vo_min Lower limit of the output value Vo,min

Vo_max Output value Vo,max that corresponds to the input value Vin,max

Sampling Frequency Sampling frequency, in Hz

Quantization Block Quantization Block (with offset)
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As shown from the waveforms on the left, the quantization error of the quantization block is from 0 to 1 LSB
(least significant bit), or 1/23 (or 0.125). 

For the quantization block with offset, a value of 0.5*LSB is added to the input before performing the
quantization. This reduces the quantization error to -0.5 LSB to +0.5 LSB (except when the input is close to the
maximum value), as shown from the waveforms on the right. 

The figure below shows the input-output relationship of a general quantization block with offset.

The number of bits determines the quantization resolution. The input range, Vin,max - Vin,min, is divided into 2N

stages, with the width of each stage as:

(000)

(001)

(010)

(011)

(100)

(101)

(110)

(111)

Binary 

Quantization block Quantization block (with offset)

(000)

(001)

(010)

(011)

(100)

(101)

(110)

(111)

numbers
Binary 
numbers

Vin,min Vin,max

Vo

Vin

Vo,min

Vo,max

0

2
N

-1

2
N

1

ΔVin

ΔVo

Binary numbers

Actual output limit
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except for the 1st stage where the width is 0.5*ΔVin, and the last stage where the width is 1.5∗ΔVin. Note that for
the quantization block without the offset, the width of the 1st and last stage is ΔVin. 

If the input falls in the kth stage, the output will be calculated as:

where k is from 1 to 2N, and the output step is calculated as:

Note that the value Vo,max corresponds to the output value when the input is at Vin,max. But because of the
quantization, the output can be represented in only N levels, from 0 to 2N-1. As a result, the actual limit of the
output is not Vo,max, but Vo,max - ΔVo, as shown in the figure above. 

Example:
For a quantization block with the offset, let N = 3, Vin,min = 0, Vin,max = 1, Vo,min = 0, and Vo,min = 1. We have
ΔVin = ΔVo = 1/8. If Vin = 0.25, it is in the 3rd stage (k = 3), and it corresponds to Vo = 0 + (3 - 1) * 1/8 = 0.25. If
Vin = 0.6, it is in the 6th stage (k = 6), and it corresponds to Vo = 0 + (6 - 1) * 1/8 = 0.625. 

3.5.5  Circular Buffers
A circular buffer is a memory location that can store an array of data. Two types of circular buffers are provided
in PSIM: One with a single output, and the other with a vector output. 

Images:

Attributes:

A circular buffer stores data in a buffer. When the pointer reaches the end of the buffer, it will start again from
the beginning.

The circular buffer with single output is a type of first-in-first-out memory storage device, and the output is
equal to the value being pushed out.

The output of the circular buffer with vector output is a vector array with the length equal to the buffer length.
To access each memory location, use the memory read block. 

Example:
If a circular buffer has a buffer length of 4 and a sampling frequency of 10 Hz, we have the buffer storage at
different time as follows:

Parameters Description

Buffer Length The length of the buffer

Sampling Frequency Sampling frequency, in Hz

ΔVin
Vin max, Vin min,–

2N
---------------------------------------=

Vo Vo min, k 1–( ) ΔVo⋅+=

ΔVo
Vo max, Vo min,–

2N
------------------------------------=

Circular Buffer (single output) Circular Buffer (vector output)
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3.5.6  Convolution Block
A convolution block performs the convolution of two input vectors. The output is also a vector.

Image:

Let the two input vectors be:
A = [ am am-1 am-2 ... a1]
B = [ bn bn-1 bn-2 ... b1]

We have the convolution of A and B as:

where
             ci = Σ[ ak+1 * bj-k],   k=0, ..., m+n-1; j=0, ..., m+n-1; i=1, ..., m+n-1

Example:
If A = [1 2 3] and B = [4 5], we have m = 3; n = 2; and the convolution of A and B is: C = [4 13 22 15].

3.5.7  Memory Read Block
A memory read block is used to read the value of a memory location of a vector.

Image:

Attribute:

A memory read block allows one to access the memory location of elements such as convolution block, vector
array, and circular buffer. The index offset defines the offset from the starting memory location.

Time Input Value at Memory Location Output (for single-
output buffer)1 2 3 4

0 0.11 0.11 0 0 0 0

0.1 0.22 0.11 0.22 0 0 0

0.2 0.33 0.11 0.22 0.33 0 0

0.3 0.44 0.11 0.22 0.33 0.44 0

0.4 0.55 0.55 0.22 0.33 0.44 0.11

0.5 0.66 0.55 0.66 0.33 0.44 0.22

... ... ...

Parameter Description

Memory Index Offset Offset from the starting memory location

C A B⊗ cm n 1–+ cm n 2–+ ... c1= =
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Example:
Let a vector be A = [2 4 6 8]. If index offset is 0, the memory read block output will be 2. If the index offset is
2, the output will be 6.

3.5.8  Data Array
This is a one-dimensional array. The output is a vector. The data are either entered directly (the element is called
Array in the PSIM library) or specified in a file (the element is called Array (file) in the PSIM library).

Image:

Attributes:

If the array is read from a file, the file will have the following format:

N
a1
... ... ...
aN

where N is the length of the array, and a1..aN are the array values. 

Example:
To define an array A = [2 4 6 8], we will have: Array Length = 4; Values = 2 4 6 8. If the array is to be read from
a file, the file will be:

4
2.
4.
6.
8.

3.5.9  Stack
A stack is a first-in-last-out register. 

Image:

Attribute:

Parameters Description

Array Length The length of the data array N (for the element Array only)

Values Values of the array (for the element Array only)

File for Coefficients Name of the file storing the array (for the element Array (file) only)

Parameter Description

Stack Depth The stack depth

Vin

push
pop

Vo
130    Chapter 3: Control Circuit Components



The rising edge triggers the push or pop action. When a pop action is performed and the stack is empty, the
output remains unchanged. When a push action is performed and the stack is already full, the data at the bottom
of the stack will be pushed out and will be lost.

3.5.10 Multi-Rate Sampling System
A discrete system can have more than one sampling rate. The following system is used to illustrate this.

The system below has 3 sections. The first section has a sampling rate of 10 Hz. The output, Vo, fed back to the
system and is sampled at 4 Hz in the second section. In the third section, the output is displayed at a sampling
rate of 2 Hz.

It should be noted that a zero-order hold must be used between two elements with different sampling rates.

Vo
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3.6  SimCoupler Module
The SimCoupler Module is an add-on module to the PSIM software. It provides interface between PSIM and
Matlab/Simulink for co-simulation. With the SimCoupler Module, part of a system can be implemented and
simulated in PSIM, and the rest of the system in Simulink. One can therefore make full use of PSIM’s capability
in power simulation and Matlab/Simulink’s capability in control simulation in a complementary way.

The SimCoupler interface consists of two parts: the link nodes in PSIM, and the SimCoupler model block in
Simulink. The images are shown below.

Images:

In PSIM, the In Link nodes receive values from Simulink, and the Out Link nodes send the values to Simulink.
They are all control elements and can be used in the control circuit only. In Simulink, the SimCoupler model
block is connected to the rest of the system through input/output ports.

3.6.1  Set-up in PSIM and Simulink
The use of the SimCoupler Module is easy and straightforward. As an example, the following shows a
permanent-magnet synchronous motor (PMSM) drive system with the power stage implemented in PSIM, and
the control in Simulink.

The following are the steps to set up SimCoupler for PSIM-Matlab/Simulink co-simulation for the example
above.

SimCoupler Model Block
In Link Node Out Link Node

In PSIM In SimuLink

Power

Control

in PSIM

in SimuLink

File: pmsm_simulink.mdl

File: pmsm_psim.sch
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Adding the SimCoupler Block to the Simulink Library:
Run the program "SetSimPath.exe" to add the SimCoupler block to the Simulink library and set up the
SimCoupler Module for co-simulation of PSIM and Matlab/Simulink. After the execution, the
SimCoupler block will appear as "S-function SimCoupler" in the Simulink Library Browser.

Note that this step is necessary, otherwise Simulink will not be able to find PSIM. With this, it is also
not necessary to manually add the PSIM folder to the Matlab path.

Also, this program needs to be run only once. It needs to be run again only if the PSIM folder or
Matlab folder has changed. 

In PSIM:
- After the rest of the power circuit is created, connect three Out Link nodes to the low-pass filters of

Phase A, B, and C currents, and rename them as “Ia”, “Ib”, and “Ic”; and connect one Out Link node to
the speed sensor output and rename it as “Wrpm”.

- Connect three In Link nodes to the positive inputs of the comparators, and rename them as “Va”, “Vb”,
and “Vc”. 

- Go to the Simulate menu, and select Arrange SLINK Nodes. A dialog window will appear. Arrange 
the order of the In Link nodes (SLINK In) and Out Link nodes (SLINK Out) to be the same as how the 
input/output ports would appear in the SimCoupler model block in Simulink (the order of the ports is 
from the top to the bottom). In this example, the order will be “Va”, “Vb”, and “Vc” for the In Link 
nodes, and “Ia”, “Ib”, “Ic”, and “Wrpm” for the Out Link nodes.

- Save the schematic file. In this example, we assume that the file is saved to  
“C:\PSIM\pmsm_psim.sch”. 

In Simulink:
- Start Matlab. 

- Launch Simulink. Open an existing file or create a new file. After the rest of the system is created, go 
to the menu "S-function SimCoupler" in the Simulink Library Browser, select the SimCoupler block, 
and place it on the schematic.  

- In the PMSM example file, double click on the SimCoupler block, and click on the Browser button to
locate and select the PSIM schematic file “C:\PSIM\pmsm_psim.sch”. Then click on Apply. The
number of input and output ports of the SimCoupler model block will automatically match those
defined in the PSIM netlist. In this case, there will be 3 input ports and 4 output ports. 

- Go to the Simulation menu and select Simulation Parameters. Under Solver Options, set the Type
to “Fixed-step”. Set Fixed step size to be the same as or close to PSIM’s time step. In this case, the
time step is set to 0.1ms. More discussion on the selection of the solver option and the time step is
given in the next section. 

- The setup is now complete. Go to Simulink and start the simulation.

The SimCoupler Module supports Matlab/Simulink Release 13 and higher.

Please also note that when the SimCoupler model block is used in a feedback system in Simulink, the
SimCoupler model block may be part of an algebraic loop (please refer to Matlab Help for more information on
algebraic loops). Some versions of Matlab/Simulink can not solve a system containing algebraic loops, and
other can solve the system but with degraded performance. To break an algebraic loop, place a memory block at
each output of the SimCoupler model block. The memory block introduces one integration time step delay. 

3.6.2  Solver Type and Time Step Selection in Simulink
There are certain restrictions on the selection of the solver type and the time step in Simulink when performing
the co-simulation. To illustrate this, we use the following one-quadrant chopper circuit with average current
mode control as an example. 

The circuit on the left is all implemented and simulated in PSIM. The circuit on the right has the power stage
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implemented in PSIM, and the control implemented in Simulink. In both circuits, the PSIM simulation time
step is 2 us.

There are different ways of setting up Simulink to perform co-simulation. The recommend approach is to set the
Solve Type to Fixed-step and define the Fixed step size to be the same or close to PSIM’s time step. The figure
below shows this option.

It is recommended that Simulink use the same time step as PSIM, although we have found that, even if the
Simulink time step is slightly larger than PSIM time step, satisfactory results are obtained. In this case, for
example, the time step is set to 20 us, 10 times larger than the PSIM time step.

If the Simulink Solver type is instead set to Variable-step, the simulation results will not be correct. The figure
below shows this option.

When the Simulink Solver type is set to Variable-step, in order to obtain correct results, a zero-order-hold must
be placed at the input of the SimCoupler model block. Moreover, the zero-order-hold sample time must be the
same or close to PSIM time step. The figure below shows the configuration.

Complete circuit in PSIM Power circuit in PSIM

Time step: 2us

Control in Simulink
Time step: 20 us
Solver Type: Fixed-step

Control in Simulink Solver Type: Variable-step
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Therefore, Simulink must be set up to have the Solver Type as Fixed-step with the time step the same or close
to the PSIM time step, or if the Solver Type is Variable-step, a zero-order-hold must be used with the sample
time the same or close to PSIM time step

Control in Simulink Solver Type: Variable-step
ZOH Sample Time: 2 us
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4
  Other Components

4.1  Parameter File
The parameter file element defines the name of the file that stores the component parameters and limit settings.
For example, the resistance of a resistor can be specified as R1, and the value of R1 is defined in a parameter
file.

Image:

The parameter file is a text file created by the user. The format is shown below:

<name> = <value>         % Add comment here   

(global) <name> = <value> % Definition "(global)" is used in SimCoder only

<name> <value>             // Add comment here

LIMIT <name> <lower limit> <upper limit>

% Comment 

// Comment 

The field <value> can be either a numerical number (e.g. “R1 = 12.3”) or a mathematical expression (e.g. “R3 =
R1 + R2/2.”). The name and the value can be separated by either an equation sign (e.g. “R1 = 12.3”) or a space
(e.g. “R1 12.3”). Text from the character % or // to the end of the line is treated as comments (e.g. “% R3 is the
load resistance”).

The definition "(global)" is used in SimCoder only for automatic code generation. Please refer to the SimCoder
User Manual on how it is used. For PSIM simulation, this definition is ignored. That is, a parameter definition
"(global) Kp = 1.2" is treated the same as "Kp = 1.2".

For example, a parameter file may look like the following:

R1=12.3 %R1 is defined as 12.3

R2 23.4Ohm %Equation sign can be replaced by space

% Comment starts with either % or //

R3=R1+R2/2. //Math expression is allowed

L1=3m //power-of-ten suffix is allowed. L1=0.003

C1=100uF

LIMIT R3 5. 25. %R3 is limited between 5. and 25.

When PSIM saves the schematic that contains the parameter file element, it will save the information of both
the relative path and absolute path of the parameter file, as well as a copy of the content of the parameter file. 

When PSIM loads a schematic with the parameter file element, it will search and load the parameter file in the
following order: relative path (relative to the schematic file), absolute path, and the local path (the local folder
where the schematic file is). If PSIM still can not find the parameter file, it will create the parameter file in the
local schematic folder from the copy that it saved in the schematic file. 
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4.2  Sources
Several types of independent voltage/current sources are available in PSIM. The notation of a current source
direction is: the current flows out of the higher-potential node, through the external circuit, and back into the
lower-potential node of the source.

Note that current sources can be used in the power circuit only.

4.2.1  Time
The Time element is a special case of the piecewise linear voltage source. It is treated as a grounded voltage
source, and the value is equal to the simulation time, in sec.

Image:

4.2.2  Constant
The constant element allows users to define a constant. It behaviors as a grounded voltage source.

Image:

Attribute:

4.2.3  DC Source
A dc source has a constant amplitude. The reference of the grounded dc voltage sources is the ground.

Images:

Attribute:

Parameter Description

Value Value of the constant

Parameter Description

Amplitude Amplitude of the source

DC CurrentGrounded DC (circle) Grounded DC (T)DC (battery)
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4.2.4  Sinusoidal Source
A sinusoidal source is defined as:

The specifications can be illustrated as follows.

Images:

Attributes:

To facilitate the setup of three-phase circuits, a symmetrical three-phase Y-connected sinusoidal voltage source
is provided. The dotted phase of the source refers to Phase A.

Image:

Attributes:

4.2.5  Square-Wave Source

Parameters Description

Peak Amplitude Peak amplitude Vm 

Frequency Frequency f, in Hz 

Phase Angle Initial phase angle θ, in deg. 

DC Offset DC offset Voffset 

Tstart Starting time, in sec. Before this time, the source is 0.

Parameters Description

V (line-line-rms) Line-to-line rms voltage amplitude

Frequency Frequency f, in Hz

Init. Angle (phase A) Initial angle for Phase A

vo Vm 2π f t θ+⋅ ⋅( )sin⋅ Voffset+=

Voffset
Vm

1/f
θ t

Voltage Current

3-phase Voltage

a

b

c
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A square-wave voltage source or current source is defined by peak-to-peak amplitude, frequency, duty-cycle,
and DC offset. The duty cycle is defined as the ratio between the high-potential interval versus the period.

Images:

Attributes:

The specifications of a square wave source are illustrated as follows.

When the phase delay θ is positive, the waveform is shifted to the right along the time axis.

4.2.6  Triangular/Sawtooth Sources
A triangular-wave voltage source or current source is defined by peak-to-peak amplitude, frequency, duty-
cycle, and DC offset. The duty cycle is defined as the ratio between the rising-slope interval versus the period.

Images:

Attributes:

Parameters Description

Vpeak-peak Peak-to-peak amplitude Vpp

Frequency Frequency, in Hz

Duty Cycle Duty cycle D of the high-potential interval

DC Offset DC offset Voffset 

Phase Delay Phase delay θ of the waveform, in deg.

Parameters Description

Vpeak-peak Peak-to-peak amplitude Vpp 

Frequency Frequency, in Hz 

Duty Cycle Duty cycle D of the rising slope interval

DC Offset DC offset Voffset 

Voltage Current

Voffset

Vpp

t
T (T=1/f)

D*T

0

θ

Voltage Current
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The specifications of a triangular wave source are illustrated as:

When the phase delay θ is positive, the waveform is shifted to the right along the time axis.

A sawtooth-wave voltage source is a special case of the triangular source with the duty cycle of 1 and dc offset
and phase delay of 0, and with one node grounded. It is defined as below: 

Image:

Attributes:

4.2.7  Step Sources
A step voltage/current source changes from one level to another at a given time. Two types of step sources are
provided: one that changes from 0 to a certain level (refer to as Step in the library), and the other that changes
from one level to another level (referred to as Step (2-level) in the library).

Images:

Attributes:
For the Step type source:

Phase Delay Phase delay θ of the waveform, in deg.

Parameters Description

Vpeak Peak amplitude

Frequency Frequency, in Hz

Parameters Description

Vstep Value Vstep after the step change 

Tstep Time Tstep at which the step change occurs

Voffset

Vpp

t
T 

(T=1/f)

D*T

0

θ

Sawtooth-wave

Voltage Current
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For the Step (2-level) type source:

The specifications of the voltage step sources are illustrated as follows:

4.2.8  Piecewise Linear Source
The waveform of a piecewise linear source consists of piecewise linear segments. It is defined by the number of
points, the values and the corresponding time (in sec.). The values and times can be entered either separately, or
in pair.

Images:

Attributes:
For the sources that define the values and times separately:

For the sources that define the values and times in pair:

The time and value pair must be enclosed by left and right brackets. The time and value can be separated by
either a comma, such as (1.2m,5.5), or a space, such as (1.2m 5.5), or both, such as (1.2m, 5.5).

Example: 
The following is a non-periodic piecewise linear source. It has 3 segments which can be defined by four points

Parameters Description

Vstep1 Value Vstep1 before the step change 

Vstep2 Value Vstep2 after the step change

Tstep Time Tstep at which the step change occurs

T_transition Transition time Ttransition from Vstep1 to Vstep2

Parameters Description

Frequency Frequency of the waveform, in Hz 

No. of Points n No. of points 

Values V1...Vn Values at each point 

Time T1...Tn Time at each point, in sec. 

Parameters Description

Frequency Frequency of the waveform, in Hz 

Times, Values (t1,v1) ... Time and value at each point

t0 Tstep

Vstep

t0 Tstep

Vstep2

Ttransition
Vstep1

Step (2-level) TypeStep Type

                         Voltage Current
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(marked in the figure).

The specification for the piecewise linear voltage source will be:

The specification for the piecewise linear (in pair) voltage source will be:

4.2.9  Random Source
The amplitude of a random voltage source (VRAND) or current source (IRAND) is determined randomly at
each simulation time step. A random source is defined as:

where Vm is the peak-to-peak amplitude of the source, n is a random number in the range of 0 to 1, and Voffset is
the dc offset.

Images:

Attributes:

4.2.10 Math Function Source
A math function source allows one to define the source in a mathematical expression. 

Image:

Frequency 0.

No. of Points n 4

Values V1...Vn 1.   1.    3.   3.

Times T1...Tn 0.  0.1  0.2  0.3

Frequency 0.

Times, Values (t1,v1)... (0., 1) (0.1, 1) (0.2, 3) (0.3, 3)

Parameters Description

Peak-Peak Amplitude Peak-to-peak amplitude of the source

DC Offset DC offset

0 0.1 0.2 0.3

1

2
3

Time (sec.)

vo Vm n Voffset+⋅=

                         Voltage Current
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Attributes:

In the expression, “T” or “t” represents time. For example, to implement a sinusoidal source, the expression will
be: sin(2*3.14159*60*t+2.09). 

4.2.11 Voltage/Current-Controlled Sources
The following types of controlled sources are available:

- Voltage controlled voltage source 
- Current controlled voltage source 
- Voltage controlled current source 
- Current controlled current source 
- Variable-gain voltage controlled voltage source 
- Variable-gain voltage controlled current source 

The controlling current of a current controlled source must come from a RLC branch. Also, for a controlled
current source, the controlling voltage or current can not be an independent source.

Note that controlled sources can be used in the power circuit only.

Images:

Attribute:

For voltage-controlled sources, the controlling voltage is from the positive node (+) to the negative node (-). 

For current-controlled sources (with an arrow pointing from one node to another), the control nodes are
connected across a RLC branch, and the direction of the controlling current is indicated by the arrow. 

For current-controlled sources (with a wire connecting the two nodes), the controlling current flows from one
control node to another, as indicated by the arrow. A 10-uOhm resistor is used to sense the controlling current.

The output of a controlled source, except variable-gain controlled sources, is equal to the gain multiplied by the
controlling voltage or current. For the variable-gain controlled sources, the output is equal to the following:

Parameters Description

Expression The mathematical expression of the source

Tstart Start time of the source

Parameter Description

Gain Gain of the source 

                         

Voltage-controlled Current-controlled

Voltage-controlled Current-controlled

Variable-gain 

Variable-gain

vin1 vin2

vin1 vin2

Current-controlled 

Current-controlled 

voltage-controlled

voltage-controlled

(flowing through)

(flowing through)

vo k vin2⋅( ) vin1⋅=

io k vin2⋅( ) vin1⋅=
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Input 1 is on the side with the multiplication sign, and Input 2 is on the side with the letter k.

The difference between a variable-gain controlled source and a nonlinear source with multiplication is that, for
the nonlinear source with multiplication, values of both vin1 and vin2 at the current time step are used to
calculate the output and are updated in each iteration. But for the variable-gain controlled source, it is assumed
that the change of vin2 is small from one time step to the next, and the value of vin2 at the previous time step is
used at the current time step. This assumption is valid as long as vin2 changes at a much slower rate as compared
to vin1 and the time step is small as compared to the change of vin2. Variable-gain controlled sources can be used
in circuits which may otherwise have convergence problem with nonlinear sources with multiplication.

Example:
The circuits below illustrates the use of current controlled voltage sources. In the circuit on the left, the voltage
source is controlled by the inductor current is. With a gain of 1, the waveform of the voltage vis is equal to that
of is. In this way, a current quantity can be converted to a voltage quantity.

The circuit on the right is equivalent to that on the left, except that a different current controlled source is used
instead.

4.2.12 Nonlinear Voltage-Controlled Sources
The output of a nonlinear voltage-controlled source is either the multiplication, division, or square-root of the
inputs. They are defined as:

Nonlinear (multiplication): Output  or  

Nonlinear (division): Output  or

Nonlinear (square-root): Output or 

Nonlinear (power): Output 

In the nonlinear power source, the term sign(vin) is 1 if vin is positive, and it is -1 if vin is negative.

Note that these nonlinear sources can be used in the power circuit only. 

Images:

                         

Vis

is

Vis

is

vo k vin1 vin2⋅ ⋅= io k vin1 vin2⋅ ⋅=

vo k
vin1

vin2
--------⋅= io k

vin1

vin2
--------⋅=

vo k vin1⋅= io k vin1⋅=

vo sign vin( ) k k1 vin⋅( )
k2⋅ ⋅=

Multiplication Division Square-root

vin1 vin2

vin2vin1

Power
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Attributes:
For all the sources except the nonlinear power source: 

For the nonlinear power source: 

For the nonlinear (division) source, Input 1 is on the side of the division sign. 

4.3  Voltage/Current Sensors
Voltage/current sensors measure the voltages/currents of the power circuit and send them to the control circuit.
The current sensor has an internal resistance of 1 μΩ.

Images:

Attribute:

4.4  Probes and Meters
Probes and meters are used to measure voltages, currents, power, or other quantities. 

Below find the images of the ac ammeter, dc ammeter, voltage probe, current probe, ac voltmeter, dc voltmeter,
single-phase and 3-phase wattmeters and kilowatt hour (kWh) meters, VAR meters, and VA-Power Factor
meters. A voltage probe measures a node voltage with respect to ground. A two-terminal voltage probe
measures the voltage between two nodes. A current probe or meter measures the current flowing into the meter
from the dotted side. Similarly, a power meter measures the power flowing into the meter from the dotted side.
Note that all the probes and meters, except the node-to-ground probe, are allowed in the power circuit only.

While voltage/current probes measure the instantaneous voltage or current, meters measure the dc or ac
quantities. A small resistor of 1 μΩ is used in the current probe internally to measure the current.

Parameter Description

Gain Gain k of the source 

Parameters Description

Gain Gain k of the source

Coefficient k1 Coefficient k1

Coefficient k2 Coefficient k2

Parameter Description

Gain Gain of the sensor

Current SensorVoltage Sensor
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Images:

Attributes:

In the images for the single-phase/3-phase wattmeter / kWh meter, the node with the letter "W" is for the real
power output, in watt, and the node with the letter "kWh" is for the kilowatt hour output, in kilowatt-hour. 

A low-pass filter is used in the dc meter and wattmeter models to filter out high-frequency components,
whereas a high-pass filter is used in the ac meter models to filter out the dc component. The cut-off frequency
determines the transient response of the filter. 

Except the voltage and current probes, the readings of all the meters are meaningful only when the readings
reach the steady state.

The single-phase and 3-phase VAR meter measure the reactive power (VAR) at the fundamental frequency; and
the VA-Power Factor meters measure the apparent power (VA), the total power factor (PF), and the
displacement power factor (DPF). The kilowatt hour meter reading gives the integration of the real power over
a time interval defined by the start time and the stop time. 

For a single-phase circuit, the real power P, reactive power Q, apparent power S, total power factor PF, and the
displacement power factor DPF are defined as follows.

Assume both the voltage and current contains harmonics, i.e.

where ω1 is the fundamental frequency and all others are harmonic frequencies. We have the rms values of the

Parameters Description

Operating Frequency Operating frequency or fundamental frequency of the ac meter, in Hz 

Cut-off Frequency Cut-off frequency of the low-pass/high-pass filter, in Hz

kWh Meter Start Time Time from which the kilowatt hour meter starts, in sec. (for W/kWh meters only)

kWh Meter Stop Time Time at which the kilowatt hour meter stops, in sec. (for W/kWh meters only)

VA Display Flag Display flag for apparent power (0: no display; 1: display) (for VA-Power Factor 
meters only)

PF Display Flag Display flag for power factor (0: no display; 1: display) (for VA-Power Factor 
meters only)

DPF Display Flag Display flag for displacement power factor (0: no display; 1: display) (for VA-
Power Factor meters only)

AC VoltmeterDC Voltmeter AC AmmeterDC Ammeter

Wattmeter / VAR Meter
3-ph Wattmeter

3-ph VAR Meter

Voltage Probe Current Probe

VA-Power Factor Meter 3-ph VA - 

a

b

c

a

b

c

kWh Meter / kWh Meter Power Factor Meter

v t( ) 2V1 ω1t φ1+( )sin 2V2 ω2t φ2+( )sin ...+ +=

i t( ) 2I1 ω1t θ1+( )sin 2I2 ω2t θ2+( )sin ...+ +=
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voltage and current as:

The real power (or average power) P is defined as:

where T is the fundamental period. 

The reactive power Q is defined as:

Note that the reactive power is for the fundamental component only. 

The apparent power S is defined as:

The total power factor PF and the displacement power factor DPF are then defined as follow:

For the three-phase circuit, the definitions are similar. Note that the 3-phase VA-Power Factor meter is for the 3-
phase 3-wire circuit, and the summation of the three phase voltages or currents must be equal to zero, that is: 

To use the single-phase or three-phase wattmeter/VAR meters, insert the meters into the circuit. 

Example:
This example shows how single-phase and three-phase meters are used. The circuit on the left shows the use of
the wattmeter and VAR meter, and the circuit on the right shows the use of the three-phase wattmeter and VAR
meter.

4.5  Voltage/Current Scopes
While voltage/current probes and meters save the simulation results for post waveform processing, voltage/
current scopes allow users to view simulation waveforms at runtime in the middle of the simulation.

Three scopes are provided: 1-channel voltage scope, 2-channel voltage scope, 4-channel voltage scope, and
current scope. 

Below are the images of the voltage and current scopes and their expanded view.

Vrms V1
2 V2

2 ...+ +=

Irms I1
2 I2

2 ...+ +=

P 1
T
--- v t( ) i t( )⋅( ) td

0

T

∫=

Q V1 I1 φ1 θ1–( )sin⋅ ⋅=

S Vrms Irms⋅=

PF P
S
---=

DPF φ1 θ1–( )cos=

va vb vc+ + 0=
ia ib ic+ + 0=
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The 1-channel and 4-channel voltage scope and the current scope have the same interface. For the 4-channel
scope, the channel can be selected through the drop-down channel selection, and the settings apply that the
channel selected.

The scope is designed to operate in a similar way as the actual oscilloscope in the lab. It has 3 main sections:
Timebase section, Channel section, and Trigger section.

In the Timebase section, the scale of time (x axis) is defined.

In the Channel section, the scale of the Y axis, as well as the offset and the color of the waveform, are defined.
The channel display mode can be either DC, AC, or Gnd (for ground). When the display mode is in DC, the
entire waveform is displayed. If the display mode is in AC, only the ac portion of the waveform is displayed.
When the display mode is Gnd, the waveform will show 0.

In the Trigger section, the trigger conditions are defined. The trigger can be set to either ON or OFF. When the
trigger is off, the waveform is free-running, and the display of the waveform in the scope may vary from one
frame to another. If the trigger is on, the waveform display will only start when the trigger conditions are met.
This will lead to a steady waveform display.

There are three trigger modes: rising-edge triggering, falling-edge triggering, and one-shot triggering (if the
once checkbox is checked, the one-shot triggering is selected). The one-shot triggering will trigger only once,
and it is useful, for example, in situations where a transient needs to be captured.

The trigger level sets the level at which the triggering occurs. For example, if Channel A is selected with the
rising-edge triggering and the trigger level of 0V, whenever the Channel A input crosses over 0 from negative to
positive, triggering will occur and the waveform display will start from that instant.

On the scope, if the Auto scale checkbox is checked, the scale of all the channels will be automatically adjusted
so that the waveforms are within the display of the scope. 

Note that voltage scopes have connecting terminals which can be connected to either power circuit nodes or
control circuit nodes. The scopes will display the node-to-ground voltages at these nodes.

The current scope, on the other hand, has no connecting terminals. It is associated with any element that has the
parameter of the current flag, and it is enabled by right clicking on top of the element, and selecting the branch
current under the Current Scopes, as shown below. After the branch current is selected, a check mark will
appear in front of the branch current name. 

A B DCA B

1-channel, 2-channel, and 4-channel voltage scopes Current scope

Interface for current scope, and Interface for 2-channel scope 1-channel and 4-channel voltage scopes
Chapter 4: Other Components 149



If the element has multiple current flags, under the Current Scopes menu, there will be multiply branch currents,
one corresponding to each current flag. 

For example, for a 3-phase resistor R1, under the Current Scopes menu, there will be three branch currents:

I(R1) A
I(R1) B
I(R1) C

The letter "A", "B", and "C" refer to Channel A, B, and C, respectively. For example, if  "I(R1) A", "I(R1) B",
and "I(R1) C) are all selected, in the current scope, one can go to the Channel pull-down menu in the Channel
section, and select one of the channels for display. If Channel A is selected, the scope will show the Phase A
branch current I(R1). 

4.6  Initial Values
The initial node voltages of the power circuit and control circuit can be defined using this block. 

Image:

Attribute:

Parameter Description

Initial Value Initial value of the node voltage
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4.7  Switch Controllers
A switch controller has the same function as a switch gate/base drive circuit in an actual circuit. It receives the
input from the control circuit, and controls switches in the power circuit. One switch controller can control
multiple switches simultaneously. 

4.7.1  On-Off Switch Controller
On-off switch controllers are used as the interface between control gating signals and power switches. The
input, which is a logic signal (either 0 or 1) from the control circuit, is passed to the power circuit as the gating
signal.

Image:

Example:
The circuit below implements the step change of a load. In the circuit, the on-off switch controller is used to
control the bi-directional switch. The step voltage source, which is connected to the controller input, changes
from 0 to 1 at the time of 12 ms. The closure of the switch results in the short-circuit of the resistor across the
switch and the increase of the current.

4.7.2  Alpha Controller
An alpha controller is used for delay angle control of thyristor switches or bridges. There are three input for the
controller: the alpha value, the synchronization signal, and the gating enable/disable signal. The transition of the
synchronization signal from low to high (from 0 to 1) provides the synchronization and this corresponds to the
moment when the delay angle alpha equals zero. A gating with a delay of alpha degrees is generated and sent to
the thyristors. The alpha value is updated instantaneously.

Image: 

Attributes:

Parameters Description

Frequency Operating frequency of the controlled switch/switch module, in Hz

Pulse Width On-time pulse width of the switch gating, in deg.

On-off
Controller

Enable/Disable

alphaSynchronization Signal
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The input for the delay angle alpha is in deg. 

Example: 
The figure below shows a thyristor circuit using delay angle control. In the circuit, the zero-crossing of vs,
which corresponds to the moment that the thyristor would start conducting naturally, is used to provide the
synchronization. The delay angle is set at 30o. The gating signal is delayed from the rising edge of the
synchronization signal by 30o.

4.7.3  PWM Lookup Table Controller
There are four input signals in a PWM lookup table controller: the modulation index, the delay angle, the
synchronization signal, and the gating enable/disable signal. The gating pattern is selected based on the
modulation index. The synchronization signal provides the synchronization to the gating pattern. The gating
pattern is updated when the synchronization signal changes from low to high. The delay angle defines the
relative angle between the gating pattern and the synchronization signal. For example, if the delay angle is 10
deg., the gating pattern will be leading the synchronization signal by 10 deg. 

Image: 

Attributes:

A lookup table, which is stored in a file, contains the gating patterns. It has the following format:

n, m1, m2, ..., mn
k1
G1,1, G1,2, ..., G1,k1
... ... ...

Parameters Description

Frequency Switching frequency, in Hz

Update Angle Update angle, in deg., based on which the gatings are internally updated. If the 
angle is 360o, the gatings are updated at every cycle. If it is 60o, the gatings are 
updated at every 60o.

File Name Name of the file storing the PWM gating pattern

vs

vsync

iRL1

Enable/Disable

Mod. 
Index

Sync.Delay
SignalAngle
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kn
Gn,1, Gn,2, ..., Gn,kn

where n is the number of gating patterns; mi is the modulation index correspondent to Pattern i; and ki is the
number of switching points in Pattern i. The modulation index array m1 to mn should be monotonically
increasing. The output will select the ith pattern if the input is smaller than or equal to mi. If the input exceeds
mn, the last pattern will be selected.

The following table shows an example of a PWM pattern file with five modulation index levels and 14
switching points.

5, 0.901, 0.910253, 0.920214, 1.199442, 1.21
14
7.736627   72.10303   80.79825   99.20176   107.8970   172.2634   180. 
187.7366   252.1030   260.7982   279.2018   287.8970   352.2634   360.
14
7.821098   72.27710   80.72750   99.27251   107.7229   172.1789   180.
187.8211   252.2771   260.7275   279.2725   287.7229   352.1789   360.
14
7.902047   72.44823   80.66083   99.33917   107.5518   172.0979   180.
187.9021   252.4482   260.6608   279.3392   287.5518   352.0980   360.
14
10.186691   87.24225   88.75861   91.24139   92.75775   169.8133   180.
190.1867   267.2422   268.7586   271.2414   272.7578   349.8133   360.
14
10.189426   87.47009   88.97936   91.02065   92.52991   169.8106   180.
190.1894   267.4701   268.9793   271.0207   272.5299   349.8106   360.

In this example, if the modulation index input is 0.8, the controller will select the first gating pattern. If the
modulation index is 0.915, the controller will select the third pattern.

Example: 
This example shows a three-phase voltage source inverter (file: “vsi3pwm.sch”). The PWM for the converter
uses the selected harmonic elimination. The gating patterns are described above and are pre-stored in File
“vsi3pwm.tbl”. The gating pattern is selected based on the modulation index. The waveforms of the line-to-line
voltage and the three-phase load currents are shown below.
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4.8  Function Blocks

4.8.1  Control-Power Interface Block
A control-power interface block passes a control circuit value to the power circuit. It is used as a buffer between
the control and power circuit. The output of the interface block is treated as a constant voltage source when the
power circuit is solved. With this block, some of the functions that can only be generated in the control circuit
can be passed to the power circuit.

Image: 

Example: A Constant-Power Load Model
In a constant-power dc load, the voltage V, current I, and power P have the relationship as P=V*I. Given the
voltage and the power, the current can be calculated as I=P/V. This can be implemented using the circuit as
shown below. 

The load voltage is measured through a voltage sensor and is fed to a divider. The output of the divider gives the
current value I. Since the voltage could be zero or a low value at the initial stage, a limiter is used to limit the
current amplitude. This value is converted into the load current quantity through a voltage-controlled current
source. 

Example: 
The following circuit illustrates how a control circuit signal can be passed to the power circuit. As seen from the
power circuit, the CTOP block behaviors as a grounded voltage source. 

4.8.2  Transformation Blocks
Function blocks of the following transformations are provided: 

- abc-dqo transformation 
- abc-αβ transformation 
- αβ-dq transformation 
- Cartesian-polar transformation 

All these blocks can be used in either power circuit or control circuit. 

P

IV

k=1

LOAD

Control Circuit Power Circuit
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4.8.2.1  abc-dqo Transformation
The abc-dqo function blocks perform the transformation between the abc coordinate and the dqo coordinate.

Images:

The angle θ at the bottom of the blocks is in rad.

It should be noted that, in power circuit, currents must first be converted into voltage quantities (using current-
controlled voltage sources) before they can be transformed. Also, if an input terminal is not used (such as in the
dqo-to-abc transformation block where only Phase d and q are not used, and Phase o is not used), it must be
connected to ground.

The transformation equations from abc to dqo are:

The transformation equations from dqo to abc are:

Example:
In this example, three symmetrical ac waveforms are transformed into dqo quantities. The angle θ is defined as
θ = ωt where ω = 2π*60. Since the angle θ changes linearly with time, a piecewise linear voltage which has a
ramp waveform is used to represent θ. The simulation waveforms show the three-phase ac (top), the angle θ
(middle), and the dqo output. In this example, the “q” component is constant, and both the “d” and the “o”
components are zero. 

abc to dqo dqo to abc

θ θ

vd

vq

vo

2
3
---

θcos θ 2π
3

------–⎝ ⎠
⎛ ⎞cos θ 2π

3
------+⎝ ⎠

⎛ ⎞cos

θsin θ 2π
3

------–⎝ ⎠
⎛ ⎞sin θ 2π

3
------+⎝ ⎠

⎛ ⎞sin

1
2
--- 1

2
--- 1

2
---

va

vb

vc

⋅ ⋅=

va

vb

vc

θcos θsin 1

θ 2π
3

------–⎝ ⎠
⎛ ⎞cos θ 2π

3
------–⎝ ⎠

⎛ ⎞sin 1

θ 2π
3

------+⎝ ⎠
⎛ ⎞cos θ 2π

3
------+⎝ ⎠

⎛ ⎞sin 1

vd

vq

vo

⋅=
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4.8.2.2  abc-αβ Transformation
The abc-αβ function blocks perform the transformation between the abc coordinate and the αβ coordinate.

Images:

In the images, the letter "al" refers to α, and the letter "be" refers to β.

The transformation equations are:

From abc to αβ:

From ab to αβ:

From ac to αβ:

From αβ to abc:

For the ab-to-αβ and ac-to-αβ transformation, it is assumed that va + vb + vc = 0.

abc to αβ ab to αβ ac to αβ αβ to abc  

vα

vβ

2
3
---

1 1
2
---– 1

2
---–

0 3
2

------- 3
2

-------–

va

vb

vc
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vα

vβ

3
2
--- 0

2
2

------- 2
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vb

⋅=

vα

vβ

3
2
--- 0

2
2

-------– 2–

va

vc

⋅=

va
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vc

2
3
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1 0

1
2
---– 3

2
-------

1
2
---– 3

2
-------–

vα

vβ
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4.8.2.3  αβ-dq Transformation
The αβ-dq function blocks perform the transformation between the αβ coordinate to the dq coordinate.

Images:

In the images, the letter "al" refers to α, and the letter "be" refers to β.

The transformation equations are:

From αβ to dq:

From dq to αβ:

4.8.2.4  Cartesian-Polar Transformation
The Cartesian-polar function blocks perform the transformation between the Cartesian coordinate and the polar
coordinate.

Images:

In the images, the letter "r" refers to the amplitude, and the letter "a" refers to the phase angle θ. The angle is in
rad.

The transformation equations are:

From Cartesian to polar:

From polar to Cartesian:

4.8.3  Math Function Blocks

dq to αβαβ to dq  

θ θ

vd

vq

θcos θsin
θsin– θcos

vα

vβ

⋅=

vα

vβ

θcos θsin–
θsin θcos

vd

vq

⋅=

Polar to CartesianCartesian to polar 

r x2 y2+=

θ y
x
--⎝ ⎠

⎛ ⎞atan=

x r θcos⋅=

y r θsin⋅=
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The output of a math function block is expressed as the mathematical function of the inputs. With this block,
one can implement complex and nonlinear relationship easily. Blocks with 1, 2, 3, 5, and 10 inputs are provided.

Images: 

Attributes:

The derivative df/dxi can be set to zero. 

The variables that are allowed in the expression are: T or t for time, and xi (i from 1 to n) which represents the ith
input. For example, for the 3-input math function block, the allowed variables are: T, t, x1, x2, and x3. For the 1-
input math function block, the variable x, which refers to the only input, is also allowed.

4.8.4  Lookup Tables
There are three types of lookup tables: one-dimensional lookup table, 2-dimensional lookup table with integer
inputs, and 2-dimensional lookup table with floating-point inputs. 

All three types of lookup tables can be used in both power circuit and control circuit.

Images:

Attribute:

For the 2-dimensional lookup table block, the node at the left is for the row index input, and the node at the top
is for the column index input.

The one-dimensional lookup table has one input and one output. Two data arrays, corresponding to the input
and the output, are stored in the lookup table in a file. The format of the table is as follows.

Vin(1), Vo(1)
Vin(2), Vo(2)
...
Vin(n), Vo(n)

Parameters Description

Expression 
f(x1,x2,...,xn)

Expression of the output versus inputs where n is the number of inputs

Expression df/dxi Expression of the derivative of the function f versus the ith input

Parameter Description

File Name Name of the file storing the lookup table

1-input 2-input 3-input 5-input 10-input

1-dimensional 2-dimensional

Index i

Index j
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The input array Vin must be monotonically increasing. Between two points, linear interpolation is used to obtain
the output. When the value of the input is less than Vin(1) or greater than Vin(n), the output will be clamped to
Vo(1) or Vo(n).

The 2-dimensional lookup table with integer input has two inputs. The output data is stored in a 2-dimensional
matrix. The two input correspond to the row and column indices of the matrix. For example, if the row index is
3 and the column index is 4, the output will be A(3,4) where A is the data matrix. The data for the lookup table
are stored in a file and have the following format:

m, n
A(1,1), A(1,2), ..., A(1,n)
A(2,1), A(2,2), ..., A(2,n)
... ... ...
A(m,1), A(m,2), ..., A(m,n)

where m and n are the number of rows and columns, respectively. Since the row or the column index must be an
integer, the input value is automatically converted to an integer. If either the row or the column index is out of
the range (for example, the row index is less than 1 or greater than m), the output will be zero.

The 2-dimensional lookup table with floating-point inputs is similar to the 2-dimensional lookup table with
integer inputs. The difference is that in this case, inputs are floating-point values, and interpolation is used to
calculate the output.

The data for the lookup table are stored in a file and have the following format:

m, n
Vr,1 Vr,2 ... Vr,m
Vc,1 Vc,2 ... Vc,n
A(1,1), A(1,2), ..., A(1,n)
A(2,1), A(2,2), ..., A(2,n)
... ... ...
A(m,1), A(m,2), ..., A(m,n)

where m is the number of rows and n is the number of columns; Vr is the row vector and Vc is the column
vector; and A(i,j) is the output value at Row i and Column j. Note that Vectors Vr and Vc must be monotonically
increasing.

If the input falls between two points, interpolation is used to calculate the value. If the input is less than the
minimum or greater than the maximum value, the input will be set to be the same as the minimum or maximum
value.

Examples: 
The following shows a one-dimensional lookup table:

1., 10.
2., 30.
3., 20.
4., 60.
5., 50.

If the input is 0.99, the output will be 10. If the input is 1.5, the output will be =20. 

The following shows a 2-dimensional lookup table with integer inputs:

3, 4
1., -2., 4., 1.
2., 3., 5., 8.

10 1.5 1–( ) 30 10–( )⋅
2 1–

------------------------------------------------+
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3., 8., -2., 9.

If the row index is 2 and the column index is 4, the output will be 8. If the row index is 5, regardless of the
column index, the output will be 0. 

The following shows a 2-dimensional lookup table with floating-point inputs:

3, 4
1.1  2.2  3.3
1.2  2.3  3.4  4.5
1., -2., 4., 1.
2., 3., 5., 8.
3., 8., -2., 9.

If the row input is 2 and the column input is 3, the following table shows the four points that enclose the input
point, and the output value of 3.826 through interpolation:

4.8.5  C Block
The C block allows users to enter C code directly without compiling the code, unlike in the case of external
DLL blocks where users need to compile the code into a DLL using a compiler. The code of the C block will be
interpreted and executed at runtime by a built-in C interpreter in PSIM. 

This block makes it very easy to support custom C codes, and to define and modify the functionality of the
block.

The interface of the C block dialog window is shown below.

In the Number of Input/Output Ports section, the number of input and output ports of the ports is defined. After
the number of ports is changed, the image of the block in the schematic will change accordingly.

In the Function Type section, there are four choices: 

Variable/Function Definitions: For includes statements and global variable definition.
OpenSimUser Fcn: The function that is called only once at the beginning of the simulation for

initialization.
RunSimUser Fcn: The function that is called at each simulation step.
CloseSimUser Fcn: The function that is called only once at the end of the simulation for

termination.

When one of the choices is selected, the area underneath shows the corresponding code. The complete code
consists the combined code of all the four parts. 

Column

2.3 3 3.4

1.1 -2 4

Row 2 2.091 3.826 4.818

2.2 3 5
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Click on the Check Code button to check if the code has any compiling errors. Click on the Edit Image button
to customize the image of the C block.

For example, assume that a C block has 2 inputs and 3 outputs. After numbers of input/output ports are defined,
the C block will have an image in PSIM as follows:

The node sequence is from the top to the bottom. 

In the C code, the in array is used to pass the values from PSIM into the C block, and the out array is used to
pass the values from the C block back to PSIM. In this example, the first input, which corresponds to in[0] in
the C code, is the node at the top left, and the first output, which corresponds to out[0] in the C code, is at the
top right. 

The difference between the C block and the external DLL block is that, even though the C block is easier to use,
it does have the disadvantage that the custom code in the C block can not be debugged, while in the external
DLL block it is possible to set break points and trace/step through the code for debugging.

4.8.6  Simplified C Block
The simplified C block is a special case of the C block. Unlike the C block that contains a variable/function
definition section and three functions, the simplified C block contains only the C code that is called and ran at
every time step, corresponding to the code for the RunSimUser function.

The interface of the simplified C block dialog window is shown below.

Area for
custom code

Function
selection

Input/output
ports

2-input / 3-output

in[0]

in[1]

out[0]

out[2]

out[1]

input output
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In the Number of Input/Output Ports section, the number of input and output ports of the ports is defined. After
the number of ports is changed, the image of the block in the schematic will change accordingly.

Variables that can be used in the code include: 

t: Time passed from PSIM
delt: Time step passed from PSIM
x1, x2, ... : Inputs 1, 2, etc.
y1, y2, ... : Outputs 1, 2, etc.

Unlike the C block, the simplified C block can be used for automatic code generation. 

4.8.7  External DLL Blocks
An external DLL (dynamic link library) block allows users to write code in C/C++, compile it into DLL using
Microsoft Visual C/C++, and link it with PSIM. These blocks can be used in either the power circuit or the
control circuit.

A DLL block receives values from PSIM as inputs, performs the calculation, and sends the results back to
PSIM. PSIM calls the DLL routine at each simulation time step. However, when the inputs of the DLL block
are connected to one of these discrete elements (zero-order hold, unit delay, discrete integrators and
differentiators, z-domain transfer function blocks, and digital filters), the DLL block is called only at the
discrete sampling times.

Two types of DLL blocks are provided: Simple DLL Block and General DLL Block. The simple DLL block has
a fixed number of inputs and outputs, and the DLL file name is the only parameter that needs to be defined. On
the other hand, the general DLL block allows users to define arbitrary number of inputs/outputs and additional
parameters. Users can also customize the DLL block image. 

The simple DLL block is easier to program and use.

Simple DLL blocks with 1 input/out up to 25 inputs/outputs are provided. The images and parameters of DLL
blocks with 1, 3, and 6 inputs/outputs are shown below. 

Area for
custom code

Input/output
ports
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Images: 

Attribute:

The node with a dot is for the first input (in[0]). The sequence of the input/output nodes is from the top to the
bottom.

The images and parameters of a general DLL block are shown below. 

Image (for a block with 2 inputs and 3 outputs): 

Attribute:

The node with a dot is for the first input (in[0]). The sequence of the input/output nodes is from the top to the
bottom.

By default, users define the number of inputs and outputs. But the number of inputs and outputs, the node
names, as well as the number of parameters and the parameter names can all be defined inside the DLL routine.

Parameter Description

File Name Name of the DLL file

Parameter Description

DLL File Name of the DLL file

Input Data File Name of the input data file that DLL reads (optional)

Number of Input 
Nodes

Number of input nodes (optional)

Number of Output 
Nodes

Number of output nodes (optional)

IN Nodes List of input nodes (optional)

OUT Nodes List of output nodes (optional)

Parameter 1 Parameter to be passed from PSIM into DLL (optional)

Parameter 2 Parameter to be passed from PSIM into DLL (optional)

Edit Image (button) Click this button to edit and customize the image of the DLL block.

Display File (button) Click this button to display the content of the Input Data File (optional).

Read File (button) If the Input Data File is modified, click this button to reload the data file 
(optional).

1-input 3-input 6-input

1

3

1

3

22

input output

1 1

6 6

1 1

3

2
2

input output
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For more details on defining and programming for the general DLL block, please refer to the help file "Help
General DLL Block.pdf" and related examples.

The name of the DLL file can be arbitrary. The DLL file can be placed in one of the two places, in the order of
precedence: in the PSIM directory, and in the same directory as the schematic file that uses the DLL file.

Note: When a DLL file is used in multiple DLL blocks in a schematic, if global or static variables are declared
and used in the DLL code, these global/static variables will be the same and be shared among all the DLL
blocks. If this is not what users intended, the DLL calculation can be incorrect, and users should avoid using
global/static variables in the code in this case.

Several examples using the simple DLL blocks and the general DLL blocks are provided in the
"examples\custom DLL" sub-folder in the PSIM directory.

4.8.8  Embedded Software Block
The Embedded Software Block is a special type of the external DLL blocks. It is intended for modeling
embedded software devices such as microcontrollers and DSP.

Attribute:

The Embedded Software Block has similar functionality as the general external DLL block. However, unlike
the general DLL block whose connection nodes are predefined as either inputs or outputs, the Embedded
Software Block allows the node types to be programmed as needed.

Also, additional information, such as the exact instant at which the state of a variable changes, can be calculated
and passed to and from PSIM. 

The Embedded Software Block is a control circuit element, and can be used in the control circuit only.

For more information on how to use the Embedded Software Block, please refer to the document "Help
Embedded Software Block.pdf".

Parameter Description

DLL File Name of the DLL file that defines the functionality and the interface of the block

Number of Nodes Total number of input and output nodes 
164    Chapter 4: Other Components



5
  Analysis Specification

5.1  Simulation Control
The Simulation Control element defines parameters and settings related to simulation.

To place the Simulation Control element, go to the Simulate menu in PSIM, and select Simulation Control.
The Simulation Control element has the image of a clock.

In the Parameters tab of the Simulation Control dialog window, the following parameters are defined for the
transient simulation. 

In the SimCoder tab of the dialog window, comments can be entered and these comments will be inserted at the
beginning of the automatically generated code. Note that this is for SimCoder only. 

In the Color tab of the dialog window, the color of the Simulation Control element can be changed. 

With the SAVE and LOAD functions, the circuit voltages, currents and other quantities can be saved at the end
of a simulation session, and loaded back as the initial conditions for the next simulation session. This provides
the flexibility of running a long simulation in several shorter stages with different time steps and parameters.
Components values and parameters of the circuit can be changed from one simulation session to the other. The
circuit topology, however, must remain the same.

Time Step Simulation time step, in sec. 

Total Time Total simulation time, in sec. 

Free Run 
checkbox

When the Free Run checkbox is not checked, the simulation will run up to the Total Time 
and then stop. But when it is checked, the simulation will run in the free-run mode and it 
will keep on running until manually stopped.
In the free-run mode, voltage/current scopes can be used to monitor and display voltages 
and currents in the middle of the simulation.

Print Time Time from which simulation results are saved to the output file. No output is saved 
before this time. 

Print Step Print step. If it is set to 1, for example, every data point will be saved to the output file. If 
it is set to 10, only one out of 10 data points will be saved. This helps to reduce the 
output file size.

Load Flag Flag for the LOAD function. If the flag is 1, the previous simulation values will be 
loaded from a file (with the “.ssf” extension) as the initial conditions.

Save Flag Flag for the SAVE function. If the flag is 1, values at the end of the current simulation 
will be saved to a file with the “.ssf” extension.

Hardware Target This is for SimCoder only, for specifying hardware target for automatic code generation. 
The hardware target can be one of the following:
    - None:                        No hardware target
    - TI F28335:                TI F28335 Hardware Target
    - PE-Pro/F28335:        PE-Pro/F28335 Hardware Target
    - PE_Expert3:              PE-Expert3 Hardware Target
    - General_Hardware:    General Hardware Target
 For PE-Expert3 hardware, set the PE-View version as either PE-View8 or PE-View9 
through the drop-down box. 
For more information, please refer to SimCoder User’s Manual.
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In PSIM, the simulation time step is fixed throughout the simulation. In order to ensure accurate simulation
results, the time step must be chosen properly. The factors that limit the time step in a circuit include the
switching period, widths of pulses or waveforms, and intervals of transients. It is recommended that the time
step should be at least one magnitude smaller than the smallest of the above. 

Also, an interpolation technique is implemented which will calculate the exact switching instants. With this
technique, the error due to the misalignment of switching instants and discrete simulation points is significantly
reduced. It is possible to simulate with a large time step while still maintaining accurate results.

The allowable maximum time step is automatically calculated in PSIM. It is compared with the time step set by
the user, and the smaller value of the two will be used in the simulation. 

5.2  AC Analysis
The frequency response of a circuit or a control loop can be obtained with the ac analysis. A key feature of the
ac analysis in PSIM is that, a circuit can be in its original switchmode form, and no average model is required.
Nevertheless, with the average model, the time it takes to perform the ac analysis will be shorter. 

The following are the steps to set up the ac analysis:

- Identify a sinusoidal voltage source as the excitation source for the ac sweep. 

- Place ac sweep probes at the desired output location. To measure the loop response of a closed control
loop, use the node-to-node probe. 

- Place the AC Sweep block on the schematic, and define the parameters of the ac sweep. 

- Run the simulation.

Below are the images of the ac sweep probes and the AC Sweep block.

Images:

Attributes:

The principle of the ac analysis is that a small ac excitation signal is injected into the system as the perturbation,
and the signal at the same frequency is extracted at the output. To obtain accurate ac analysis results, the

Parameters Description

Start Frequency Start frequency of the ac sweep, in Hz

End Frequency End frequency of the ac sweep, in Hz

No. of Points Number of data points

Flag for Points Flag to define how the data points is generated.
Flag = 0: Points are distributed linearly in LOG10 scale
Flag = 1: Points are distributed linearly in linear scale

Source Name Name of the excitation source

Start Amplitude Excitation source amplitude at the start frequency

End Amplitude Excitation source amplitude at the end frequency

Freq. for extra Points Frequencies of additional data points. If the frequency-domain characteristics 
change rapidly at a certain frequency range, one can add extra points in this region 
to obtain better data resolution.

AC SweepAC Sweep Probe AC Sweep Probe (loop)
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excitation source amplitude must be set properly. The amplitude must be small enough so that the perturbation
stays in the linear region. On the other hand, the excitation source amplitude must be large enough so that the
output signal is not affected by numerical errors. 

In general, a physical system has low attenuation in the low frequency range and high attenuation in the high
frequency range. A good selection of the excitation source amplitude would be to have a relatively small
amplitude at the low frequency, and a relatively large amplitude at the high frequency.

Sometimes, after ac analysis is complete, a warning message is displayed as follows:
Warning: The program did not reach the steady state after 60 cycles. See File “message.txt”
for more details.

This message occurs when the software fails to detect the steady state at the ac sweep output after 60 cycles. To
address this problem, one may increase damping in the circuit (by including parasitic resistances, for example),
or adjust the excitation source amplitude, or reduce simulation time step. The file “message.txt” gives the
information on the frequency at which this occurs and the relative error. The relative error will indicate how far
the data point is from reaching the steady state.

Example: Open-Loop Response of a Buck Converter
The circuit on the left is an one-quadrant buck converter. An excitation source is injected to the modulation
signal, and the output voltage is measured. The result of the ac analysis, on the right, shows the open-loop
response of the output voltage versus the modulation signal. 

Example: Loop Transfer Function of a Closed-Loop Circuit
The ac analysis can be used to find out the loop response of a closed-loop system. The circuit below shows a
buck converter with average current mode control. By injecting the excitation signal into the current feedback
path, and using the node-to-node ac sweep probe, we can obtain the loop transfer function directly. With the
loop transfer function, one can determine the bandwidth of the control loop and the phase margin. 

Please note that the ac sweep probe should be connected such that the dotted side is connected to the node after
the excitation source injection. 
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Example: Loop Transfer Function of a Switchmode Power Supply
The loop transfer function of a switchmode power supply controlled by a PWM IC can also be determined in a
similar way. The figure below shows a buck converter controlled by TI UC3842. The excitation source can be
inserted in the feedback path, before the op. amp. output. 

5.3  Parameter Sweep
Parameter sweep can be performed for the following parameters:

- Resistance, inductance, and capacitance of RLC branches

- Gain of proportional blocks 

- Time constant of integrators 

- Gain and time constant of proportional-integral controllers 

- Gain, cut-off frequency, and damping ratio of 2nd-order low-pass and high-pass filters 

- Gain, center frequency, and passing and stopping band of 2nd-order band-pass and band-stop filters 
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The image and parameters of the parameter sweep block are shown below.

Image: 

Attributes:

For example, let the resistance of a resistor be “Ro”. To sweep the resistance from 2 Ohm to 10 Ohm, with a
step of 2 Ohm, the specification will be:

The image and parameters of the parameter sweep element are shown below.

Parameter sweep will produce two plots: One is the outputs versus time, and the other is the outputs at the last
simulation point versus the swept parameter. 

For example, a circuit has two outputs V1 and V2, and the resistance Ro is swept. The total simulation time is
0.1 sec. After the simulation, there will be two plots in Simview. One is V1 and V2 versus time. The other is V1
and V2 versus Ro. The V1 and V2 values used in the second plot are the values at the last simulation point at
0.1 sec.

Parameters Description

Start Value Starting value of the parameter

End Value End value of the parameter

Increment Step Increment step

Parameter to be Swept Parameter to be swept

Start Value 2

End Value 10

Increment Step 2

Parameter to be Swept Ro
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6
  Circuit Schematic Design

PSIM’s schematic program provides interactive and user-friendly interface for circuit schematic entry and
editing. The following figure shows a boost power factor correction circuit in the PSIM environment.

In PSIM, all the elements are stored under the Elements menu. The elements are divided into four groups:
Power (for power circuit element), Control (for control elements), Other (for switch controllers, sensors,
probes, interface elements, and elements that are common to both power and control), and Sources (for voltage
and current sources). 

6.1  Creating a Circuit
The following functions are provided for circuit creation. 

Get Element There are several ways to get an element from the element library. One is to use the pull-
down menu. Go to the Elements menu, and go into the submenu and highlight the
element to be selected. 

Another is to use the Library Browser, as shown below. 
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The Library Browser provides a convenient way of navigating through the library. To
launch the Library Browser, go to View -> Library Browser. 

Also, the most recent elements are listed in the pull-down button on the

toolbar, and can be selected. 

In addition, one can select elements from the Element Toolbar. 

Place Once an element is selected from the menu, the image of the element will appear on the
screen and move with the mouse. Click the left button of the mouse to place the element. 

Select Element To select an existing element on the schematic, click on the element. A rectangle will
appear around the element. 

To select a block of a circuit, keep the left button of a mouse pressed and drag the mouse
until the rectangle covers the selected area. 

Rotate Before the element is placed, right click to rotate the element. After an element is
selected, select Edit -> Rotate to rotate the element. 

Wire To connect a wire between two nodes, select Edit -> Wire. The image of a pen will
appear on the screen. To draw a wire, keep the left button of the mouse pressed and drag
the mouse. A wire always starts from and end at a grid intersection. 

For easy inspection, a floating node is displayed as a circle, and a junction node is
displayed as a solid dot.

Label If two or more nodes are connected to the same label, they are connected. It is equivalent
as though they were connected by wire. Using labels will reduce the cross-wiring and
improve the schematic layout.

The text of a label can be moved. To select the text, left click on the label, then press the
Tab key. 

Assign To assign the parameters of an element, double click on the element. A dialog box will
appear. Specify the values and hit the <Return> key or click on OK.

Move To move an element or a circuit block, select the element/circuit block and drag the mouse
while keeping the left button pressed. 

Move Schematic To move the whole schematic, right click and drag the mouse. 
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6.2  File Menu
The following functions are provided in the File menu for various file operations: 

New To create a new schematic file. 

Open To open an existing schematic file. 

Close To close the current schematic file. 

Close All To close all schematic files. 

Save To save the current schematic file. 

Save As... To save the current schematic file to a different name. 

Save All To save all schematic files. 

Save with Password To save a schematic file so that it is protected with a password. When a file is password
protected, it can still be used in the simulation, but one needs to enter the correct password
in order to see the schematic. The password protection is used in situations where the
person who created the file needs to share it with someone else, but does not wish to
reveal the details of the schematic. 

Save in Package File To save a schematic file and all associated files to one single package file. This is
especially useful if the main circuit calls multiple subcircuits, and one needs to send the
files to someone else. Rather than finding and collecting all the subcircuit files, one can
just create the package file and send out the single package file. 

Save as Older Versions To save a file in the Version 8.0 or 7.1 format. Note that if the file uses elements that
are unique in Version 9.0, these elements will be omitted. 

Print To print the schematic. Note that the schematic is printed as it appears on the screen. If
you zoom in or out the schematic, the printout will be changed accordingly. 

Print Preview To preview the printout. 

Print Selected To print only a portion of the schematic selected. 

Print Selected Preview To preview the printout of the portion of the schematic selected. 

Print Page Setup To adjust the print page position and set the print page legend. 

Printer Setup To set up the printer. 

Exit To exit the PSIM schematic program. 

6.3  Edit Menu
The following functions are provided in the Edit menu for circuit editing: 

Undo To undo the previous change. 

Redo To go back to the state before undoing the changes. 

Cut To cut the selected circuit out of the schematic. The circuit that is cut can be pasted back.

To delete an element or a portion of the circuit, select the item and hit <Delete> key. 

Copy To copy an element or a portion of a circuit into a buffer, which can then be pasted back. 

Paste To paste back the copied element or circuit. 

Select All To select the entire schematic. 

To select only a portion of the schematic, left click and drag the mouse. 

Copy to Clipboard To copy the schematic image to the clipboard which can then be pasted back in another
software. One can choose one of the three options: Metafile Format, Color Bitmap, or
Black and White bitmap. The metafile format is vector based, and gives better image
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quality especially when the image is resized. The Black & White option will result in a
smaller image file size as compared to the color bitmap. 

Drawing To draw images on the schematic for display purposes. The following images are
provided: line, ellipse, rectangle, half-circles, and bitmap images. 

When the bitmap image option is selected, left click the mouse and drag the mouse to
define the area that will contain the bitmap image. Then select the bitmap file.

Text To place text on the screen, choose Text. Enter the text in the dialog box, and click the left
button of the mouse to place it. 

Wire To enter the wiring mode. The cursor will change to the shape of a pen.

Label To place a label on the schematic. When two nodes are connected to two labels of the
same name, they are considered physically connected. 

Attributes When an element is selected, choose Attributes to bring out the property dialog window. 

Add/Remove To add or remove the current scope for an element that has the 
Current Scope current flag. After this function is selected, click on top of the element, and select the

branch current name to display the current scope. Select the branch current name again to
remove the current scope.

Show/Hide To show or hide the parameters of elements that can be changed 
Runtime Variables at runtime in the middle of the simulation. After this is selected, the text of the parameter

will appear. Double click on the text, and a small dialog window will appear. Enter the
new value directly in the data field, and click Apply. Or alternatively, click on the up/
down arrow keys on the keyboard to increase/decrease the value. 

Disable To disable an element or part of a circuit. When the element or the circuit is disabled, it
will be grayed out and will be treated as non-existent as far as the simulation is concerned.
This function is useful if an element or circuit needs to be excluded but not deleted from
the circuit.

Enable To enable a previously disabled element or circuit.

Rotate To rotate the selected element or a portion of the circuit by 90o clockwise. 

Flip Left/Right To flip the selected element horizontally.

Flip Top/Bottom To flip the selected element vertically.

Find To find a particular element based on type and name.

Find Next To repeat the previous Find operation.

Edit Library To edit PSIM image libraries. More details are given in Section 6.9.

Escape Quit from any of the above editing modes by choosing Escape. 

6.4  View Menu
The following additional functions are provided in the View menu for circuit editing: 

Status Bar To show/hide the status bar. 

Toolbar To show/hide the toolbar. 

Element Bar To show/hide the element bar. 

Recently Used To display the drop-down list box that will list the elements
Element List recently fetched from the library. 

Library Browser To launch the Library Browser. The Library Browser is another way of accessing the
PSIM Element library. 

Zoom In To zoom in the schematic.
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Zoom Out To zoom out the schematic.

Fit to Page To adjust the zooming so that the entire schematic fits the screen.

Zoom In Selected To zoom in to the selected area. 

Element List To generate the parts list of the circuit. 

Element Count To count the number of elements. Voltage/current probes and meters are not included in
the element count. 

Refresh To refresh the screen display. 

6.5  Subcircuit Menu
Functions are provided in the Subcircuit menu for subcircuit editing and manipulation.

The following functions are to be performed in the main circuit (outside the subcircuit):

New Subcircuit To create a new subcircuit 

Load Subcircuit To load an existing subcircuit. The subcircuit will appear on the screen as a block. 

Edit Subcircuit To edit the size and file name of the subcircuit 

Display Subcircuit To display the name of a selected subcircuit in the main circuit
Name

Show Subcircuit To display the port names of the subcircuit in the main circuit 
Ports

Hide Subcircuit To hide the port names of the subcircuit in the main circuit 
Ports

Subcircuit List To list the file names of the main circuit and the subcircuits 

The following functions are to be performed inside the subcircuit:

Set Size To set the size of the subcircuit 

Place Bi-directional  To place a bi-directional connection port in the subcircuit 
Port

Place Input Signal  To place an input signal connection port in the subcircuit 
Port

Place Output Signal  To place an output signal connection port in the subcircuit 
Port

Display Port To display the connection port of the subcircuit 

Edit Default To edit the default variable list of the subcircuit. This is done 
Variable List inside the subcircuit.

Edit Image To edit the subcircuit image

One Page up To go back to the main circuit. The subcircuit is automatically saved. 

Top Page To jump from a lower-level subcircuit to the top-level main circuit. This is useful for
circuits with multiple layers of subcircuits. 

If the functions Set Size, Display Port, Edit Default Variable List, and Edit Image are performed in the main
circuit, they will be applied to the main circuit instead.

There are three types of subcircuit ports for signal interface with the main circuit: Bi-directional port for power
circuit and mechanical systems, and input signal and output signal ports for control circuit. 

Even though bi-directional ports also work for control circuit, it is strongly recommended to use input or output
signal ports for control circuit for better clarity. Furthermore, if a subcircuit is involved in code generation, only
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input or output signal ports can be used.

Right click on top of the subcircuit block, and choose Attributes to display the subcircuit property dialog
window. There are three tabs: Subcircuit Info, Subcircuit Variables, and Color.

In the Subcircuit Info Tab:

In this tab, the name of the subcircuit can be edited. click on the Change Subcircuit File button to change to a
different subcircuit. The selected subcircuit file will be loaded instead.

In the Subcircuit Variables Tab:

In this tab, variables used in the subcircuit can be edited. For example, a resistor in the circuit has the resistance
defined as "Rparasitic", and for better clarity, this resistance is referred to as "Parasitic Resistance". Also, the
resistance has a value of 1mOhm. This variable will be entered as:

Variable Description: Parasitic Resistance
Variable Name: Rparasitic
Variable Value: 1m

When the checkbox next to the line "Parasitic Resistance" is checked, in the main circuit, this variable will be
displayed as:

Parasitic Resistance = 1m

Since subcircuit variable list can be edited, the current variable list may be different from the default variable
list. One can click on the Set as Default Variables button to set the current variable list as the default list, or
click on the Reload Default Variables button to reload the default list if the default list has been modified.

Two functions are provided at the bottom of the dialog for SimCoder for automatic code generation. Click on
the Generate Code button to generate code for this subcircuit. If the checkbox Replace subcircuit with
generated code for simulation is checked, the schematic inside the subcircuit will be replaced by the generated
code for simulation.

In the Color Tab:

In this tab, the subcircuit color can be changed. 

Example: Use of Subcircuit
The circuit below illustrates the use of subcircuit. The circuit on the left is a buck converter, with the L-C filter
inside a subcircuit. The content of the subcircuit is shown on the right. 

In this example, there are two bi-directional ports ("in+" and "in-") on the left, and two bi-directional ports
("o+" and "o-") on the right.

6.5.1  Creating Subcircuit - In the Main Circuit
The following are the steps to create the subcircuit “chop_sub.sch” in the main circuit “chop.sch”.

- Open or create the main circuit “chop.sch”. 

- If the file “chop_sub.sch” does not exist, go to the Subcircuit menu, and select New Subcircuit. If the
file exists, select Load Subcircuit instead.

File: chop_sub.sch

Inside the subcircuit:

File: chop.sch

Subcircuit
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- A subcircuit block (rectangle) will appear on the screen. Place the subcircuit.

If the circuit that is to be converted into a subcircuit has already been created in the main circuit, a quick way of
converting it into a subcircuit is to select the circuit, and then right click and choose Create Subcircuit. Specify
the subcircuit file name as "chop_sub.sch", and the circuit will be converted into a subcircuit. Adjust the port
location and wire connection if necessary. 

6.5.2  Creating Subcircuit - Inside the Subcircuit
To enter the subcircuit, double click on the subcircuit block. 

- Create/edit the content of the subcircuit circuit exactly the same way as in the main circuit.

- To specify the subcircuit size, select Set Size in the Subcircuit menu. In this example, the size is set to
4x7 (width of 4 divisions and height of 7 divisions). Note that the size of the subcircuit should be
chosen such that it gives the proper appearance and allows easy wire connection in the main circuit. 

- Once the subcircuit is complete, define ports to connect the subcircuit nodes with the corresponding
nodes in the main circuit. Choosing Place Port in the Subcircuit menu, and a port image will appear.
After the port is placed in the circuit, a pop-up window (shown on the left below) will appear.

The diamonds on the four sides represent the connection nodes and the positions of the subcircuit.
They correspond to the connection nodes of the subcircuit block on the right. There are no diamonds at
the four corners since connections to the corners are not permitted. 

 When a diamond is selected, it is colored red. By default, the left diamond at the top is selected and
marked with red color. Click on the desired diamond to select and to specify the port name.

  In this example, in the main circuit “chop.sch”, there are four linking nodes, two on the left side and
two on the right side of the subcircuit block. The relative position of the nodes are that the upper two
nodes are 1 division below the top and the lower two nodes are 1 division above the bottom.

  To specify the upper left linking node, click on the top diamond of the left side, and type “in+”. The
text “in+” will be within that diamond box and a port labelled with “in+” will appear on the screen.
Connect the port to the upper left node. The same procedure is repeated for the linking nodes “in-”,
“out+”, and “out-”.

- After the four nodes are placed, the node assignment and the subcircuit appear in PSIM as shown
below. 

Subcircuit port assignments
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The creation of the subcircuit is now complete. Save the subcircuit, and go back to the main circuit. 

6.5.3  Connecting Subcircuit - In the Main Circuit
Once the subcircuit is created and connection ports are defined, complete the connection to the subcircuit block
in the main circuit. 

- In the main circuit, the connection points on the borders of the subcircuit block appear as hollow
circles.

- Select the subcircuit block, and select Show Subcircuit Ports in the Subcircuit menu to display the
port names as defined inside the subcircuit. 

- Connect the wires to the connection points accordingly. 

6.5.4  Other Features of the Subcircuit
This section describes other features of the subcircuit through the example shown below. 

6.5.4.1  Passing Variables from the Main Circuit to Subcircuit
In this example, the main circuit “main.sch” uses a subcircuit “sub.sch”. In the subcircuit, the inductance value
is defined as “L” and the capacitance is defined as “C”. The default values of L and C can be set by selecting
Subcircuit | Set Default Variable List. In this case, L is set to 5mH and C is set to 100uF. 

When the subcircuit is loaded into the main circuit the first time, this default variable list will appear in the tab
“Subcircuit Variables” in Subcircuit | Edit Subcircuit from the main circuit “main.sch”. New variables can be

File: sub.sch

Inside the subcircuit:

File: main.sch
178    Chapter 6: Circuit Schematic Design



added here and variable values can be changed. In this case, L is changed to 2mH, and C is kept the same as the
default value.

Note that the variables and the values are saved to the netlist file and used in simulation. The default variable
list inside the subcircuit is not saved to the netlist and is not used for simulation. 

This feature allows the parameters of a subcircuit to be defined at the main circuit level. In the case where the
same subcircuit is used several times in one main circuit, different parameters can be assigned to the same
variable. For example, if the subcircuit “sub.sch” is used two times in above example, in one subcircuit L can be
defined as 3mH, and in another subcircuit L can be defined as 1mH. 

Note that this example also illustrates the feature that parameters can be defined as a variable (for example
“Vin” for the input dc voltage source) or a mathematical expression (for example “R1+R2” for the load
resistance). The variables “Vin”, “R1”, and “R2”, are defined in the parameter file “para-main.txt”. See Section
4.1 for more details.

6.5.4.2  Customizing the Subcircuit Image
The following are the procedures to customize the subcircuit image of “sub.sch”: 

- In the subcircuit, select Edit Image in the Subcircuit menu. A window will pop-up, as shown below. 

In the window, the diamonds marked red are the connection nodes of the subcircuit block, in exactly
the same positions as appearing in the main circuit. 

- Use the drawing tool to create/edit the image for the subcircuit block. If the drawing tool is not already
displayed, go to the View menu and check Drawing Tools. Click on Zoom In and Zoom Out icons on
the toolbar to adjust the size of the image working area. 

After the image is created, the pop-out window will appear as follows.
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- Go back to the subcircuit window (“sub.sch” in this case), and save the subcircuit. The new subcircuit 
block image should appear in the main circuit.

6.5.4.3  Including Subcircuits in the PSIM Element List
If you create a directory called “User Defined” under the PSIM directory, and place subcircuits inside this
directory. subcircuits will appear as items in the Elements menu, under Elements | User Defined, just like any
other PSIM elements. You can also create subdirectories under the directory User Defined, and place
subcircuits inside the subdirectories. For example, the Elements menu may look like this:

- Power

- Control

- Other

- Sources

- Symbols

- User Defined

- Subcircuit 1

- Project A

- Subcircuit 2

- Subcircuit 3

- Project B

- Subcircuit 4

In this way, common-used custom-built subcircuits can be grouped together and easily managed and accessed.

6.6  Simulate Menu
The following functions are provided in the Simulate menu for running simulation:

Simulation Control  To set the simulation parameters such as time step, total time, etc. When this is selected,
the cursor will change to the image of a clock. Place this clock on the schematic, and
double click to display the property window. 

Run Simulation To run the simulation. 

Cancel Simulation To cancel the simulation that is currently in progress. 

Pause Simulation To pause the simulation that is currently in progress. 

Restart Simulation To resume a paused simulation. 

Simulate Next Time Step To run the simulation to the next time step, and pause. 

Run SIMVIEW To launch the waveform display program SIMVIEW. 

Generate Netlist File To generate the netlist file from the schematic. 

View Netlist File To view the generated netlist file. 

Show Warning To show the warning messages, if any, from the simulation. 

Arrange SLINK Nodes To rearrange the SLINK nodes. This function is for the SimCoupler Module for co-
simulation with Matlab/Simulink. Please refer to Section 3.6 for more details. 

Generate Code To generate code from the control schematic. This function is for SimCoder for automatic
code generation. Please refer to SimCoder User Manual for more details. 

Runtime Graph To select waveforms to show in the middle of a simulation run. 
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To view the simulation results in the middle of the simulation, one can either go to Simulate -> Runtime
Graphs to select the waveforms, or use the voltage/current scopes (under Elements -> Other -> Probes) to
view the waveforms.

The difference between the runtime graphs and the voltage/current scopes is that only waveforms that are saved
for display in SIMVIEW (such as voltage probes, current probes, current flags, etc.) are available for the
runtime graphs. In addition, a runtime graph display the waveform in its entirety, from the beginning to the final
study time. Because of this, the runtime graphs are disabled in the free-run mode as the final study time is
undetermined.

On the other hand, voltage/current scopes can be used in either the one-time simulation mode or in the free-run
mode. Voltage scopes can be connected to any nodes, and will display the node-to-ground voltage waveforms.
On the other hand, current scopes are available to elements that have current flags (such as R-L-C branches and
switches).

Moreover, in the free-run mode, the majority of the element parameters can be changed during runtime in the
middle of the simulation. This makes it possible to tune a circuit while inspecting key waveforms using voltage/
current scopes, until desired performance is achieved.

Running Simulation in the Free-Run Mode:

To illustrate how to run a simulation in the free-run mode, a buck converter circuit shown below is used as an
example. The circuit on the left was originally set up for the one-time simulation, with the total simulation time
set to a specific value. 

To set up the simulation in the free-run mode:

- In Simulation Control, check the Free Run checkbox.

- Go to Elements -> Other -> Scopes, and select the 2-channel voltage scope. Connect the scope as
shown above on the right.

- Double click on the scope, and the scope image will appear. Start the simulation, and the waveforms
will appear and will be updated continuously in the scope. Change the scope settings as desired.

- Elements parameters can now be adjusted in the middle of the simulation. To adjust the gain of the PI
controller, for example, right click on top of the PI block, and choose Runtime Variables -> Gain.
The text of the gain "0.6" will be displayed if it has not been displayed already.

- Click on the text "0.6", and a small dialog window will appear. The screen should look as follows.

One-time simulation Simulation in the free-run mode
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- Place the cursor inside the input field of the dialog window for the gain, and change the gain either by
pressing on the upper/down arrow keys on the keyboard, or by entering a new value and then clicking
on Apply. Watch how the waveforms change as the gain is changed.

Other parameters, such as current reference, dc input voltage, inductance, capacitance, and load
resistance, can be changed in the similar way.

- Branch currents can also be displayed in the free-run mode. To display the inductor current, for
example, right click on top of the inductor, and a menu will appear. Choose Current Scopes and the
branch current name. 

- An image of the current scope (similar to the voltage scope image, but without connection terminals)
will appear. Double click on the scope to expand and view the inductor waveform.

Below is how the window would look like with both the voltage scope and the current scope.

Other branch currents, such as capacitor current, load current, diode current, or MOSFET switch
current, can be displayed in the similar way.

Gain of the 
PI controller

Voltage scope

Current scope
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Running Simulation with the Command-Line Option:

Simulation can also be launched with the command line option by running the program PsimCmd.exe. For
example, to simulate the circuit "chop.sch" which is stored in the folder "c:\psim\examples", go to the PSIM
folder, and run the following command:

PsimCmd  -i "c:\psim\examples\chop.sch" -o "c:\psim\examples\chop.smv"

The format of the command line is as follows:

PsimCmd  -i "[input file]" -o "[output file]" -v "VarName1=VarValue1"            -v 
"VarName2=VarValue2" -t "TotalTime" -s "TimeStep" -g

Note that the quotes around the parameter values must be present. The command-line parameters are:

-i: Input schematic file name
-o: Output file name (in either .txt or .smv extension)
-v: Variable name and value. This parameter can be used multiple times. For example, to 

define the resistance R1 as 1.5 and the inductance L1 as 0.001, we have: 
         -v "R1=1.5"  -v "L1=0.001" 

-t: Total time of the simulation
-s: Time step of the simulation
-g Run SIMVIEW after the simulation is complete

With the command-line option, one can run several circuits automatically in a batch run. 

6.7  Options Menu
The following functions are provided in the Options menu for various settings:

Settings... To set the simulation parameters such as time step, total time, etc. When this is selected,
the cursor will change to the image of a clock. Place this clock on the schematic, and
double click to display the property window. 

Auto-run SIMVIEW To automatically run SIMVIEW after the simulation is complete. 

Set Path... To set the PSIM search paths and device file paths. 

Enter Password To enter the password to view a schematic file that is password protected. 

Disable Password To disable the protection of a schematic file that is password protected. 

Customize Toolbars To create customized toolbars. 

Customize KeyboardTo customize keyboard. Functions can be assigned to the keyboard for easier circuit
editing. 

Deactivate To deactivate the PSIM license. This is for softkey version only. 

Change Softkey Password To change the password of login for running PSIM softkey version. This is for
softkey version only. 

Check for Software Update To check if any newer software updates are available on the Powersim server.
This is for licenses that have the Annual Software Maintenance only. 

The following settings are defined under Settings...:

Under the General tab:

On Editing:

Display grid Check this option to display the grid in the PSIM schematic. 

Zoom factor: The zoom factor defined here is used when the schematic is zoomed in or out. 

Enable rubber band: When checked, an element or a portion of a circuit remains connected with the rest of
the circuit when moved. 
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Show print page border: When enabled, the border of the printout will be displayed.

On Text Font:

Default text font: Set the default font for the text placed in the schematic. 

Default graph font: Set the text font for the runtime graphs. 

On Simulation:

Simulation result format: Simulation results can be saved in either binary format (default) or text format. The
binary format will result in a smaller result file, and will be faster to load.Set the default
font for the text placed in the schematic. 

Output buffer size: When checked, the simulation data will be written to the result file in segment. For
example, if the buffer size is set to 20 MB, the simulation data will be first saved to the
buffer, and when it reaches 20 MB, the whole 20-MB data will be written to the result file.

Please note that the runtime graph only plots the data in the buffer. Therefore, when the
old data are saved to the file and the new data fills in the buffer, the runtime graph will
only show the waveform of the new data, and the old waveform will be lost.

To retain all the waveforms in the runtime graph, one can either increase the buffer size,
or un-check this option.

When this option is un-checked, however, PSIM will allocate all the required memory for
the buffer at the very beginning. If the simulation time step is small and the total time is
long, and if there are many output curves, a very large memory may be required, which
will take some time to allocate, and may even fail if the computer does not have sufficient
amount of memory.

Disable simulation warning messages: When this option is checked, warning messages generated in the
simulation are suppressed. 

Under the Advanced tab:

On Software Updates:

Check for software updates: When this option is checked, if you have the valid software annual maintenance,
PSIM will automatically check for new updates on the Powersim server. If a new update
is available, you will be prompted to install the update. 

On Automatic Backup:

Automatic backup: When this option is checked, PSIM will create a backup of the file currently being edited
in the time interval specified. In case of a program crash, the backup file will preserve the
previous work. The backup file is deleted automatically when the file is closed normally
from the PSIM environment. 

On Time-Out:

Idle time: When this option is checked, PSIM will be timed out after the program is idle for the
specified amount of time. Note that this applies to the PSIM network version only. 

When PSIM is timed out, the license will be released and other users will be able to check
it out. When PSIM is back from the idle state, it will try to log back in the License
Manager if a license is still available. If there is no license available, an error message will
be posted. 

This feature will prevent users from holding up licenses unintentionally. 

On Automatic Code Generation:

Show image next to elements ...: This is for SimCoder only for automatic code generation. When this option is
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checked, in the PSIM library, an image will appear next to the elements that can be used
for code generation. This is used to differentiate elements that can be used for code
generation from the ones that can not.

On PSIM Help File:

Use alternate PSIM help file path: By default, PSIM reads the help file psim.chm from the same PSIM folder.
When this option is checked, PSIM will read the help file from the specified file path
instead.

Under the Colors tab:

Color settings: Colors for grids, elements, subcircuits, ports, wire, text, nodes, and labels can be set. 

Wire color: The wire color can be set either by default, or by circuit type. 

The Set Path... function in the Options menu allows users to define additional search paths when loading an
external DLL file or device file. For example, if a schematic file uses a DLL file, and this DLL file is placed in
a directory other than the schematic directory or the PSIM directory, this directory can be included in PSIM by
using the Set Path function. Similarly, if a Thermal Module device is placed in a folder other than the default
device folder, this device file can be used by PSIM schematic by including the folder in the Device File Path.

PSIM searches the DLL files in the following order:

- PSIM directory

- Schematic file directory

- Directories as defined in the PSIM Search Path section.

The first time that the DLL file is encountered, it will be loaded. For example, assume that the PSIM program
files are in C:\PSIM, the schematic file is in C:\TEMP; and the directory as defined in the Set Path function is
C:\TEMPDLL. The DLL file can be in one of the three places:

- C:\PSIM

- C:\TEMP

- C:\TEMPDLL

PSIM loads the Thermal Module device files in the following order:

- The "device" sub-folder in the PSIM directory

- Directories as defined in the Device File Path section.

All the device files in the PSIM’s device sub-folder and in the folders defined in the Device File Path will be
loaded. 

The procedures for create customized toolbars and to customize keyboards are described below. 

Customizing Toolbars:

To create a toolbar called "new" and add the AND gate to the toolbar, for example, do the following: 

- Choose View -> Custom Toolbars. The Custom Toolbars dialog window will appear. Choose New
Toolbar, and the following window will appear.
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- Specify the Toolbar Name as "new". 

- Draw the AND gate icon in the icon editing area. Or if the icon is already available in the predefined
icon images, select the icon and copy it to the icon editing area.

- Under the Edit Command section, with the option Elements selected, highlight "AND Gate". Then
click on the Add Button. The icon will appear in the toolbar icon area. Click on OK to close the
window, and go back to the Custom Toolbars window.

- Check "new" in the Custom Toolbars dialog window, and the new toolbar will appear. Uncheck the
box will hide the toolbar.

Customizing Keyboard:

To define the key "r" for getting a resistor from the library, for example, do the following: 

- Choose View -> Custom Keyboard. The Custom Toolbars dialog window will appear. Choose New
Toolbar, and the following window will appear.

- In the section Add Shortcut Key, select the option Elements. Then find and highlight the element
"Resistor".

- Move the cursor into the input field of Press new shortcut key, and press the key "r" on the keyboard.
Then click on Assign. 

- The key "r" will be assigned to the resistor, and the definition will appear in the Current Shortcut

Icon
editing area

Predefined
icon images

Toolbar
icon area
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Key list.

6.8  Utilities Menu
Several utility programs are provided under the Utilities menu.

s2z Converter This program converts a s-domain function to a z-domain function. Note that this program
is enabled only if the Digital Control Module license is available. 

Device Database Editor: This will launch the device database editor PcdEditor.exe for the Thermal Module. 

B-H Curve: This program plots the B-H curve of the saturable core element (under Elements ->
Power -> Magnetic Elements). 

Solar Module (physical model): This program plots the i-v curve of the solar module (physical model)
element (under Elements -> Power -> Renewable Energy). This function is part of the
Renewable Energy option.

SimCoupler Setup: This will launch the program SetSimPath.exe that performs the setup for the co-
simulation between PSIM and Matlab/Simulink. This function is part of the SimCoupler
Module.

Launch/Export to To launch the SmartCtrl software, or if the ac sweep result is available, to export the ac 
SmartCtrl sweep result to SmartCtrl. SmartCtrl is a separate software for control loop design. For

more information, please refer to the Help menu in SmartCtrl.

Unit Converter: This program performs unit conversion in length, area, weight, and temperature. 

Calculator: This will launch the Windows’ calculator. 

6.9  Managing the PSIM Library
A PSIM library element consists of two parts: the netlist part and the image part. The netlist part comes from the
netlist library, and there is only one netlist library, psim.lib. The netlist library can not be edited. 

The image part comes from an image library. There can be multiple image libraries, and all the image libraries
in the PSIM directory will be automatically loaded into PSIM. The standard image library provided by PSIM is
psimimage.lib. This file also can not be edited. However, in order to facilitate users to copy images from the
standard image library, the standard image library can be viewed by going to Edit -> Edit Library -> Edit
library files, and choosing psimimage.lib.

Users can create their own custom image libraries. To create a new custom image library, go to Edit -> Edit
Library -> Edit library files, and click on New library. Then define the library name as it appears in the PSIM
Elements menu, and the library file name. This library file will be created and placed in the PSIM directory. 

To edit an image library, go to Edit -> Edit Library -> Edit library files, and select the library file. The figure
below shows the library editor dialog window. The dialog shows the menu tree of the library as well as various
functions.

To create a new element in the custom image library, click on New Element, and select the netlist that this
element corresponds to from the list. For example, the netlist name of the resistor is "R". To create a new
element called "My Resistor", select the netlist "R". To create the image for this resistor, click on Edit Image. 
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The following functions are provided in the library editor: 

Up To move an element up in the menu 

Down To move an element down in the menu 

---> To move an element one level lower in the menu 

<--- To move an element one level higher in the menu 

Add Separator To add a separator between elements 

Add Submenu To add a submenu in the library 

Edit To edit the name of an element 

Edit Image To edit the image of an element 

New Element To create a new element in the image library. This element will be linked to a netlist
element in the netlist library.

Save Element as To save the existing element as a new element. The new element will have the image of
the existing element as the default image.

New Element (DLL) To create a new element for a DLL file 

New Element To create a new element for a subcircuit 
(Subcircuit)

Delete Element To delete an element from the library 

6.9.1  Creating a Secondary Image
It is possible that some users may find certain element images in the standard PSIM image library
psimimage.lib different from what they are used to use. In this case, users can create their own secondary
images. 

A secondary image can be created for an element in either standard image library psimimage.lib or users’ own
custom image libraries. Secondary images are saved in a secondary image library with the .lib2 extension.

Netlist name
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To illustrate the process, a secondary image will be created in the library "mylib.lib2" for the "Diode" element
in the standard image library.

- Go to Edit -> Edit Library -> Edit secondary image library files, and click on New library. In the
dialog, define the secondary image library name as "mylib.lib2". 

- Then select "mylib.lib2" and click on Edit selected library. The dialog window for editing secondary
image library will appear.

- Click on the Add button. From the PSIM library tree, navigate to Power -> Switches, and select
"Diode". The element "Diode" will appear in the list of the secondary images. The text "PSIMIMAGE"
in front of the "Diode" text shows that this is for the diode element in the standard image library
psimimage.lib.

- Highlight "Diode", and click on the Edit button to create the image.

- If this image is to be used as the default image for this element, click on the "Set as Default Image". 

After the secondary image is created, this image will be available for selection in the PSIM schematic. For
example, if a diode is placed on the schematic, double click to display the property dialog of the diode, then
click on the Color tab. Click on the pull-down arrow, and two images will be displayed. One from the standard
image library, and the other from the custom image library mylib.lib. 

If the secondary image is selected, all the images of the same element will be automatically changed to the
secondary image. The selected image will also be set as the default image when a schematic is created or loaded
the next time. 

To share the secondary images that one creates with other people, one just has to send to them the secondary
image library file (with the .lib2 extension).

6.9.2  Adding a New Subcircuit Element into the Library
There are two ways to add a custom model to the PSIM library list. One is to have the model in the form of a
subcircuit, and then place the schematic file in a folder called user defined in the PSIM directory, or in one of
the sub-folders of the user defined folder. Any schematic files and sub-folders under the user defined folder
will appear in the PSIM library list.

Another way is to add the custom model directly to an image library. The advantage of this approach is that the
custom element will have the same look-and-feel as the standard PSIM elements, giving it a better interface. It
is also possible to associate a help file to the custom model.

There are three main steps to add a new element, modeled in a subcircuit, into the library: 

- Create the subcircuit model of the new element.

Standard image

Secondary image
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- Add this element to the PSIM library.

- Create an on-line help file for this new element.

To illustrate this process, a LC-filter element is used as an example.

Creating the Subcircuit:

The first step is to create the subcircuit of the new element in the same way as if the subcircuit is to be called by
another circuit. For example, the subcircuit of the 2nd-order LC filter, called "LC_filter.sch", and its image are
shown below:

In this case, the inductance and capacitance values will be defined through the interface, and need to appear in
the property window of the new LC filter element. Therefore, the parameter value for the inductance needs to be
defined as a variable, in this case, L, and the value for the capacitance as C.

Then from Subcircuit -> Edit Default Variable List, add the variables L and C as the default variables. This
step is necessary as the new element obtains the parameter information from the default variable list. The
default variable list window should appears as follows.

Here Variable Label is the text that describes the parameter, Variable Name is the variable that is used as the
parameter value in the subcircuit, and Variable Value is the default value of the parameter. For example, for the
inductance L, the Variable Label is Inductance, the Variable Name is L, and the Variable Value is 1m.

After the file is created, place it in the "lib" sub-folder in the PSIM directory.

Adding the New Element to the PSIM Library:

To add the subcircuit element into the PSIM library, follow these steps:

- Go to Edit -> Edit Library -> Edit Library Files, and choose the custom image library for the new
element. Click on New Library to create a new image library, or select an existing library and click on
Edit Selected Library.

- In the Library Editor, click on the button New Element (Subcircuit). Enter the information to the
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dialog window as shown below:

The explanation of each field is as follows:

Name: Name of the new element as it appears in the PSIM library
Description: Description of the new element
Schematic File: The location of the subcircuit schematic file "LC_filter.sch". The schematic file

of the subcircuit must be placed in the "lib" sub-folder in the PSIM directory.
Hide (menu): Leave this box unchecked. If this box is checked, this element will not appear in

the library.
Help File: On-line help file associated with this element. This file must be placed in the

"help" sub-folder in the PSIM directory. When the Help button is clicked in the
property dialog window, this file will be displayed. This file can be a text file
(which can be opened by a text editor such as NotePad) or a HTML file. 

- Click on the buttons Save Image Library and Update Menu. The new element will appear in the
library and will be ready to use.

6.9.3  Adding a New DLL Element into the Library
Similar to that of a subcircuit element, there are three main steps to add a new element, modeled in a DLL, into
the PSIM library: 

- Create the model in the DLL file.

- Add this element to the PSIM library.

- Create an on-line help file for this new element.

To illustrate this process, an inductor is used as an example.

Creating the DLL:

The first step is to create the inductance model in DLL. Please refer to the relevant section on how to create a
custom DLL.

Here we assume that the DLL file, "inductor_model.dll", has already been created. It has one parameter called
"Inductance", and two connecting nodes. The file is placed in the "lib" sub-folder in the PSIM directory.

Adding the New Element to the PSIM Library:

To add the DLL element into the PSIM library, follow these steps:

- Go to Edit -> Edit Library -> Edit Library Files, and choose the library for the new element. Click
on New Library to create a new image library, or select an existing library and click on Edit Selected
Library.

- In the Library Editor, click on the button New DLL File. Enter the information to the dialog window
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as shown below:

The explanation of each field is as follows:

Name: Name of the new inductor element as it appears in the PSIM library
Description: Description of the new inductor element
File Path: The location of the DLL file "inductor_model.dll" that models the new inductor

element. The DLL file must be placed in the "lib" sub-folder in the PSIM
directory.

Input Nodes: Number of input terminals of the new element. 
Output Nodes:Number of output terminals of the new element. 
Hide (menu): Leave this box unchecked. If this box is checked, this element will not appear in

the library.
Help File: On-line help file associated with this element. This file must be placed in the

"help" sub-folder in the PSIM directory. When the Help button is clicked in the
property dialog window, this file will be displayed. This file can be a text file
(which can be opened by a text editor such as NotePad) or a HTML file.

- In the next dialog window, set the new element size as: Width = 5, and Height = 2. Then create an
image for this element, or accept the default image.

- Click on the buttons Save Image Library and Update Menu. The new element will appear in the
library and will be ready to use.

The information regarding the number of parameters and the parameter description for the new inductor
element is obtained from the DLL file automatically. In this case, the new element will have one parameter as
"Inductance".
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7
  Waveform Processing

SIMVIEW is PSIM’s waveform display and post-processing program. The following shows simulation
waveforms in the SIMVIEW environment.

SIMVIEW reads data in either ASCII text format or SIMVIEW binary format. The following shows a sample
text data file:

Functions in each menu are explained in the following sections.

7.1  File Menu
The File Menu has the following functions:

Open Load a data file in ASCII text format (with .txt extension) or SIMVIEW binary format
(with .smv extension)

Merge Merge another data file with the existing data file for display 

Re-Load Data Re-load data from the same text file 

Save As Save the waveforms to either binary data format or text format. When saving to the binary
format, the current settings are also saved. 

In the FFT display, this will save the FFT results to a text file specified by the user. 

Print Print the waveforms

   Time             Isa               Isc               Isb               Tem_IM          
 5.000000000E-006  0.000000000E+000  0.000000000E+000  0.000000000E+000  7.145888260E-048 
 1.000000000E-005  0.000000000E+000  0.000000000E+000  0.000000000E+000  1.082981714E-046 
 1.500000000E-005  0.000000000E+000  0.000000000E+000  0.000000000E+000  5.408644357E-046 
 2.000000000E-005  1.139566166E-001 -2.279132474E-001  1.139566166E-001  1.613605209E-017 
 2.500000000E-005  5.072914178E-001 -1.014582858E+000  5.072914178E-001  3.598226665E-015 
... ... ... ...
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Print Setup Set up the printer 

Print Page Setup Set up the hardcopy printout size

Print Preview Preview the printout 

Exit Quit SIMVIEW 

When the data of a file are currently being displayed, if new data is available, by selecting Re-Load Data, new
data will be loaded and waveforms will be re-drawn. 

By using the Merge function, data from multiple files can be merged together for display. For example, if one
file contains the curves “I1” and “I2”, and another file contains the curves “V1” and “V2”, all four curves can
be merged and displayed on one screen. If the second file also contains a curve with the same name “I1”, it will
be modified to “I1_({second_file_name})” automatically where second_file_name is the name of the second
file.

7.2  Edit Menu
The Edit Menu has the following functions:

Undo Go back to the previous X and Y axis settings

Copy to Clipboard Copy the waveforms to the clipboard either in metafile format or bitmap format.

View Data Points View the data points of the waveforms within the displayed range in a separate window.
In this window, one can use the left mouse to highlight data points in rows or columns,
then right mouse click and choose Copy Selected to copy the data to the clipboard. One
could also just copy the row that the cursor is on by selecting Copy Row, or copy the entire
data by selecting Copy All. One can then paste the copied data back in another program.

Note that the Copy to Clipboard function will copy the displayed waveforms on the screen to the clipboard. To
save the memory and have the waveform image in black & white, first go to Option and de-select Color to
have a black & white display, then copy the waveform to the clipboard. 

7.3  Axis Menu
The Axis Menu has the following functions:

X Axis Change the settings of the X axis 

Y Axis Change the settings of the Y axis 

Choose X-Axis Variable By default, the first column of the data is selected as the X axis. However, other
columns can also be selected as the X axis through this function. 

The dialog box of the X/Y axis settings are shown below.

If the Auto-Grid box is checked, the number of axis divisions will be automatically determined. The data range
and grid division, however, can be manually set. 

By default, the first column of the data, which is usually Time, is used as the X axis. However, any other
column of the data can be used as the X axis. For example, the following figure shows a sine waveform as the X
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axis versus a cosine waveform in the Y axis.

7.4  Screen Menu
The Screen Menu has the following functions:

Add/Delete Curves Add or delete curves from the selected screen 

Add Screen Add a new screen 

Delete Screen Delete the selected screen 

A screen is selected by clicking the left mouse on top of the screen.

The property dialog window of curves is shown below.

All the data variables available for display are in the Variables Available box, and the variables currently being
displayed are in the Variables for Display box. After a variable is highlighted in the Variables Available box, it
can be added to the Variables for Display box by clicking on “Add ->”. Similarly, a variable can be removed
from display by highlighting the variable and clicking on “<- Remove”.

In the Edit Box, an mathematical expression can be specified. 

A mathematical expression can contain brackets and is not case sensitive. The following math functions are
allowed:

+ addition
- subtraction
* multiplication
/ division
^ to the power of [Example: 2^3 = 2*2*2]
SQRT square-root function

Edit Box
Chapter 7: Waveform Processing 195



SIN sine function
COS cosine function
TAN tangent function
ATAN inverse tangent function

EXP exponential (base e) [Example: EXP(x) = ex]
LOG logarithmic function (base e) [Example: LOG(x) = ln (x)]
LOG10 logarithmic function (base 10) 
ABS absolute function
SIGN sign function [Example: SIGN(1.2) = 1; SIGN(-1.2) = -1]
AVG moving average function
AVGX periodic average function AVGX(y,Tp) where y is the curve name and Tp is the time

interval where the average is calculated.
INT integration function

The moving average function AVG(y) calculates the average of the curve y up to the measured point.

The periodic average function AVGX(y,Tp) calculates the average of the curve y in each time segment, with
interval of the time segment as Tp. For example, AVGX(V1, 0.016667) will calculate the average of the curve
V1 at the 60-Hz interval.

Type an expression in the Edit Box, and click on the "Add ->" button. Highlight the expression on the right,
click on the "<- Remove" button, and the expression will be moved into the Edit Box for further editing. 

Also in the property dialog window, in the Curves tab, the curve properties, such as color, line thickness, and
marker symbol, can be defined.

In the Screen tab, the screen properties, such as foreground/background colors, grid color, and font size/type,
can be defined.

7.5  Measure Menu
The Measure Menu has the following functions:

Measure Enter the measure mode. 

Mark Data Point Mark the x and y coordinate values of the data point in a selected curve

Max Find the global maximum of a selected curve

Min Find the global minimum of a selected curve 

Next Max Find the next local maximum of a selected curve 

Next Min Find the next local minimum of a selected curve 

The Measure function allows the measurement of waveforms. After Measure is selected, the measure dialog
window will appear. By clicking the left mouse, a line will appear and the values of the waveforms will be
displayed. By clicking the right mouse, another line will appear and the different between the current position
and the previous position, which is marked by the left mouse, will be measured. A SIMVIEW window with the
measure dialog windows in these two modes are shown below.
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Once Measure is selected, an individual curve can be selected by clicking on the pull-down menu

on the Measure toolbar. The functions, Max, Min, Next Max, Next Min, Avg, and rms, can
be used to evaluate the curve. Note that these functions are only enabled in the Measure mode. 

7.6  Analysis Menu
The Analysis Menu has the following functions:

Perform FFT Perform the FFT (Fast Fourier Transform) analysis of time-domain waveforms

Display in Time Domain Show the corresponding time-domain waveforms of FFT results

Avg Calculate the average value

Avg(|x|) Calculate the average of the absolute value

RMS Calculate the rms value 

PF (power factor) Calculate the power factor of two waveforms on the screen. The screen must display two
curves only. The power factor is defined as cos(theta) where theta is the angle difference
between the first curve and the second curve.

P (real power) Calculate the real power of two waveforms on the screen. The screen must display two
curves only. 

S (apparent power) Calculate the apparent power of two waveforms on the screen. The screen must display
two curves only. 

THD Calculate the THD (total harmonic distortion) 

All these functions apply to the time interval currently being displayed on the screen.

By selecting Perform FFT, the harmonic spectrum (both the amplitudes and angle) of the time-domain
waveforms can be calculated and displayed. To display the angles of the FFT results, double click on top of the
screen (or click on the Add/Delete Curves icon). In the Select Curves tab, click on the Angle tab, and select the
angles. The name convention of angles is Angle(D)_{name} for the angle in deg., and Angle(R)_{name} for the
angle in rad., and name is the curve name in the time domain.

Note that, in order to obtain correct FFT results, the simulation must reach the steady state, and the data range
must be restricted (using the manual range setting in the X Axis function) to have the integer number of the
fundamental period. For example, for a 60-Hz fundamental frequency, the data length in display must be integer
multiples of 1/60 sec.

Left mouse click Right mouse click
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7.7  View Menu
The View Menu has the following functions:

Zoom Zoom into a selected region 

Re-Draw Re-draw the waveform using the auto-scale 

Escape Escape from the Zoom or Measure mode 

Standard Toolbar Enable/disable standard toolbar 

Measure Toolbar Enable/disable measure toolbar 

Status Bar Enable/disable status bar 

Calculator Launch the Calculator in Simview 

The interface of the calculator is shown below.

One key feature of the calculator is that it provides 9 memory spaces. By double clicking on a number in the
Measure dialog window in Simview, the value will be automatically transferred to the calculator and stored in
one of the memory spaces, starting from the top. In this way, data can be directly transferred to this calculator
for calculation without the need to record them on a piece of paper. 

7.8  Option Menu
The Option Menu has the following functions:

Options... Various options can be set here.

Grid Enable or disable the grid display 

Color Set the curves to be either Color (default) or Black and White 

In the Options... dialog window, when the option Redraw x-axis when loading new data is checked, the
waveform will be redrawn with the new x-axis range when new data is loaded. If this option is not checked, the
x-axis range will be unchanged.

Also in the Options... dialog window, the right mouse action can be set to either Show menu, Pan, or Zoom. 

Memory

Result

Expression
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7.9  Label Menu
The Label Menu has the following functions:

Text Place text on the screen 

Line Draw a line 

Dotted Line Draw a dotted line 

Arrow Draw a line with arrow

To draw a line, first select Line from the Label menu. Then click the left mouse at the position where the line
begins, and drag the mouse while keeping the left button pressed. Dotted lines and lines with arrows are drawn
in the same way. 

If one is in the Zoom or Measure mode, and wishes to edit a text or a label, one should first escape from the
Zoom/Measure mode by selecting “Escape” in the “View” menu. 

7.10  Settings Menu
The Settings Menu has the following functions:

Re-Load Settings Re-load the settings from the .ini file and apply to the current display

Save Settings Save the current settings to a file with the same file name but with the .ini extension

Save Temporary Settings Save the current settings temporarily. The temporary settings are not saved to any
files, and are discarded when the document is closed. 

Load Temporary Settings Load the temporary settings and apply to the current display

Add to Favorites Save the current settings as a favorite. When saving a favorite, one can choose to
save the following settings: line color and thickness, text font, Log/dB/FFT display
settings, and x and y axis ranges.

Manage Favorites Manage the favorites

When Simview loads a data file (.txt or .smv file), if the corresponding .ini file exists, it will load the settings in
the .ini file.

The functions Load Temporary Settings and Save Temporary Settings are used in situations where one wants to
save the settings temporarily and uses it shortly after. For example, when comparing one waveform with
another, one can first save the temporary settings when displaying the first waveform. Then display the second
waveform and load the temporary settings.

Favorites are a convenient way of storing particular graph settings to be used later. For example, assume that
Simview shows two screens, with the top screen displaying V1 in the red color and with certain x-axis and y-
axis ranges, and the bottom screen displaying V2 in the blue color with its own y-axis range. If this settings is
likely to be used again in the future, the settings can be saved as a favorite and used later.

To apply a favorite to the current display, go to the Settings menu and choose the favorite from the list. Note that
when applying the favorite, the number of screens currently on display must be the same as the number of
screen in the favorite. 

7.11  Exporting Data
FFT results can be saved to a text file. Both simulation results (*.txt) and FFT results (*.fft) are in text format
and can be edited using a text editor (such as Microsoft NotePad), or exported to other software (such as
Microsoft Excel). 

For example, to load a simulate result file “chop-1q.txt” in Microsoft Excel, follow these steps:

- In Microsoft Excel, select Open from the File menu. Open the file “chop-1q.txt”.

- In the dialog window “Text Import Wizard - Step 1 of 3”, under Original data type, choose
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Delimited. Click on Next.

- In the dialog window “Text Import Wizard - Step 2 of 3”, under Delimiters, choose Space. Click on
Next.

- In the dialog window “Text Import Wizard - Step 3 of 3”, under Column data format, choose
General. Click on Finish.
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8
  Error/Warning Messages and Other Simulation Issues

8.1  Simulation Issues

8.1.1  Time Step Selection
PSIM uses the fixed time step in the simulation. In order to assure accurate results, the simulation time step
should be properly chosen. The factors that limit the time step in a circuit include the switching period, widths
of pulses or square waveforms, and intervals of fast transients. It is recommended that the time step should be at
least one magnitude smaller than the smallest of the above. 

8.1.2  Propagation Delays in Logic Circuits
The logic elements in PSIM are ideal, i.e. there is no propagation delay. If a logic circuit uses the propagation
delays for its operation, a function block in PSIM, called the Time Delay block, needs to be added to represent
the effect of the propagation delay.

To illustrate this, take a two-bit counter circuit as an example.

In the circuit on the left, the initial values of both Q0 and Q1 are assumed to be zero. At the clock rising edge, Q0
will change to 1. Without delay, the position of Q1, which should remain at 0, will toggle to 1 at the same time. 

To prevent this, a time delay element with the delay period of one time step needs to be inserted between Q0 and
the input (J) of the second flip-flop. 

8.1.3  Interface Between Power and Control Circuits
In PSIM, power circuits are represented in the discrete circuit form, and control circuits are represented in
function block diagram. Power circuit components, such as RLC branches, switches, transformers, mutual
inductors, current sources, floating voltage sources, and all types of controlled sources are not allowed in the
control circuit. Similarly, control circuit components, such as logic gates, PI controllers, lookup tables, and
other function blocks, are not allowed in the power circuit.

If there is a direct connection between the power circuit and the input of a control circuit element, a voltage
sensor will be automatically inserted by the program. Similarly, if there is a direct connection between the
output of a control circuit element and the power circuit, a control-power interface block will be automatically
inserted. This is illustrated in the examples below.

1 V

clock

Q0

1 V

clock

Q1
Q1Q0
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It should be noted that, in PSIM, the power circuit and the control circuit are solved separately. There is one
time step delay between the power and the control circuit solutions.

8.1.4  FFT Analysis
When using FFT for the harmonic analysis, one should make sure that the following requirements are satisfied:

- The waveforms have reached the steady state;

- The length of the data selected for FFT should be the multiple integer of the fundamental period.

For a 60-Hz waveform, for example, the data length should be restricted to 16.67 msec. (or multiples of 16.67
msec.). Otherwise, the FFT results will be incorrect. The data is selected by clicking on X Axis in SIMVIEW,
de-selecting Auto-scale in Range, and specifying the starting time and the final time. The FFT analysis is only
performed on the data that are displayed on the screen.

Note that the FFT results are discrete. The FFT results are determined by the time interval between two
consecutive data points, Δt, and the data length Tlength. The data point interval Δt is equal to the simulation time
step multiplied by the print step. In the FFT results, the frequency incremental step will be 1/Tlength, and the
maximum frequency will be 1/(2*Δt).

For example, if you take the FFT of a 1-kHz square waveform with a data length of 1 ms and a data point
interval of 10 us, that is, Tlength = 1 ms, and Δt = 10 us, the frequency incremental step will be: Δf = 1/Tlength =
1 kHz. The maximum frequency will be: fmax = 1/(2*Δt) = 50 kHz.

8.2  Error/Warning Messages
The error and warning messages are listed in the following.

E-1 Input format errors occurred in the simulation.

It may be caused by one of the following:

- Incorrect/Incomplete specifications

- Wrong input for integers and character strings

Make sure that the PSIM library is not modified, and the PSIM simulator is up-to-date. 

In the circuit file, character strings should be included between two apostrophes (like ‘test’). Also, make
sure an integer is specified for an integer variable. The specification of a real number (like 3. instead of
3) for an integer will trigger the error message.

E-2 Error message: The node of an element is floating.

op. amp.

Transfer Function

op. amp.

Transfer Function

Comparator Comparator
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This can also be caused by a poor connection in PSIM. When drawing a wire between two nodes, make
sure that the wire is connected to the terminal of the element.

W-1 Warning!!! The program failed to converge after 10 iterations when determining switch positions.
The computation continues with the following switch positions: ... ...

This warning occurs when the program fails to converge when determining switching positions. Since
the computation continues based on the switch positions at the end of the 10th iteration, results could be
inaccurate. One should be cautious when analyzing the results.

There are many factors that cause this problem. The following measures can be taken to isolate and
solve the problem:

- Check the circuit and make sure the circuit is correct.

- Check the switch gating signals.

- Connect small resistors/inductors in series with switches and voltage sources.

W-2 Warning!!! The program did not reach the steady state after 60 cycles when performing the ac
sweep.

This warning occurs when the program fails to reach the steady state after 60 cycles when performing
the ac sweep. The cause of the problem could be that the system is poorly damped at that particular
frequency or the signal amplitude is too small. 

You may try the following to isolate and solve the problem:

- Run the time-domain simulation with the excitation source at that frequency and see if time-
domain waveforms are oscillatory.

- Increase the excitation voltage amplitude for larger signal level, or

- Reduce the time step for better accuracy and resolution.

8.3  Debugging
Some of the approaches in debugging a circuit is discussed in the following.

Symptom:
Simulation results show sudden changes (discontinuity) of inductor currents and capacitor voltages.

Solution:
This may be caused by the interruption of inductor current path and short-circuit of capacitor (or
capacitor-voltage source) loops. Check the switch gating signals. If necessary, include overlap or dead
time pulses to avoid open-circuit or shooting-through.

If an initial current is assigned to an inductor, initial switch positions should be set such that a path is
provided for the current flow. Otherwise, the inductor current will be forced to start from zero.

Symptom:
Simulation waveforms look incorrect or inaccurate, or the waveform resolution is poor.

Solution:
This may be caused by two reasons. One is the time step. Since PSIM uses the fixed time step during the
entire simulation, one should make sure that the time step is sufficiently small. As a rule of thumb, the
time step should be several tens times smaller than the switching period. 

Another reason is the problem of waveform display. One should make sure that the print step is not too
big. To display all the data points, set the print step to 1.
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GTO 10, 13
IGBT 10
MOSFET (n-channel) 10
MOSFET (p-channel) 10, 13

trapezoidal waveform block 111
trigonometric function 108

U
unit delay block 113, 125

V
variable

default 175, 176, 178, 179, 190
passing 178
runtime 174, 181

voltmeter
ac 146
dc 146

W
wattmeter 146, 147, 148

3-phase 148
wind turbine 97
wire 172, 174, 177, 185, 203

Z
zero-order hold 1, 111, 112, 120, 131, 162
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